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Document Structure

Table 1 list the sections in this document with a brief description of each section. 

Table 1.  AETG System Users Guide Sections (Sheet 1 of 2)

Section 
Number Section Name Description

Section 1 Introduction This section contains general information on 
this guide including an overview of some basic
AETG functionalities.

Section 2 A Quick Tour of the AETG 
System

This section details several basic tasks that w
help you become familar with the AETG 
System.

Section 3 AETG Basics This section contains basic information on 
using the AETG GUI.

Section 4 Using AETG Objects This section contains information on how to 
use AETG objects

Section 5 Using the Database 
Browser

This section contains information on the AETG
Database Browser.

Section 6 Format Object This section contains information on Format 
objects, which describe a testable interface to
an application or a testing situation. 

Section 7 Field Object This section contains information on Field 
objects, which define the data values that are
input to an application.

Section 8 Compound Object This section contains information on 
Compound objects, which let you collect 
several Fields and treat them as one Field.

Section 9 Test Object This section contains information on Test 
objects, which define the means by which a 
requirement is verified in a software 
application.

This section also contains information on how
to generate a Test Case Matrix.

Section 10 Relation Object This section contains information on Relation
objects, which let you collect requirements dat
to establish how fields and values on the forma
relate to one another.
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Section 11 Command Line Tools This section contains information on the AETG
Command Line tools.

Section 12 Input Modeling with the 
AETG System

This section provides tips on how the AETG 
System could be used to model various types 
applications.

NOTE — The following sections contain information 
required by the AETG Adminstrator.

Section 13 Installing the AETG SystemThis section contains information on 
installation, including required third-party 
software. 

Section 14 Configuring the AETG 
System

This section contains information on 
configuring a working installation.

Section 15 Operability Management — 
Starting and Stopping 
AETG Processes

This section describes the procedures used t
start, stop, and get status of all of the AETG 
processes.

Section 16 Administrative CLUI 
Commands

This section describes the tasks used to 
administer the AETG System.

Section 17 Person Object This section describes the tasks used to 
administer Person objects.

Appendix A Using the AETG System 
with the MYNAH System

This section contains information on the 
differences in the GUI when the AETG System
is licensed with the MYNAH System. 

Appendix B Generate Tcl Scripts for 
AETG Testcases

This section contains information on 
generating test code when the AETG System 
licensed with the MYNAH System.

Appendix C Example Installation FilesThis appendix contains examples of the 
delivered files used to install the AETG 
System.

Table 1.  AETG System Users Guide Sections (Sheet 2 of 2)

Section 
Number Section Name Description
Preface–2  
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Formatting Conventions

The following formatting conventions are used in this document.

• Substitutable or user supplied items (e.g., option and argument values) appear 
boldItalics Times.

• File and directory names appear in italics Times.

• The first time a term is used, it will appear in bold 11-point Helvetica , such as when 
we first mention Format  object.

• Menu names and items will appear in bold 10-point Helvetica , such as when we 
mention the Edit  menu.

• Cascading menus will appear in bold Helvetica  with arrows between the menu 
options to signify the cascades, such as

Aetg->New->Format
 Preface–3
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1. Introduction

This document describes the procedures for using the Automatic Efficient Testcase 
Generator (AETG™) System.

Software testing is expensive in both time and material resources. By various estima
testing can cost as much as 20% to 33% of the total development budget of a softwa
project. The AETG System can greatly reduce the cost of testing by reducing time to 
develop test plans and by reducing the number of maintained test cases. The Bellco
proprietary combinatorial algorithm generates an efficient set of test cases and these
cases provide a high degree of coverage for the application under test. The generated
can be easily introduced into application testing tools to populate screens and/or messa
with data for test automation. 

1.1 AETG System Overview

The AETG System runs on the Solaris™ platform (Release 2.5.1) with any X-windows™ 
manager.

Using the AETG System entails performing the following steps:

1. Defining the Interface

2. Defining and Associating Tests

3. Defining the Rules of the Interface

4. Generating the Efficient Set of Test Cases

5. Automating the Test Cases.

The following subsections provide general information each of these tasks.

1.1.1 Starting the AETG System

To start the AETG System, simply type

xmyRunAetg 

in a standard UNIX window.

NOTE — The AETG System automatically runs in the 
background.
 1–1
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1.1.2 Defining the Interface

An interface is the means by which you interact with an application or testing situatio
such as a screen or a communications protocol. You define an interface into which d
input to an application using an AETG database object called a Format  object. A Format 
object is a collection of Field  objects, which are database objects that are used to hold
information about the data to be applied to an application. You must define one or m
Field objects from within the Format and then assign one or more Values to each Fie

A completed Format object, therefore, represents an interface to a System Under Te
(SUT) that you wish to validate, i.e., test.

See Section 6 for information on working with Format objects. See Section 7 for 
information on working with Field objects.

Figure 1-1 illustrates the flow of steps you follow to define an interface and how Forma
Fields and Values are related to each other. 

After you have created more than one Field objects, you can optionally create a 
Compound  object, which is a database object that lets you collect simple Fields into on
set and then treat that set of Fields as a single Field. 

Once you have created a Compound object, you must create at least one Tuple , which is a 
reference name given to the specific value set of a Compound. 

See Section 8 for information on working with Compound objects and Tuples.

Figure 1-1.  Defining the Interface

Desktop 
or

Folder
Field
Object

Format
Object Value 

1 2 3

1. From the Desktop (or a Folder), you create one or more Format objects.

2. From a Format object, create the Fields that make up that Format. 

3. For each Field, define one or more values.
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1.1.3 Defining and Associating Tests

A Test  object is a database object that is used to track and verify compliance with sp
system requirements. Test objects are created within Test Hierarchies , which are 
equivalent to directories (or folders).

See Section 9 for information on working with Test objects.

You may need one or more Test objects to test all the things you want to verify abou
Format, such as in the following scenarios:

• You may wish to exercise all the Fields and all combinations of Fields in a Form

• You may wish to test certain invalid Field values to see how the System Under T
behaves when given invalid input.

• You can test a subset of the Format’s Fields with one Test object and the remai
Fields with a different Test object. 

• You can test the entire Format with one Test object.

Once you’ve created a Format object and the desired Test objects, you must associate  the 
Format object with each Test object that will validate some aspect of the Format, cre
a link between the Format object and the pertinent Test objects.

Figure 1-2 depicts a Format object being associated with multiple Test objects. 

1.1.4 Defining the Rules of the Interface

After you define the testing interface and define and associate tests, you create Relations , 
which are database objects that define the rules governing the data (i.e., formal 
requirements) that will be input to the System Under Test.

Figure 1-2.  Associating a Format with Tests

Format

Test
Object

Object

Test
Object

Test
Object

1

1
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1. Associate a Format object with one or more Test objects. These Test objects 
describe how the SUT interface that the Format describes will be tested.
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You create one or more Relation objects from within a Test object and define, for each
one or more rules, such as “When Field1 has a value of blue, Field2 may not be pink or 
yellow.” The Relation uses a set of Fields from a Format.

Figure 1-3 depicts the flow of steps you follow when associating Relation objects with T
objects. 

Using a Relation object, you can 

• Specify which values must be included in the test case. This does not mean the
the only values that will be included, but that priority will be given that these valu
are included.

• Specify which values are to be excluded.

• Specify a set of invalid values to do error condition testing.

1.1.5 Generating the Efficient Set of Test Cases

When you have finished specifying all the rules that will be used for this Test, you can
ask the AETG System to generate the efficient set of test cases for this Test. This ope
is performed from the Test object, and the resulting Test Case Matrix is stored with the Test
object.

Figure 1-3.  Defining the Rules

Format

Test
Object

Object

Relation

Object

Test
Object Relation

Object

1

1

1. From a Test object, you create one or more Relations, using some or all of th
information in the Format object. The Relation objects specify rules about 
combining Field values.
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Figure 1-4 depicts the flow of steps you follow to generate the Test Case Matrix. 

1.1.6 Aut omating the Test Cases

The generated Test Case Matrix can potentially be read by an automated testing too
as the MYNAH System, to create a script to automate test cases.

1.1.7 Summary

1. Defining the Interface

A. Create a Format object.

B. Define one or more Field objects.

C. Assign one or more Values to each Field.

2. Defining and Associating Tests

A. Create one or more Test objects that will be used to exercise the interface.

B. Associate these Tests with the Format.

3. Defining the Rules of the Interface

Create one or more Relation objects from within a Test object and define, for each
one or more rules. 

4. Generating the Efficient Set of Test Cases

Generate a Test Case Matrix using the defined Relation(s).

5. Automating the Test Cases

Figure 1-5 contains a flow chart describing the recommended of the steps required to c
a test case. 

Figure 1-4.  Generating the Test Cases

Test
Object Relation

Object

Test Case
Matrix

From a Test object, you ask the AETG System to Generate the Test Case Matrix, us
the information in the Relations that are associated with that Test. The Matrix is 
comprised of all of the test cases that are needed to exercise the rules in the set o
Relations.
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Figure 1-5.  Recommended Steps for Creating a Test Case
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1.2 Command Line User Interface (CLUI)

The Command Line User Interface (CLUI) is a set of commands you can use to perf
AETG utility operations from the UNIX® command line. 

See Section 11 for descriptions of the CLUI commands.

1.3 Some Basic Terms we Use 

Before we proceed, let us define a few terms and concepts we will use in this docum

1.3.1 Mouse Terms

When referring to how to use a mouse (when working with the AETG GUI), we use t
following terms:

1.3.2 Cascading Menus

Many AETG menu items contain a triangle that indicates that there is a submenu associat
with that menu item, such as the one in Figure 1-6. 

Click This means that you should place the mouse pointer on an item we 
identify in an AETG window and press down and release the left mou
button quickly.

Double click This means to press down and release the left mouse button twice in rapid 
succession.

Pointer This refers to the arrow that indicates the mouse position. 

Figure 1-6.  Cascading Menu Example
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For example, to access the function depicted in Figure 1-6, we would tell you to execute

Aetg->New->Folder

This means you would

1. Click on the Aetg  menu.

2. Click on the New menu option.

3. Click on the Folder  menu option.

1.4 On-line Documentation

This document is available on-line in the Adobe® Acrobat® PDF format. The PDF file is 
accessible from either the local file system or from an internal URL. See the AETG 
administrator for the location of the PDF file.

Viewing the PDF file requires that you have installed the Adobe Acrobat Reader® 
(Release 3.0). If you need the Acrobat Reader, contact the AETG administrator. In 
addition, you can download the Acrobat Reader directly (off the Internet) from Adobe
www.adobe.com. Follow the instructions detailed on the web page.

Once you have installed the Acrobat Reader, you can read the file

• Using the Acrobat Reader directly if the AETG System has been installed on a l
system.

• Using the Acrobat Reader as plug-in to a browser if the AETG System has not b
installed on a local system, such as if the system has been installed on a UNIX S
server and you are using an X-windows emulator to access the system on a PC
Consult your browser’s documentation for information on how to install plug-ins.

If you access the PDF file via a browser, you may wish to download the file to your lo
system, which will give you direct access to the file the next time you need to read the
rather than waiting for the browser to load it. 

1.5 Customer Support

You can get support for the AETG System from the MYNAH Customer Service Center
between 8:00 AM and 7:00 PM ET Monday through Friday by calling (732) 699-2668
Option 3; if outside the 732 area, call (800) 795-3119, Option 3.

During non-standard support hours and holidays, critical problem coverage is provid

You can also contact support (for non critical problems) via e-mail at 
mynah-support@cc.bellcore.com. 
1–8  
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2. A Quick Tour of the AETG System

Before we explain the AETG system in detail we want you to perform some simple ta
that will let you become familiar with how to use the AETG System and what it can do
you. This section provides a Quick Start, touching on the basic features of the AETG
System. 

NOTE — This section does not touch on all of the 
features of the AETG System nor provide detailed 
information on the features we do discuss.

In this Quick Tour, you will

1. Create a folder on the AETG desktop to contain the AETG objects.

2. Create a Format object and the required Field objects to define the interface.

3. Create a Test Hierarchy and Test object.

4. Create a Relation object to test all possible combinations of the Fields you create.

5. Generate the Test Case Matrix, which is the the list of the generated efficient set 
cases.

6. Change how the Fields interact with each other.

7. Regenerate the Test Case Matrix.

8. Specify fields to be excluded from a test case.

9. Regenerate the Test Case Matrix.
 2–1
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2.1 Define what you want to Test

Before you create the AETG objects, you first have to define what you are using the A
System to test (or model) and the rules of the test.

2.1.1 Define the Interface

This Quick Tour example uses the AETG System to model a very basic display, defi
the shape, color, and “attributes” of a display element. Table 2-1 lists the display elements
and the possible values for each element. Each element is defined using a Field object

2.1.2 Define the Rules of the Test

For the Quick Tour, you will use the AETG System to generate 

1. All possible permutations.

2. All permutations excluding Yellow Squares.

Table 2-1.  Quick Tour Elements and Values

Element Field Name Possible Values

Shape • Circle 

• Square

Color • Red

• Blue

• Yellow

Attribute • Blinking 

• Non-blinking
2–2  
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2.2 Start the AETG System 

Start the AETG System by typing 

xmyRunAetg 

in a standard UNIX window.

NOTE — Before you start the AETG System, your path 
must be set properly to contain $XMYDIR/bin. Also, your 
XMYHOME environment variable must be set. If you 
need to, call your AETG administrator for more 
information about doing this.

2.3 Registering as an AETG User

The first time you start the AETG System as a new user, the system displays a New
dialog (Figure 2-1). This dialog prompts you for basic information about yourself that t
system will store in its database. 

The system is case-insensitive to information you enter here; you can type information in 
upper case, lower case, or combination of upper and lower case. 

To enter information

1. Type in your last name in the Last Name  field.

2. Position the pointer in the First Name  field (you can Tab over to it or point and click 
with the mouse) and type in your first name. 

3. Position the pointer in the MI field and type in your middle initial. 

4. Position the pointer in the Email  field and type in your e-mail address. 

5. Position the pointer in the Phone  field and type in your business phone number.

6. Use the mouse to click the OK button in the bottom, left-hand corner of the dialog. 

Figure 2-1.  New User Dialog
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You are now registered with your local system as an AETG user.

The system displays the AETG Desktop (Figure 2-2). This is the first of many AETG 
System windows and dialog boxes. We will describe the AETG Desktop in Section 3. 

Figure 2-2.  MYNAH Desktop 
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2.4 Create a Folder

The AETG System lets you organize your work into items called Folders , which are the 
equivalent of UNIX directories or paper folders in which you place a number of docum

To create a folder

1. Execute

Aetg->New->Folder

A dialog box (Figure 2-3) appears requesting a name for the folder. 

2. Position the pointer in the Folder Name  text area and type in a name for it, for 
example, Quick Demo. 

3. Click on OK. 

The system creates a new folder and places it in the desktop display as a line item
Figure 2-4.) 

Figure 2-3.  Naming a Folder

Figure 2-4.  New Folder on the AETG Desktop
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4. Open the Folder by double clicking on the Folder’s icon. An empty Folder appears. 
(See Figure 2-5.) 

2.5 Create a Format Object

A Format object lets you 

• Document the interface you want to represent.

• Define all of the Fields on the Format.

To create a Format object

1. Execute

Folder->New->Format

A new untitled Format object item appears in the Folder. (See Figure 2-6.) 

Figure 2-5.  An Empty new Folder

Figure 2-6.  A new Untitled Format Object
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2. Open the Format object by double clicking on the Format object icon. By default
system displays the Format object’s Properties view. (See Figure 2-7.) 

3. Click on the Lock  icon (in the upper, right-hand corner of the view) to “Unlock” th
Format object.

NOTE — See Table 3-1 in Section 3.1.4 for a list of the 
icons in the AETG Tool Bar.

4. The AETG Format Name Dialog (Figure 2-8) appears. Enter a name for the Forma
object, for example, Display Format and click on OK. 

Figure 2-7.  Format Object Properties View

Figure 2-8.  AETG Format Name Dialog
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5. Optionally, you can

• Select the Format type by clicking on the Type  menu and selecting the type of 
interface the Format is, for example, AsyncScreen .

• Enter a description of the Format object.

The Format object Properties view will look similar to the one in Figure 2-9. 

6. Proceed to Section 2.6 to create the required Field objects and associated Values

NOTE — See Section 6 for detailed information on 
Format objects.

Figure 2-9.  Completed Format Object Properties View
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2.6 Create Field Objects and Values

A Field object lets you enter information about the Fields on a Format, such as the n
of the Fields and a list of valid values for the Fields.

Creating a Field object is a two step process.

1. You first create a Field object from a Format object’s Fields view.

2. You then specify possible values for the Field object.

You will create the Field object and values for the Shape display element listed in the first
row of Table 2-1. 

To create the Shape Field object

1. On the unlocked Format object you created in Section 2.5, display the Format object 
Fields view. You can do this in one of two ways:

• Click on the Fld  button on the Format object Tool Bar.

• Execute

View->Change View->Fields

The Fields view (Figure 2-10) appears. 

Figure 2-10.  Format Object Fields View
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2. Execute

Format->New->Field 

An untitled Field row, marked <new field> , appears in the Fields  list on the Format 
object, and a new unlocked Field object appears. 

Figure 2-11.  Creating a New Field Object
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3. Enter, at the minimum, a name for the Field object in the Name text area, for example, 
Shape.

NOTE — You can not include embedded spaces in a 
Field object name. However, you can include embedded 
spaces in a name you enter in the Logical Name  text area, 
for example, Element Shape.

The edited Field object will be similar to the one in Figure 2-12. 

Figure 2-12.  Entering a Name for a Field Object
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4. Execute

Field->New Value

An untitled Value row, marked <new-value> , appears in the Valid Values  list on the 
Field object. In addition, <new-value>  appears in the Value  text area and is 
highlighted, signifying that it is selected and you can type over this entry. 

NOTE — You can also create a new Values by executing 
Ctrl+N  (pressing and holding the Control  key and then the 
N key) or by clicking on the V button on the Tool Bar.

Figure 2-13.  Creating a New Value
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5. Enter the first value in the Value  text area, for example, Circle, and press either the 

Return  or Tab key. (See Figure 2-14.) The system accepts the value and enters it 
the Valid Values  list.

6. Execute

Field->New Value

to create a new Value row for the second Value.

7. Enter the second Value for example, Square, and press the Return  key.

Figure 2-14.  Entering a New Value
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8. To save the Value object, execute

Field->Save

Figure 2-15 shows the completed Field object. 

9. To close the Value object, execute

Field->Close

Figure 2-15.  Completed Shape Field Object
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10. Repeat Steps 2 through 9 to create the Color and Attribute Fields listed in Table 2-1. 
The completed Format object Fields view will be similar to the one in Figure 2-16. 

11. To save the Format object, execute

Format->Save

12. Proceed to Section 2.7 to create a Test Hierarchy and Test object for the test case

NOTE — See Section 7 for detailed information on Field 
objects.

Figure 2-16.  Completed Format Object Fields View
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2.7 Create a Test Hierarchy and Test Object

Test objects define the requirements used to verify or test a Format. Test objects always 
appear in their own Test Hierarchies , which are the equivalent of Folders.

To create a Test Hierarchy and Test object

1. In the Quick Demo folder, execute

Folder->New->Test Hierarchy

A new untitled Test Hierarchy item appears in the Folder. (See Figure 2-17.) 

2. Open the Test Hierarchy by double clicking on the Test Hierarchy icon. An empty Test 
Hierarchy (Figure 2-18) appears. 

Figure 2-17.  A New Untitled Test Hierarchy

Figure 2-18.  An Empty Test Hierarchy
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3. Unlock the Test Hierarchy. A Test Hierarchy Name  dialog appears (Figure 2-19), 
prompting you to enter a name for the Test Hierarchy, for example, Display Test 
Hierarchy.

4. Click on OK.

5. Execute

Hierarchy->New Test

A new untitled Test object (Figure 2-20) appears in the Hierarchy. 

6. Execute

Hierarchy->Save

NOTE — You must save a Test Hierarchy before you can 
edit a Test object.

Figure 2-19.  AETG Test Hierarchy Name Dialog

Figure 2-20.  A New Test Object
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7. Double click on the untitled Test object icon. The Test object opens, displaying 
Test object Properties view. (See Figure 2-21.) 

8. Unlock the Test object.

Figure 2-21.  Test Object Properties View
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9. Enter, at a minimum, a name for the Test object, for example, Display Test. 
Figure 2-22 shows an edited Properties view, including a description for the Test 
object. 

10. Proceed to Section 2.8 to associate the Test object with the Display Format Format 
object.

NOTE — See Section 9 for detailed information on Test 
Hierarchies and objects.

Figure 2-22.  Edited Test Object Properties View
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2.8 Create an Association

To create a test case, you must first associate  a Format object with a Test object, which
creates a link between the Format object and the Test object. Associating a Format 
with a Test object lets the Test object know what Fields and Values are available for th
case.

NOTE — A Test object can only be associated with one 
Format object at a time. However, a Format object can be 
associated with more than one Test object at a time.

You will

1. Use the AETG Database Browser to display the Format objects defined in the A
database.

NOTE — The AETG System Database Browser provides 
a quick and easy way of locating objects in the AETG 
Database. See Section 5 for information on using the 
Database Browser.

2. Select and copy the Display Format Format object you created in Section 2.5.

3. Associate the Format object with the Test object.

To associate a Format object with a Test object

1. Display the Test object’s Relations view. You can do this in one of two ways:

• Click on the Rel button on the Format object Tool Bar.

• Execute

View->Change View->Relations
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The Relations view (Figure 2-23) appears. 

Figure 2-23.  Test Object Relations View
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2. Execute

Tools->Database Browser

The Database Browser (Figure 2-24) appears. By default, the first time you open th
Database Browser during an AETG session, the Browser displays the Format ob
defined in the AETG database. 

3. Select the Display Format entry, and execute

Edit->Copy

NOTE — You can also select and copy the Display 
Format Format object from on the AETG Desktop.

4. Close the Database Browser by executing

Browser->Close

NOTE — See Section 5 for detailed information on the 
Database Browser.

Figure 2-24.  AETG Database Browser
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5. On the unlocked Display Test Test object Relations view, click in the Format  box (at 
the top of the view), and execute

Edit->Paste

A listing for the Display Format object appears in the Format  box. (See Figure 2-25.) 

6. Proceed to Section 2.9 to create a Relation object for the Display Test Test object.

Figure 2-25.  Associating a Format Object with a Test Object
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2.9 Create a Relation Object

Relation objects let you collect requirements data to establish how fields and values o
format relate to one and another.

To create a Relation object

1. On the unlocked Display Test Test object’s Relation view, execute

Test->New->Relation

A new unlocked Relation object (Figure 2-26) appears. 

Figure 2-26.  New Relation Object Properties View
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2. Enter, at the minimum, a name for the Relation object in the Name text area, for 
example, Display Rel. Figure 2-27 shows an edited Properties view, including a 
description for the Relation object. 

NOTE — For now you will accept the default Interaction 
Degree value, 2. You will change this value in 
Section 2.11.

3. Execute

Relation->Save

4. Proceed to Section 2.10 to generate the Test Case Matrix for this generation.

NOTE — See Section 10 for detailed information on 
Relation objects.

Figure 2-27.  Edited Relation Object Properties View
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2.10 Generate a Test Matrix

Now that you have created a Relation, you can generate the Test Case Matrix, which
list of the generated set of efficient test cases.

To generate the Test Case Matrix

1. Display the Display Test Test object. 

NOTE — If you can not see this object, you can display 
it using the Windows  menu. (See Section 3.1.3.7.)

2. Display the Test object’s Matrix view. You can do this in one of two ways:

• Click on the Mat button on the Test object Tool Bar.

• Execute

View->Change View->Matrix

The Matrix view (Figure 2-28) appears. 

Figure 2-28.  Test Object Matrix View
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3. Execute

Test->Matrix->Generate

The AETG System generates the Test Case Matrix based on the criteria you set 
Relation object. (See Figure 2-29.) 

Figure 2-29.  Generated Test Case Matrix
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4. To save the Test Case Matrix, execute

Test->Matrix->Save

The Save Matrix Dialog (Figure 2-30) appears. 

5. Enter a name for the Test Case Matrix, for example, Test Case 1, in the Save To  text 
area (Figure 2-31), and click on OK. 

Figure 2-30.  Save Matrix Dialog

Figure 2-31.  Entering a Name for the Test Case Matrix
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6. The Save Matrix Dialog disappears, and the name is entered on the Matrix view. (S
Figure 2-32.) 

7. Proceed to Section 2.11 to change the interaction degree.

NOTE — See Section 9.3.3 for detailed information on 
generating Test Case Matrices.

Figure 2-32.  Saved Matrix View
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2.11 Change the Interaction Degree

The Interaction Degree, which you set on the Relation object Properties view (Figure 2-26), 
determines how the fields in the generated test cases interact with each other. The 
interaction degree is restricted to an integer from 1 to N, where N is the number of Fields 
in the Relation. 

For example, a degree of 2 guarantees that, for any two fields, all possible value 
combinations are covered in the set of generated test cases. 

NOTE — See Section 10.2.1 for more information on the 
Interaction Degree.

For this Quick Tour, you will change the Interaction Degree to 3, the maximum value for 
this Relation. This creates all possible permutations for the defined Fields and Values.

To change the Interaction Degree

1. Display the Display Rel. Relation object’s Properties view, and unlock the object. (S
Figure 2-33.) 

Figure 2-33.  Unlocked Relation Object Properties View
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2. Select the current Interaction Degree value, 2, in the Interaction Degree  text area. 
(See Figure 2-34.) 

3. Type 3. (See Figure 2-35.) 

4. Execute

Relation->Save

5. Display the Display Test Test object’s Matrix view. 

Figure 2-34.  Selecting an Interaction Degree to Change It

Figure 2-35.  Specifying a new Interaction Degree
 2–31



AETG System Users Guide BR 007-252-007
A Quick Tour of the AETG System Issue 1, October 1997
Release 1.0   
6. Execute

Test->Matrix->Generate

The AETG System regenerates the Test Case Matrix using the new Interaction 
Degree. (See Figure 2-36.) 

7. Execute

Test->Matrix->Save

Figure 2-36.  Generated Test Case Matrix for new Interaction Degree
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8. Enter a new test case name in the Save Matrix Dialog, for example, Test Case 2, 
(Figure 2-37) and click on OK. 

9. Proceed to Section 2.12 to create an Exclude.

2.12 Create an Excluded Test Case

So far, you have used the AETG System to create test cases that generate all permu
for the defined Fields and Values. Often, however, there may be permutations you d
want to include in a Test Case Matrix. Conversely, there are permutations that you w
ensure are included. Further still, you may want generate test cases containing inva
values to do error condition testing. The AETG System lets you define such rules. 

For this Quick Tour, you will create an Excluded Test Case that omits all Yellow Squ
from the Test Case Matrix.

To create an Excluded Test Case

1. Display the Display Rel. Relation object.

2. Display the Relation object Excludes view. You can do this in one of two ways:

• Click on the Exc button on the Relation object Tool Bar.

• Execute

View->Change View->Excludes

Figure 2-37.  Saving the new Test Case Matrix
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The Excludes view (Figure 2-38) appears. 

3. Unlock the Relation object Excludes view.

Figure 2-38.  Relation Object Excludes View
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4. Execute

Relation->New->Exclude

The Name text area is populated with <new-test-case>, as is the Name field in the 
Excluded Test Cases  list. (See Figure 2-39.) 

Figure 2-39.  Creating a new Excluded Test Case
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5. Enter a name for the Excluded Test Case, for example, YellowSquares, and, 
optionally, a description of the Excluded Test Case. (See Figure 2-40.) 

NOTE — You cannot include embedded spaces in an 
Excluded Test Case name.

Figure 2-40.  Specifying an Excluded Test Case Name
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6. Select the values for the Excluded Test Case in the Values  list (at the bottom of the 
view).

A. Click on the Square entry in the Shape  column.

B. Hold down the Control  key, and click on the Yellow entry in the Color  column.

The Excludes view will be similar to the one in Figure 2-41. 

Figure 2-41.  Selecting Values for an Excluded Test Case
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7. Click on the Set button. This applies the selected values to the Excluded Test Case. 

The system displays a message that the values have been set for the test case.
Figure 2-42.) 

8. Execute

Relation->Save

9. Execute

Relation->Close

10. Display the Display Test Test object’s Matrix view. 

Figure 2-42.  Setting Values for an Excluded Test Case
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11. Execute

Test->Matrix->Generate

The AETG System regenerates the Test Case Matrix using the Excluded Test C
(See Figure 2-36.) 

12. Execute

Test->Matrix->Save

Figure 2-43.  Excluded Test Case Test Case Matrix
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13. Enter a new test case name in the Save Matrix Dialog, for example, Test Case 3, 
(Figure 2-37) and click on OK. 

14. Execute

Test->Close

15. The AETG System displays an alert dialog (Figure 2-45) asking you if you want to 
save your changes. Click on OK. 

NOTE — See Section 10.2.4 for information on creating 
Excluded Test Cases.

2.13 Exiting From the AETG System

If you wish to exit from the AETG System, execute

Aetg->Exit

Figure 2-44.  Saving the Excluded Test Case Matrix

Figure 2-45.  Save Changes Dialog
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2.14 What’s Next

This Quick Tour should have given you a general feeling for the AETG System and w
it can do for you. 

The remainder of this Users Guide provides detailed information on how to use the A
System. Table 2-2 list the sections in this document that contain information on how to 
the AETG System. 

Table 2-2.  AETG System Users Guide Sections

Section 
Number Section Name Description

Section 3 AETG Basics This section contains basic information on using
the AETG GUI.

Section 4 Using AETG Objects This section contains information on how to use 
AETG objects

Section 5 Using the Database 
Browser

This section contains information on the AETG 
Database Browser.

Section 6 Format Object This section contains information on Format 
objects, which describe a testable interface to an
application or a testing situation. 

Section 7 Field Object This section contains information on Field objects
which define the data values that are input to an
application.

Section 8 Compound Object This section contains information on Compound 
objects, which let you collect several Fields and 
treat them as one Field.

Section 9 Test Object This section contains information on Test objects
which define the means by which a requirement 
verified in a software application.

This section also contains information on how to
generate a Test Case Matrix.

Section 10 Relation Object This section contains information on Relation 
objects, which let you collect requirements data 
establish how fields and values on the format rela
to one another.

Section 11 Command Line Tools This section contains information on the AETG 
Command Line tools.

Section 12 Input Modeling with the 
AETG System

This section provides tips on how the AETG 
System could be used to model various types of
applications.
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3. AETG Basics

Although the GUI is easy to use, we will explain the basics of its operation in some d
here to help you enjoy the power of the AETG System.

This section covers:

• What folders are.

• The layout and operation of the system’s major windows and dialog boxes.

• Basic actions needed to navigate around the AETG System.

• Controls used in the AETG GUI.

• How to perform some routine tasks.

3.1 AETG Folders

Folders are provided for your convenience so that you can organize your work. You 
think of folders as drawers in a filing cabinet. For example, suppose you have a filing 
cabinet with three drawers. 

• The first drawer contained documents related to Release 1 of a software produc

• The second contained documents related to Release 2 of a software product. 

• The third drawer contained documents related to Release 3 of a software produ

In the AETG System, the filing cabinet itself would be the AETG Desktop. Within the 
AETG Desktop there could be other folders that correspond to drawers in the filing cabinet. 

• The first folder could contain objects related to Release 1.

• The second could contain objects related to Release 2.

• The third could contain objects related to Release 3.
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Figure 3-1 illustrates this idea. 

You can create folders when you need them and delete them when you no longer need
Folders can appear in the AETG desktop. You can move objects in and out of them 
copying the object from one folder to another.

The AETG Desktop is the first folder you encounter when you start the AETG System
serves as the main entry point to the system. (See Figure 3-2.) Unlike all other folders, the 
AETG Desktop cannot be created or deleted, but you can create and delete other fo
within it. 

3.1.1 What is the AETG Desktop?

You can think of the AETG Desktop as you would the top of your desk. It is a work sp
where you can collect all the objects and folders you will need for testing.

The top of your desk contains folders and tools, such as pens, a telephone, and a com
which help you do your job. The AETG desktop also has folders and tools that help 
create your test cases. 

In this chapter we will discuss some of these tools. In Section 4 we will discuss more of 
them. 

Figure 3-1.  What Are Folders?

Rel. 1

Rel. 2

Rel. 3

Filing Cabinet
AETG Desktop

Release 1
format
test hierarchy

Release 2
format
test hierarchy

Release 3
format
test hierarchy

One folder
for each
software
release

Forms 
related to
a release.
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Figure 3-2.  AETG Desktop List View

The AETG Desktop we have depicted above shows the List view. We will explain mo
about views in Section 3.5.

The basic window layout is the same for all folders as it is for the AETG Desktop. Th
layout we describe here applies to all other windows.

3.1.2 Title Bar

The top line of the window, called the Title Bar, displays the name of the GUI window
our example, the name of the folder, Desktop-List , appears here. 

NOTE — The AETG System was designed to use the 
Motif™ window manager, but will work with any 
X-windows manager. What elements you see on the Title 
bar will depend on which window manager you use.

When using the Motif window manager, the left-hand side of the Title Bar  contains the 
System Menu , represented by a small bar, which operates the window itself. When y

Menu 

Tool Bar

Client 

Status 

Scroll Bars

Title BarSystem Menu Minimize/Maximize
Buttons

Bar

Area

Bar
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click on the bar, the window manager displays the System  Menu that, depending on 
window manager, has the following menu selections:

On the right-hand side of the Title Bar  are two buttons. The smaller one on the left 
minimizes the window, i.e., turns it into an icon; the larger one on the right maximizes
window, i.e., increases the window size to the maximum allowed by the window man

3.1.3 Menu Bar 

The next line in the window is called the Menu  Bar. The menu bar contains all the menu
for the window you currently have open. Many of the activities you will do to perform
operations will begin from the menu bar. 

The Aetg , Selected , Edit , View , Tools , Windows , and Help  menus appear on the AETG
Desktop. The name of the first menu on a folder varies with the name of the window. So, 
for example, the AETG Desktop has Aetg  as the first menu. The Selected , Edit , View , 
Tools , Windows , and Help  menus appear on all windows although the menu selection
available on these menus sometimes vary. 

3.1.3.1 AETG Icon

An AETG System icon (Figure 3-3) appears to the left of the menus. 

If you click on the AETG icon, the system displays the AETG Banner window.

Restore Restores the window to its original size after you have re-sized it. This is
the maximized size, but the size the window was originally displayed by 
window manger.

Move Lets you move the window using the arrow keys or by dragging it.

Size Lets you re-size the window using the arrow keys or mouse.

Maximize Increases the window size to the maximum allowed by the window mana

Minimize Reduces the window to an icon.

Lower  Moves the window to the bottom of the window hierarchy.

Close Closes the window.

Figure 3-3.  AETG Icon
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We describe the AETG Desktop menus and their selections in some detail here. The
following sections of this Users Guide discuss variations in menu selections where 
appropriate. 

3.1.3.2 Aetg Menu

The menu selections for the Aetg  Menu are 

3.1.3.2.1 What Happens When You Save a Folder

To save a folder, click on the Save option of the first menu that appears on the left-han
side of the Menu bar. The system saves the contents of the desktop or folder.

NOTE — Remember, the AETG Desktop is a specialized 
folder.

The system saves the organization of folders and any preferences you selected to th
.xmyMYNAHrc file. This file is located in your home directory and is read by the syste
when you start-up the system. Every time you Save, the system copies the .xmyMYNAHrc 
file to a .xmyMYNAHrc.bak file and then saves to the .xmyMYNAHrc file.

While you are running the AETG System, it saves the contents of folders, the desktop
the preferences you selected every 60 seconds to a file named 
.xmyMYNAH.rc<hostname>.<process.id>. The system uses this file as a backup in the
unlikely event of a system crash. This ensures that you will never lose more than six
seconds of desktop work. This file is removed during normal exits, but if there is a cr
the system will ask you if you want to open it as the crash recovery file.

Save Saves the contents of the AETG Desktop, any preferences y
set with the AETG Preferences view and any queries defined 
the Database Browser. 

New Lets you create a new AETG object.

Iconify All Windows Reduces all open windows to icons. 

Exit Closes the main folder, any open folders, and exits to the UNIX 
prompt.
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3.1.3.3 Selected Menu

The Selected  Menu offers you actions that apply only to AETG objects you have selec
and to create new objects. Selections include: 

New Displays a cascade menu that lets you create new AETG objects on t
AETG Desktop or in a folder. (See Section 4 for a detailed explanation of 
AETG objects.)

Open Lets you open a selected object. 

Delete Deletes a selected object from the desktop and database.

Expand Fully Displays the complete contents (objects) of folder or hierarchies, i.e., 
displays all parent and child objects contained in the desktop or a fold

3.1.3.4 Edit Menu

The Edit  menu provides you with a number of editing features. Selections include:

Undo Cancels the previous change to a text field.

Cut Removes the selected item from the display and temporarily places it 
clipboard.

Copy Places a copy of a selected item on a clipboard.

Paste Retrieves an item from the clipboard and places it in the client area o
folder.

Clear Removes the selected item from the display, but does not place it on 
clipboard. 

Select All Places all visible items in a selected state.

Deselect All Deselects all visible items.

3.1.3.5 View Menu

The View  Menu lets you change to another view or refresh the AETG Desktop displa
Selections are:

Change View  Displays a cascade menu that lets you change the view for the curren
opened object. 

Refresh For the Desktop, refreshes the current view by removing objects from
display that are no longer in the database; for Folders and objects, ge
3–6  
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latest copy of object from the database; and for the Database Browser , 
reissues any defined or default queries. 

3.1.3.6 Tools Menu

The Tools  menu lets you display the Database Browser , which lets you search for 
objects in the AETG database. You can open or run objects directly from the Databa
Browser or copy them to a folder. See Section 4 for information on the Database Browse

3.1.3.7 Windows Menu

The Windows  menu helps you to manage the windows associated with the AETG Sys
Selections include all the currently opened windows even if they are iconified. Selec
one of the window names from the list brings that window to the top of your display.

3.1.3.8 Help Menu

The final menu on the AETG Desktop window is the Help  menu. The selections are:

Contents Displays a list of help topics. (Available in future releases.)

Procedures Displays a list of hypertext links to help on tasks and activities. 
(Available in future releases.)

Keyboard Lists key accelerators and their uses. 

On Help  Displays help messages on the help system. (Available in future
releases.)

On Icons Displays the icons that appear on the AETG Desktop, folders and 
Tool Bar, and gives a brief description of each.

On Version  Displays product information.

3.1.4 Tool Bar

As you can see in Figure 3-2, icons appear directly below the Menu Bar in what we call t
Tool Bar . These icons represent often used functions that correspond to menu selec
We placed them here for your convenience. The features available on the Tool Bar c
depending on the window. Table 3-1 lists the tools available with the AETG Desktop alon
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with a brief description of each tool. We will describe other tools when we discuss th
object view on which they appear. 

Table 3-1.  Tool Bar Icons and Functions

Icon Function What It Does

print Causes the system to display the Print dialog with 
which you can print the contents of objects or folders.

cut Removes the selected item and temporarily places it on
a clipboard. This does not remove items from the 
database. 

copy Places a copy of a selected item on the clipboard. 

paste Retrieves an item from the clipboard and places it in the
client area of folder. 

delete Deletes a selected item from the database and clears
from the display.

Save Saves the contents of the AETG Desktop, any 
preferences you set with the AETG Preferences view 
and any queries defined for the Database Browser.

change 
view

Changes the current view to the view represented by the
icon, e.g. Lst  changes view to the List view. Icons vary 
with the views available for an item. 

clear Removes the selected item from the desktop, but does
not place it on the clipboard.

refresh Refreshes the AETG Desktop view.

lock Unlocks the AETG item, making it ready for input or 
editing.
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You use the Tool Bar by clicking on the icon that corresponds to the function you wa
Depending on the icon you selected, the AETG System will either perform the action e.g., 
Cut , Copy , Paste , Change View ) or display a dialog with which to perform the function
(e.g., Print ). 

3.1.5 Client Area

The central part of the AETG Desktop window between the Toolbar and Status box 
called the client area. The client area is where you will perform most of the operation
needed for test and script development and execution. The AETG System displays t
contents of GUI objects in this area. 

3.1.6 Status Bar

The bottom line of the AETG Desktop is the Status Bar that displays text messages o
left-hand side. Two areas appear on the right-hand side of the Status Bar: one on ob
that displays the cursor location and the other that displays the current mode the AE
System is in. Mode refers to whether the object view is locked and inaccessible for editing 
or unlocked and ready for editing. When you unlock an object, the word EDIT will app
in the Status Bar.

3.1.7 Scroll Bars

The AETG Desktop has two scroll bars. One appears along the right-hand side of the 
window while the other appears directly below the client area. The scroll bar on the r
moves the client area display up or down. The scroll bar at the bottom moves the client are
display left or right. 

These scroll bars are particularly useful since the AETG display can have a virtual display
area, i.e., text is present that appears beyond the visible display. Scroll bars let you see this 
text. 
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Figure 3-4 shows how to use scroll bars. 

Figure 3-4.  Using Scroll Bars

Scroll

Click on arrows
to move display 
up or down

Click on arrows to move
display left or right

Status Display Area
Bars

Drag 
rectangle 
to slide 
display up 
or down

Drag rectangle to slide 
display left or right
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3.2 AETG Dialogs

The AETG System uses a number of Dialogs (often called dialog boxes) to help you
perform test and task-automation activities. In general, dialogs are windows accessed from
a folder that presents you with a number of controls with which to perform actions 
supporting the function of the folder from which they were called. 

The AETG System uses three basic types of dialogs:

• Dialogs that let you complete or control operations you initiated from a folder or ob
view. 

• Dialogs that let you set the properties of objects. 

• Dialogs that present system information to you such as error messages. 

We will describe other dialogs where appropriate in the sections that follow.

3.3 Navigating Around the AETG GUI

The AETG GUI provides you with a number of controls to help you move through wind
and dialog boxes and perform operations. Generally, the way you get from one folde
another is by making a menu selection or activating an icon. 

3.3.1 Using the Mouse

Table 3-2 defines several terms used when describing mouse actions throughout this
manual. All of these terms refer to action you take with the left mouse button. You do not 
use the right mouse button for any AETG specific operations. 

Table 3-2.  Mouse Actions

Action Description

Click Press and release the mouse button.

Double Click Press and release the mouse button twice.

Drag Place the pointer on an object or menu. Press the 
mouse button and hold it while moving the 
pointer. Release the mouse button when the 
action you want is accomplished.
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3.3.2 Using Icons

Icons are graphical representations of objects and folders that appear in the client area
also represent tools in the Toolbar. We have already discussed the icons in the tool 
and how to use them. (See Section 3.1.4.) Here we will describe the icons that appear in th
client area. Folders and other objects can be reduced to an icon when you are not u
them. Figure 3-5 shows a folder reduced to an icon. 

An arrow appears next to an icon if the icon represents a folder that contains other ob
For example, if we had a folder that contained a number of other objects, an arrow w
appear next to it as we have illustrated. The peak of the arrow points at the object when the
object has not been expanded. We will explain how to use the arrow when we descri
List view (Section 3.6). 

To transform an open object into an icon:

1. Click on the first menu 

2. Click on the Close  menu selection.

To activate a window that has been iconified, double click on the icon that represent
object.

3.3.3 Making Menu Selections

You can select an item from a menu by clicking on the menu and then clicking on the 
selection you want. You can also use Mnemonic keys. 

3.3.4 Using Mnemonic Keys

Mnemonic keys are individual keys you can use rather than the mouse to make men
selections. Letters that correspond to mnemonic keys appear underlined in the menu
selection name. The alt  key combined with a single keystroke can initiate menu selections. 
For example, you can open a selected object by typing alt and S and then O , e.g., S for 
Selected menu and O for Open. 

Figure 3-5.  AETG Icon
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3.3.5 Using Accelerator Keys

The AETG GUI provides accelerator keys. Accelerator keys are key combinations tha
can use instead of mouse actions to make menu selections and perform other comm
actions. Table 3-3 list the common accelerator keys for the AETG Desktop. 

There are other accelerator keys. These are listed next to the menu selections they perform. 

Table 3-3.  Key Accelerators

Keys Function

Ctrl+P Print

Ctrl+X Cut

Ctrl+C Copy

Ctrl+V Paste

Ctrl+/ Select all items

Ctrl+\ Deselect all items

Ctrl+F4 Close

Del Delete selected item

F5 Refresh 

Esc Deselect a menu.

Tab Moves the cursor focus from one 
data entry field to the next. 
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3.4 AETG GUI Controls

If you are familiar with common GUI controls, you can skip most of this section and go
to Section 3.4.5.

There are a number of common controls you will have to use to accomplish tasks asso
with testing. You may be familiar with many of these, but we describe them here for 
in case you need a quick refresher course on GUIs.

3.4.1 Using Spin Buttons

Spin buttons are GUI control that helps you to make settings. You use spin buttons t
values when the values are an ordered exclusive set. Figure 3-6 shows some typical spin 
buttons. 

To set a value with a spin button, perform one of the following:

• Click on the up or down arrows that appear next to the Value display. The up ar
increases the value in the display area; the down arrow decreases the value. 

• Position the pointer in the value display area and type in a value.

3.4.2 Using Toggle Buttons

Toggle buttons are simple on/off buttons. Toggle buttons can appear in a group or 
individually. Figure 3-7 shows a toggle button. 

To set a toggle button, click on it to set it on or off. When it is ON the button will be 
highlighted.

Figure 3-6.  Spin Buttons

Figure 3-7.  Toggle Buttons

IncreaseDecrease
ValueValue

Toggle Button - OFF Toggle Button - ON
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3.4.3 Using Radio Buttons

Radio buttons let you select one option from a group of options. They are exclusive 
settings; you can only select one from a group. Figure 3-8 shows a group of radio buttons
with All Code  selected. 

3.4.4 Using Pushbuttons

Pushbuttons are GUI controls used to execute actions that affect the entire window. 
generally appear at the bottom of an AETG window or dialog. You activate a pushbu
by clicking on it. Figure 3-9 shows typical pushbuttons arranged at the bottom of a wind

Table 3-4 lists the pushbuttons used with the AETG System.

Figure 3-8.  Radio Buttons

Figure 3-9.  Pushbuttons

Table 3-4.  Pushbuttons and Their Functions (Sheet 1 of 2)

PushButton Function 
OK Acknowledges messages from the system and approves 

changes to settings. Usually, this button also closes the 
window.

Apply Commits the current setting on a window without closing the 
window.

Reset Cancels changes made to the window content and returns the
window to the last approved settings.

Stop Stops any ongoing processes.

Continue Continues a process that has been interrupted.

Retry Lets you retry a process interrupted by the operating 
environment.

Pause Suspends an ongoing process without terminating it.
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3.4.5 Using Ruler Column Headings

In many AETG views and dialogs we use what are called Ruler Column Headings. 
Figure 3-10 shows a window from the Database Browser (See Section 4) in which all the 
column headings are rulers. If you position the pointer on a column edge and drag it

Resume Continues a process that was paused (See Pause  above.)

Close Closes a window without affecting a process.

Cancel Closes a window without applying any changes to a window’s 
content that have not been applied (See Apply  above.)

Yes Indicates a positive response to information contained in a 
message.

No Indicates a negative response to information contained in a 
message.

Defaults Use default values.

Help Displays contextual help information for a window.

Table 3-4.  Pushbuttons and Their Functions (Sheet 2 of 2)

PushButton Function 
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can make the column wider or narrower. This will be useful when the information displayed 
in the column exceeds the default column size. 

If you double click on a column heading in the ruler, the system will sort objects base
the attributes in that column. For example, if you wanted to arrange objects based o
owner of the object, you would double click on the Owner column heading. Figure 3-10 
shows Script objects sorted in alphabetical order based on the “Owners” name. 

Figure 3-10.  Database Browser Displaying Format Objects

Double
click here
to sort
based on
“owner.”

Drag column
edge to enlarge
column.
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3.5 What Are Views?

The AETG System uses what we call views. Views appear as a windows on your ter
screen when you open an AETG object. Views organize information about objects. E
view displays a certain type of information about an object.

Objects can have up to six different views. You can think of views as pages of informa
about an object or as screens in a traditional character based application. Views also 
enter information about objects and associate objects with other objects. 

The AETG Desktop we displayed in Figure 3-2 uses a List view to represent objects as lin
items with icons and text descriptions. This is one of three AETG Desktop views. The 
two are Preferences and Default View views. 
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3.6 List View

List Views are very important in the sense that List views are where you begin with t
AETG System and they are views to which you will return often. List views show you
the objects available in a folder. Figure 3-11 shows a list view for the AETG desktop.

The List view illustrated in Figure 3-11 shows only the first level of objects in your objec
tree. But an object can be expanded to show all the child objects within it, which we will 
explain in the next subsection. 

3.6.1 Expanding Items in a List View

To expand an object’s listing, click on the arrow next to the object’s iconic representatio
For example, if you clicked on the arrow for icon labelled AETG in Figure 3-11, the view 

Figure 3-11.  AETG Desktop - List View
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would expand as shown in Figure 3-12. Note that the arrow next to the icon points down 
indicate that this is an expanded display of the object. 

Items that appear on the AETG Desktop may have several levels of items below them
hierarchical relationship. When you click on the arrow next to a list item’s icon, as we
above, the system shows only the first level of the hierarchy. 

To see all the levels in a selected item’s hierarchy, execute

Selected->Expand Fully

The system will display all the levels of a hierarchy, as shown in Figure 3-13. 

Figure 3-12.  List View Expanded
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Figure 3-13.  List View Expanded Fully
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3.7 Using the Preferences View

The AETG Desktop Preferences view (Figure 3-14) lets you set items that affect all object
and processing done during the session. 

The Default Settings are:

Figure 3-14.  AETG Desktop Preferences VIew

Printer Sets the AETG System printer. This selection will appear 
automatically on all print dialogs. 

Font Sets the font size for system displays.
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3.7.1 Saving Default Settings

You can change default values. As an example, let’s go through the default settings as if we 
were setting them. 

1. Position the pointer in the Printer  data entry area and type in a printer name, e.g.,
printer1 .

2. To learn how to select a font, see Section 3.7.2. 

3. Position the pointer in the Database Max Size data entry area and type in a numbe
e.g., 250.

4. Position the pointer in the Max Test Cases data entry area and type in a number, e.g
600.

5. Check Unlock Objects When Created if you want the system to automatically ope
newly created objects. 

Database Max Size Specifies the number of objects displayed in a Database 
Browser view with initial queries. For example, if you specified 
50 objects here and the system found 100, the system woul
prompt you to choose either the number you select here (50
the number found (100). See Section 4 for information about 
the Database Browser. 

Max Test Cases Specifies the number of test cases that the system will 
automatically load into a Test object Matrix view. See 
Section 9.3.3.6.

Unlock Objects When 
Created

Lets you set whether or not newly created objects will 
automatically be unlocked by the system when opened for th
first time.
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Figure 3-15 shows an edited Preferences view. 

If you save the Preferences view, the settings will become the default settings for all
subsequent AETG sessions until you change them again. If you don’t save these se
they will remain in force for the current session and then revert to the last saved defa
settings for the next session.

To save these preferences, execute

AETG->Save 

Figure 3-15.  Edited AETG Desktop Preferences VIew
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3.7.2 Selecting The Default Fonts

To change the default font:

1. Click on the Font  pushbutton that appears in the client area of the Preferences view.

The Font Chooser dialog in Figure 3-16 will appear. The top panel of the dialog show
the alphanumeric characters for the current font. 

2. Choose a font Family  by clicking on the one you want, e.g., Lucida .

Notice that the system changes the font display in top panel.

3. Choose a Face by clicking on the one you want, e.g., sans  bold .

4. Choose a Size by clicking on the one you want, e.g., 14.

NOTE — Don’t set Size to anything over 14.

5. Click Apply  or OK  to change the fonts.

Figure 3-17 shows the new font on the Preferences view.

Figure 3-16.  Font Chooser Dialog
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Like the other default preferences, if you change the default font it will remain in force until 
you change it again with the Font Chooser dialog. 

3.8 Changing an AETG View

You can change your view during a session using the View  menu or by clicking on the Icon 
in the Tool Bar that corresponds to the view you want. Changing views will be a very
common activity as you summon different views to complete test and scripting relate
tasks. 

To change a view perform either of the following:

• Click on the icon in the Tool Bar that corresponds to the view you want, e.g., clickPrf  
to change to the Preferences view on the AETG Desktop. 

Figure 3-17.  Preferences View with Font Change
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• Execute

View->Change View

and select the view you want from the Change View  drop-down list.

3.9 Creating Folders

As we said earlier, you can create folders and use them to organize your work. We w
create a folder where we will place all the items needed to document, develop, and an
tests for an application. We will name this folder AETG Demo .

You create folders from the AETG Desktop. To do this:

1. Execute

Edit->Deselect All

to make sure nothing is selected.

2. Execute

AETG->New->Folder

The system will display a dialog requesting a name for the new folder (Figure 3-18.) 

3. Enter a name in the Folder Name  field, e.g., AETG Demo .

4. Click OK.

Figure 3-18.  Requesting Information Dialog
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The AETG System will display the icon for the new folder. (See Figure 3-19.) The system 
will display the folder under the new name you gave it. Note that since this is a folde
arrow appears next to it even though there is nothing in the folder yet. 

You can open this folder by double clicking on its icon in the List view. You can crea
objects from within it, or copy objects into it using the Database Browser. We explain how 
to use the Database Browser in Section 4.

NOTE — Test objects do not appear in ordinary folders 
but in special folders called hierarchies. See Section 9 for 
information on Test Hierarchies. 

3.9.1 Saving Folders

To save a folder, execute

Folder->Save 

3.9.2 Deleting Folders

You can delete a folder the same way you delete any other object, which will be expla
Section 4. However, you must remember to remove all objects from a folder before you
delete it. 

3.9.3 Changing a Folder’s Name

After you have created a folder you can change its name using the Folder Properties
To access this view, perform one of the following:

• Execute

View->Change View->Properties

• Click on the Pro  icon. 

Figure 3-19.  New Folder Icon
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The system will change the view to the one shown in Figure 3-20. 

We will explain an object’s Properties view in detail when we discuss the object in th
sections that follow. Here we will explain how to change the name of the folder. 

To change the name of a folder:

1. Erase the old name.

2. Type in a new name.

3. Execute

Folder->Save

to save the folder under the new name. 

Figure 3-20.  Folder Properties View
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3.10 Printing

The AETG System provides you with a print feature for most objects. You send 
information to the default printer, specify another printer, or print to a file. 

You access the Print feature from the first menu that appears in the Menu bar. For exa
for Format objects this is the Format  menu. When you do this, the system will display th
dialog shown in Figure 3-21. 

The printer specified as your default printer Preferences view appears in the Printer  data 
display area. You can simply click OK at this point and the system will print the content
of the current object according to the default settings. 

You can choose to change any of the settings by: 

1. Positioning the pointer in the Printer  data entry area and typing in another printer 
name. 

NOTE — Print Range, Copies, and Collate Copies will 
be available in future releases. 

2. If you want to print the contents of the object to a file, click on the Print to File  toggle 
button and type the output destination in the File data entry area. 

3. After you make your selections, click OK to print. 

Figure 3-21.  Print Dialog
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Figure 3-22 shows an example of a Print Dialog box where we have entered a printer
destination and the name of a file that will contain the printout. 

If you print the output to a file, you must specify, at a minimum, the path to the direct
where you want to store the output file, e.g., /bdfs/users/ksb/AETG. 

If you specify a path, the AETG System saves the file using a system generated filen
of the form <Objectname>.n, where

• <Objectname> is a type of AETG object that lets you generate output

• n is a system generated number.

For example, if you want to print a Format object and you specify a path only, e.g., 
/bdfs/users/ksb/AETG, then the AETG System will generate an output file with a full pa
and filename such as /bdfs/users/ksb/AETG/Format.3120.

You can override the system generated filename by specifying your own filename, e
/bdfs/users/ksb/AETG/Format_output.

When you print information directly from the GUI, your output may not line up correc
due to the internal fonts installed in the printer.

Figure 3-22.  Example Print Dialog Box
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For example, Figures 3-23 and 3-24 show the same excerpt of the printout generated b
Format object. Figure 3-23 shows an example of a printout generated on a printer usin
fixed width fonts. 

**FORMAT PROPERTIES VIEW**
 
Name: Main Screen                    SysID: 4
Version: 1
Owner: ksb
Type: AsyncScreen
Description:
 
 
Created By: ksb             Date: 05/30/1997   Time: 11:00:17
Revised By: rachel          Date: 06/05/1997   Time: 14:50:13
 
 
 
**FORMAT FIELDS VIEW**
 
 
Fields:
Seq. Name                           Logical Name                   Compound
---------------------------------------------------------------------------
1    Login ID                       Login Id                       logon
3    Passwd                         Password                       logon
2    Date                           Date
 
Compounds:
Name
---------------------------------------------------------------------------
logon
 
**FORMAT ASSOCIATIONS VIEW**
 
 
Tests:
ID         Hierarchy & Path                    Name
---------------------------------------------------------------------------
3164       AETG Test Hierarchy:                Login Test

Figure 3-23.  Printout Using Fixed Width Fonts
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Figure 3-24 shows an example of the same output generated on a printer using varia
width fonts. 

As you can see, the headings and the data in Figure 3-24 do not line up because of the 
difference in width for each character.

If you wish to have your the text in your printout line up, save the printout to a file and 
the file to a printer using the lp command.

**FORMAT PROPERTIES VIEW**
 
Name: Main Screen                    SysID: 4
Version: 1
Owner: ksb
Type: AsyncScreen
Description:
 
 
Created By: ksb             Date: 05/30/1997   Time: 11:00:17
Revised By: rachel          Date: 06/05/1997   Time: 14:50:13
 

**FORMAT FIELDS VIEW**
 
 
Fields:
Seq. Name                           Logical Name                   Compound
---------------------------------------------------------------------------
1    Login ID                       Login Id                       logon
3    Passwd                         Password                       logon
2    Date                           Date
 
Compounds:
Name
---------------------------------------------------------------------------
logon
 
**FORMAT ASSOCIATIONS VIEW**
 
 
Tests:
ID         Hierarchy & Path                    Name
---------------------------------------------------------------------------
3164       AETG Test Hierarchy:                Login Test

Figure 3-24.  Printout Using Variable Width Fonts
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3.11 Exiting From the AETG System

If you wish to exit from the AETG System, execute

Aetg->Exit
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4. Using AETG Objects

We introduced you to the concept of views and what they are in the AETG System in
Section 3. Here we will introduce you to another key concept: objects. We will also exp
how to organize objects and perform routine activities with them. 

In this section we will describe:

• What objects are

• How views are related to them

• Test hierarchies

• Creating new objects

• Opening objects for editing and updating

• Deleting objects.

4.1 What Are Objects?

AETG objects represent all of the entities you need to create your test cases. They rep
entities such as a format or test. Information contained in objects are called attribute
Attributes  are pieces of information that define the object and are used by the AETG
System to refine test case generation. For example, a Test object has a name and co
of information that identifies the test and helps you keep track of changes made to th
Table 4-1 lists all of the AETG objects. 

Table 4-1.  AETG Objects

Object Function 

Format Describes a testable interface to an application or a testing situation.
is the only AETG object that can appear on the AETG Desktop or in 
folder.

Field Defines the data values that are input to an application. Field objects
created and accessed from within Format objects.

Compound Gives you the option to collect several Fields and treat them as one 
Compound objects are created and access from within Format objec

Test Defines the means by which a requirement is verified in a software 
application. Test objects reside in Test Hierarchies.

Relation Lets you collect requirements data to establish how fields and value
the format relate to one another. Relation objects are created and acces
from within Test objects.
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The AETG System stores objects along with the object’s attributes in its database. A
objects have a Created By attribute that identifies who created the object and Revised By 
attribute that identifies who made the last changes to the object. Other object proper
vary with the function of the object. 

You can think of Objects as database records that store information and attributes as
within a database record. 

4.1.1 How Views and Objects Work Together.

Views display an object’s attributes. Views are like screens in a character-based appli
in that they display information and let you enter information. A single object usually 
several views, each of which displays a different set of an object’s attributes. Views let y
enter information into and retrieve information from the object. The AETG System 
processes this information in the course of helping you with your activities. 

4.2 Test Hierarchies

Test objects always appear in their own Test hierarchies, which are similar to folders
Section 9.2 for information on working with Test hierarchies.
4–2  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Using AETG Objects
  Release 1.0

 
y the 
4.3 Creating Objects

It is easy to create new objects, but once you create a new object you still have to define its 
attributes. This too is fairly simple, but it varies from object type to object type. In this
section we explain the basic actions to create an object. We will explain how to specif
attributes for each object in later sections of the manual.

4.3.1 Creating Objects on the AETG Desktop

To create an object on the AETG Desktop, click on the AETG menu, on the New menu 
selection, and finally on the object type you want. 

For example, to create a Format object, execute

AETG->New->Format

The system will place the new object in the first position on the AETG Desktop. (See 
Figure 4-1.) 

Figure 4-1.  New Format Object on AETG Desktop
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4.3.2 Creating New Objects in Folders

You can create objects in both opened and closed folders. 

4.3.2.1 Creating New Objects In Open Folders

To create objects in open folders

1. Open the folder by double clicking on its icon.

2. In the folder window, click on the Folder menu, on the New menu selection, and 
finally on the type of object you want, e.g., execute

Folder->New->Format

as shown in Figure 4-2. 

Figure 4-2.  Creating an Object in an Open Folder
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4.3.2.2 Creating New Objects In Closed Folders

To create objects in closed folders

1. Select the folder, as shown in Figure 4-3. 

2. Click on the Selected  menu, on the New menu selection, and finally on the type of 
object you want, e.g., execute

Selected->New->Format

as shown in Figure 4-2. 

The System will expand the folder’s listing on the AETG Desktop and place the obje
the first position. (See Figure 4-5.) 

Figure 4-3.  Selecting a Folder

Figure 4-4.  Creating an Object in Closed Folder

Figure 4-5.  New Object Created In a Closed Folder. 
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4.4 Opening Objects for Editing

You edit objects by opening them and changing the data in them. Here we will describe
to open an existing object so you can edit it. In later sections we explain how to ente
information into an object. The way you enter data is the same whether you are enterin
for the first time or changing information already there. The only difference is that you will 
probably have to erase data if you are editing an object.

To open an object for editing, perform one of the following:

• Double click on its icon 

• Select the object, and execute 

Selected->Open

• Select the object and press alt and S, then o.

The AETG System will open the object to the delivered default view unless you have
changed the default view with the AETG Preferences view, in which case the system
open the object to the view you specified. From here you can change an object’s attr
or associations.

4.5 Copying Objects

When you are copying closed objects from one folder to another, you use the Copy  
selection on the Edit  menu. However, if you want to copy opened objects you have to 
the Copy Object  menu option. 

To copy a closed object:

1. Highlight the object.

2. Execute

Edit->Copy

To copy an opened object, execute

Edit->Copy Object

Once you have copied the object into the clipboard, you can paste it into a Folder, th
AETG Desktop, or a ruler area.

NOTE — Paste does not create a new object. It simply 
makes a link to an existing object. 
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4.6 Duplicating Objects

When you want to copy a Format, Test, or Relation object, you must use the Duplicate  
option on the Selected  menu. Duplicate  creates a new object with many of the attribute
of the original. 

To duplicate a Test or Format object, simply select the object and execute

Selected->Duplicate

How you use the Duplicate  option depends on which object you are duplicating. Therefo
we will discuss the usage of the Duplicate  option when we discuss each object.

See Section 6.2.4 for information on duplicating a Format object.

See Section 9.2.4 for information on duplicating a Test object.

See Section 9.3.2.3 for information on duplicating a Relation object. 

4.6.1 The Differences Between Copying and Duplicating Objects

There are differences between copying an object, and duplicating an object. 

• Copy  and Copy Object  don’t create a new object. They create a link between the
existing object and a new location (folder or the AETG desktop) so you can acces
object from the new location. 

• Duplicate  creates a new object in the AETG database and copies some (but not
attributes to the new object. The attributes copied over to a duplicated object depen
on the object being duplicated. Table 4-2 lists what attributes and associations the 
system copies to the new object when you use Duplicate . 

a. This attribute is only copied when you create a new version of an existing Format object. See Figure 6.2.4.

Table 4-2.  Attributes Copied by Duplicate

Object Attributes

Format Namea, Owner, Type, Fields, Compounds

Test Priority, Type, Description

Relation Name, Field Values, Description, Includes, Excludes, 
Invalids
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4.7 Deleting Objects

When we speak of deleting objects we mean deleting objects from the AETG database
can remove objects from the AETG Desktop display or from a folder or Hierarchy display 
using the Cut  or Clear  selection on the Edit  menu. These actions simply remove an obje
from the display, but does not remove it from the database. 

You must be careful when deleting objects since deleting an object may cause other 
to happen. 

Here are some things you should keep in mind when deleting objects. 

• When you delete hierarchies, all objects in the hierarchy are deleted no matter w
owns them.

• When you delete a Test parent object, child objects are deleted.

• All of an object’s associations are removed.

Generally, only the owner of an object or the AETG System Administrator can delete
object.

To delete an object from the AETG database,

1. Select the object you want to delete.

2. Execute

Selected->Delete

The system will remind you of the consequences of delete with a pop-up dialog and as
to confirm the deletion before removing the object from the AETG database and from the
display. 

4.8 Removing Objects from the AETG GUI Display

As we mentioned earlier, you can remove objects from the GUI display using either theCut  
or Clear  selection on the Edit  menu. Cut  removes the object from the desktop and copie
it to the clipboard; it can then be pasted elsewhere in the GUI. Clear  completely removes 
the object from the GUI. Once you use Clear , the object can not be retrieved or pasted.

NOTE — Untitled objects cannot be copied to the 
clipboard, therefore, you can not use Cut  on untitled 
objects. You can, however, use Clear  to remove untitled 
objects from the display.
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4.9 Objects’ Status and Default View

An object’s revision history appears on all Properties views for objects that appear in
AETG database. Figure 4-6 shows the Status display area for a Test object. 

The Status area displays the Date and Time an object was Created or Revised, and the 
name of the user who created or revised it. 

The system displays the Default View for the object directly below the Status area. This is 
the view specified as the default on the AETG Desktop’s Preference view.

4.10 Modifying Another Person’s Objects

The xmyConfig.General file contains a parameter that specifies whether a user has th
ability to modify other people's objects in the AETG GUI. If this parameter is set to fa
only the owner of an object or an administrator will be able to edit the object. 

NOTE — All users will still be able to open the object in 
read-only mode.

The ability to open Test Hierarchies for editing purposes is not affected by the settin
this configuration tag; non-owners and non-administrators can open Test Hierarchie
editing even if NonOwnerObjectModification  is set to false . 

Figure 4-6.  Object Status Display and Default View Area 
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4.11 Multiselecting Objects

While working with the AETG System, you often have to multiselect objects, that is y
select more than one object at a time. For example, if you choose to create a Compo
(Section 6.2.2.2.1 and Section 8), you must select more than one Field objects from a 
Format object, such as shown in Figure 4-7. 

There are several methods you can use to multiselect objects.

• To multiselect non-adjacent items,

1. Click on one item you want to multiselect.

2. Control-click on the other items you want to multiselect, that is, hold down th
Control  key (Ctrl ) while you click with the Left  mouse button.

• To multiselect adjacent items,

1. Click on the first item one item you want to multiselect

2. Drag through the list of object until you select all of the objects you want to 
multiselect.

• To deselect a highlighted item, Ctrl-Click  on the value. 

Figure 4-7.  Multiselecting Fields Objects on a Format Object
4–10  
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5. Using the Database Browser

The AETG System Database Browser provides a quick and easy way of locating objec
in the AETG Database

In this section we cover:

• Accessing the Database Browser.

• Changing Object Type.

• Defining include queries.

• Changing the owner of an object.

• Associating objects with other objects.

• Using Person objects.

5.1 How the Database Browser Helps You

When using the AETG System, you create many objects to support your activities. These 
objects are stored in the AETG Database. The Database Browser provides quick an
way of locating objects.

The Database Browser is the chief tool for managing objects, since it allows you to dis
open, and edit all existing objects. 
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5.2 Accessing the Database Browser

To access the Database Browser, execute

Tools->Database Browser 

The system displays a Database Browser main window such as the one shown in 
Figure 5-1. 

Figure 5-1.  Database Browser Window
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5.2.1 Displaying Object Types with the Database Browser

By default the system displays Format object when you first access the browser, but
can select any object you want using the Database Object  option list. 

For example, if you wanted to see Test objects, you would simply execute

Database Object->Test

You can specify what objects will appear based on query criteria you enter. (See 
Section 5.2.2.) If more than 100 objects of the selected object match your query in the
database, the system will display the dialog shown in Figure 5-2.  

After you respond to the AETG Question dialog, the system displays a list of Test ob
similar to the one shown in Figure 5-3. Remember, you can sort objects by an attribute 
double clicking on a column heading since this is a “ruler” display. See Section 3 for an 
example of doing this. 

Figure 5-2.  AETG Question Dialog
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Figure 5-3.  Database Browser Window with Test Objects Displayed
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5.2.2 Using the Include Dialog

The Include dialog allows you to filter out objects based on criteria you enter. It prov
you with a way to control how many objects appear in the Database Browser. This will
you to organize objects in a convenient way. You can also specify attributes for an o
and even conditions between attributes to select objects included in the Browser. 

You access the Include dialog by executing

View->Include  

The system will display the Include dialog shown in Figure 5-4. 

An Include query contains an object Attribu te, Value and a Condition between them. In 
addition, there are logical operators that define relations between rows (Cont.). We provide 
default queries for most objects. 

Figure 5-4.  Include Dialog
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You can see the current query for Format objects in Figure 5-5 is

name is <Main Screen> END

This will search for a Format named Main Screen. 

5.2.2.1 Object Attributes and Default Queries

Table 5-1 shows the attributes used with objects and the default include queries. 

Figure 5-5.  Include Query Example

Table 5-1.  Include Attribute and Default Query

Object Type Attributes Default Query What Query Does

Person id, authority, firstname, 
<keyword>, lastname.

Authority NOT EQUAL 
“Inactive”

Displays all Person 
objects except 
Inactive.

Format id, name, OwnedBy, 
Type, Version Number

None Displays all Format 
objects.

Test id, measureEffort, 
measureImport, name, 
OwnedBy, priority, 
Type

OwnedBy is <login> Displays Test objects 
you own.

Test 
Hierarchy

id, name, RevisedBy, 
WhenRevised, 
CreatedBy

None Displays all Test 
Hierarchies. 
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5.2.2.2 Conditions Between Attributes and Values

When you define an Attribute  for the include statement, you have to define a Condition 
between the attribute and the attribute’s Value. The Conditions available are defined by 
the Attribute  you select. The conditions you can use are:

5.2.2.3 Relations between Rows

You must specify a relationship between rows for queries with multiple rows. The possible 
values for Cont. are 

END Indicates that the statement is not continued. There are no other condi

and Indicates that this statement plus the next statement(s) define the que

or Indicates that this statement or the next statement but not both define
query. 

5.2.2.4 Using the Include Dialog Example

To illustrate the Include dialog, we find all the Test objects owned by a user named “
that are the type “Test Case.” We use two rows in the Include dialog to do this. 

• The first row finds all the scripts owned by ksb .

• The second finds all of ksb’s Formats that are the type Test Case .

We connect these two rows with and so that the system finds Format objects satisfying 
both conditions simultaneously. If we select or , the system finds all the Format objects that 
satisfies one or the other of the conditions, but not necessarily both. For example, a F
object owned by someone other than ksb but that has the type Test Case is included
Database Browser display. 

is The attribute has the specified value.

is not The attribute does not have the specified value.

Greater Than The attribute has a value greater than the specified valu

Greater Than or Equal To The attribute has a value greater than or equal to the 
specified value.

Less Than The attribute has a value less than the specified value.

Less Than or Equal To The attribute has a value less than or equal to the specif
value.

Contains The attribute contains this value.
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From the Database Browser with Test objects selected:

1. Execute

View->Include  

The system displays the Include dialog shown in Figure 5-6. Since we selected the 
Include dialog from the Database Browser with Test  selected, the dialog will be set to
filter for Test objects. 

2. To add the first row, click on the Add Row  pushbutton.

The system will add a row to let you set attributes and conditions.

3. To specify the Attribute , Conditions and Values for the first row:

A. Select an attribute from the first Attribute  drop down list. (e.g., Owned By ).

B. Select a condition from the Condition option list. (e.g., is )

C. Select a value from the Value option list or type a value. (e.g., the owner’s name 
ksb ).

NOTE — If the Condition is Contains, then you may 
type a partial value. The system will match all values that 
contain that partial value.

Figure 5-6.  Test Object Include Dialog
5–8  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Using the Database Browser
  Release 1.0

ilar 

TG 
After you complete selecting items for the row, the Include dialog would look sim
to the one shown in Figure 5-7. 

4. To specify the second row, click on the Add Row  pushbutton.

The system will add another row to let you set attributes and conditions. The AE
System automatically set its relation to the first condition will be set to and , which is 
what we want.

5. To specify the Attribute , Conditions and Values for the second row:

A. Select an attribute from the first Attribute  drop down list. (e.g., Type )

B. Select a condition from the Condition  option list. (e.g., is )

C. Select a value from the Value  option list. (e.g., Test Case )

Figure 5-7.  Include Dialog with One Condition Specified.
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After you complete selecting items for the row, the Include dialog would look sim
to the one shown below in Figure 5-8. 

6. Click the Apply  pushbutton.

The system will retrieve all the script objects that meet the criteria specified.

The system will save this query as your default query if you do a Save. 

Figure 5-8.  Include Dialog with Two Conditions Specified.
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5.2.2.5 Deleting Rows From the Include Dialog

You can delete rows from an Include query. To do this

1. Click on the square at the beginning of the row you want to delete. (See Figure 5-9.) 

2. Click on the Delete Row  push button. 

The system will delete the row you checked. 

5.2.3 Opening Objects With the Database Browser

As we said earlier, you can open objects directly from the Database Browser window
do this

1. Click on the object you want to open to select it. 

2. Execute 

Open->Selected 

You can also simply double click on the object row item.

In either case, the system will open the object you selected and display its default vie

Figure 5-9.  Deleting a Row
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5.3 Using Person Objects

As we said earlier, most information in the AETG System is represented as an object. 
AETG user is represented as a Person object. That includes you! 

When you first logon to the AETG System, it will prompt you for your name, login id, a
telephone number. This information is stored in your Person Object.

Your system administrator maintains all person objects and in general you can‘t crea
edit other user’s Person Objects. You can however access Person objects and look 
information they contain. You can also access your own person object and make cha
to the data in it. 

5.3.1 Viewing Person Objects

To view Person Objects:

1. Execute 

Tools->Database Browser

2. Select Person  as the Database Object.

The system will display a list of Person objects.

3. Open the Person object you want to view by performing one of the following:

• Double clicking on it.

• Execute 

Selected->Open
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Figure 5-10 shows a Person object Properties view we opened. The person object we
opened happens to be for a user with Administrative privileges. 

Note that there is no lock icon on this view because you can’t change any information
you can’t change information in another user’s Person object. As you can see from 
Figure5-10 each Person object lists: 

User ID The UNIX user ID.

Last Name The user’s last name.

First Name The user’s first name.

MI The user’s middle initial.

Email The user’s email address.

Phone The user’s phone number.

Authority System authority granted the user. 

Default View The currently specified default view. 

Figure 5-10.  Person Object Properties View
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5.3.2 Changing Data in Your Person Object. 

You can change the data that appears in your Person object. The only data you can change
are the data you entered when you logged on to the AETG System for the first time. You 
cannot change information entered by the System Administrator.

To change information in your person object:

1. Execute 

Tools->Database Browser

2. Select Person  as the object Type .

3. Select your Person object.

4. Open it by performing one of the following:

• Double clicking on it.

• Execute 

Selected->Open

The system display the Person object’s Properties view (Figure 5-11). 

Figure 5-11.  Person Object Opened for Editing
5–14  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Using the Database Browser
  Release 1.0

 with 
5. Click on the Lock icon to unlock the Person object.

6. Highlight the information you want to change and delete it.

7. Type in new information. 

8. Repeat Steps 6 and 7 for each piece of information you want to change.

9. To save your changes, execute 

Person->Save 

5.3.3 Using the Person Object Information View

The Person object Information view allows you to see the Keyword objects associated
a Person object. You access the Information view by clicking on the Inf  icon or by clicking 
on the View  menu, the Change View  menu selection and then selecting the Information  
view from the list. The system will display the Information view shown in Figure 5-12. 

Figure 5-12.  Person Object Information View
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You can enter comments in the Comment area if this is your Person object. To enter
comments:

• Position the pointer in the first free line of the Comments area 

• Type in the text. 

When you are finished copying in Keyword objects and entering comments, execute

Person->Save 

to save your changes.
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6. Format Object

A Format object describes a testable interface to an application or a testing situation
interface, or situation, can represent any of the following: 

• A Screen (e.g., 3270 or Asynchronous screen)

• A Message (e.g., a defined message between two applications, such as a Rem
Procedure Call or a contract message)

• A Protocol (e.g., a defined protocol between any two entities, such as a 
communication protocol)

• A Flow (e.g., a defined flow of data or logic)

• A Configuration (e.g., this could represent a set of valid combinations of applicat
or it could represent all of the Tags and Values in a configuration file)

• Any other testing situation that can be represented as a set of fields.

6.1 Why use a Format Object

You use a Format object to document the interface that you are trying to represent a
define all of the fields on the format. 

6.2 Working a Format Object

You create a Format object by executing one of the following from either the AETG 
Desktop or from within a folder. 

An untitled Format object appears on the Desktop or in a Folder. You may then open
and save the Format object. Editing entails defining the Fields and Values for this Format. 

To create a Format object … Then

On the AETG Desktop On the AETG Desktop, execute

AETG->New ->Format

In an open Folder In a Folder, execute

Folder->New->Format

In a closed Folder 1. Select the Folder.

2. Execute

Selected->New->Format
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You may optionally create Compounds, which group Fields so that you can treat the 
as one unit.

The Format object has three views:

The default view is the Properties view (Figure 6-1).

6.2.1 Properties View

The Format object Properties view (Figure 6-1) lets you enter or update such information
as the Name, Owner, and Type of the Format object. 

Properties Used to define the Properties for the Format object. (See Section 6.2.1.)

Fields Used to create Fields and, if desired, Compounds for the Format Obj
(See Section 6.2.2.)

Associations Used to display what Test(s) you have associated with this Format 
object. (See Section 6.2.3.)

Figure 6-1.  Format Object Properties View
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The Properties view contains the following parameters: 

Name Lets you enter a name for the Format object, e.g., Main Screen.

This is a required parameter.

Version An AETG System generated number for the version of the Format obj
which helps you track changes to a Format object from release to rele
The initial Version number for a new Format object is 1 and is 
incremented by 1 for each duplicate you make of the Format object. (
Section 6.2.4 for information on duplicating a Format object.)

This is a display only parameter. 

Type A drop-down menu that lets you specify the kind of interface being 
represented. Valid values are 

3270Screen The Format object represents a synchronous (3270) 
screen.

asyncScreen The Format object represents an asynchronous scree

guiScreen The Format object represents a screen of a GUI base
application.

config The Format object represents a configuration screen.

other The Format object type is indeterminate.

Default= other . 

This is a required parameter.

NOTE — The Type parameter does not affect the resulting test case
matrix but provides you with an added means of documenting the tes

Owner Specifies the person who is currently responsible for maintaining this
Format object. By default this is the person who created the Format ob

This is a required parameter. 

Description Lets you enter a description for the Format object, e.g., the purpose or 
contents of the Format object. 

Status Displays who created or revised the Format object and when the Format
object was created or revised. 

This is a display only parameter.
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The combination of the Name and Version number uniquely creates a title for the Fo
object, which appears in the Title bar in the format 

name.version#

For example, if you entered Logon Screen for the Name and the Version number is 1, then

Logon Screen.1

appears in the Title bar.

This name (e.g., Logon Screen.1) also appears in the List view of the Folder in which yo
placed this Format object. (See Figure 6-14.)

6.2.2 Fields View

The Fields view (Figure 6-2) lets you define the elements of the Format used to input d
to an application. 

Figure 6-2.   Format Object Fields View
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The Fields view contains the following parameters:  

6.2.2.1 Working with Fields

The Fields list contains the following columns: 

Fields Contains a list of Field objects associated with a Format object. Field 
objects define the data values that are sent as input to an application. 
single Field object is called a Simple Field .

This is a required parameter.

See Section 7 for detailed information on Fields Objects.

Compounds Contains a list of Compound objects associated with a Format object. 
Compound objects are optional and let you collect several Fields and treat
them as one. A Compound is a Complex Field , made up of several simple
Fields and specific values.

See Section 8 for detailed information on Compound objects.

Seq. The Sequence Number within the Format for this Field. (See 
Section 6.2.2.3.)

Name The user-provided Field Name. This Field Name must be uniqu
for a Format. (See Section 7.2.1.)

Logical Name The user-provided Logical Name given to the Field. (See 
Section 7.2.1.)

Compound Name The name of a Compound that the Field participates in. If the Fie
does not participate in a Compound, this column is blank. (See
Section 8.)
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6.2.2.1.1 Creating a New Field Object

To create a new Field object

1. Make sure that the Format Object is unlocked.

2. Execute

Format->New Field 

An untitled Field row, marked <new field> , appears in the Field list and a new 
unlocked Field object is displayed. (See Figure 6-3.) While the Field is untitled, the 
Seq. column contains dashes.

Figure 6-3.  Creating a New Field Object
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NOTE — While an Untitled row exists in the Field  list, 
the New Field  menu item is disabled.

3. Enter, at a minimum, a Field Name and at least one Value for the newly created
object. (See Section 7.2.1.1 for information on specifying values.)

NOTE — To specify a Value, you must first execute

Format->New Value

WARNING — Two Fields in a single Format cannot 
have the same Field name.

4. Save the Field object.

The new Field is placed after a selected Field row or at the end of the list if no Field r
currently selected. 

The Sequence Number of the new Field is populated when the Field is saved for the
time. All other Sequence numbers are updated if necessary.

6.2.2.1.2 Copying Field Objects

Field objects can be copied from another Format object or from within the same Form
object. To copy a Field object

1. Select the Field object you want to copy in the Fields  list area.

2. Execute

Edit->Copy

3. You can now paste the copied Field object. 

To paste the Field Object(s)… Then

To another Format object 1. Open the Format object. If needed, chang
the view to the Fields view.

2. Unlock the Format object.

3. Click on the Fields  list area, and execute

Edit->Paste 

Within the same Format object 1. If needed, unlock the Format object.

2. Execute

Edit->Paste 
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In either case, the dialog in Figure 6-4 appears, prompting you to enter a name for th
pasted Field object. 

NOTE — No two Field objects within the same Format 
object can have the same name. If you enter a Field object 
name that already exists within the Format object, an error 
dialog such as the one in Figure 6-5 appears. When you 
click on OK, the Field object name dialog in Figure 6-4 
reappears, and you must enter a unique Field object name 
or click on Cancel  to cancel the paste. 

When a Field object is copied, the following Field object attributes are copied:

• Logical Name

• Description

• Parameters

• Field Values.

6.2.2.1.3 Deleting Field Objects

To delete Field Objects

1. On an unlocked Format object, select one or more Field objects in the Fields  list.

Figure 6-4.  Pasted Field Object Dialog

Figure 6-5.  Duplicate Field Object Name Error Dialog
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2. Execute

Edit->Delete 

The row corresponding to the deleted Field object(s) is removed from the Fields list.

NOTE — If a Field is associated with a Relation 
(Section 9.3.2.1), the AETG System sounds an error beep 
and tells you which Relation(s) are affected, otherwise the 
system deletes the Field and will removes the row from 
the display.

6.2.2.2 Working with Compound Objects

The Compounds list contains only one column, Compound Name , which contains the 
user-provided names of Compound objects.

6.2.2.2.1 Creating Compound Objects

If you have created more than one Field objects, you can collect several Fields and 
them as one. This is done using a Compound object.

NOTE — Compound objects are optional, but can help 
enhance your test cases.

To Create a Compound object

1. Select two or more Field objects in the Fields  list area. (See Figure 6-6.) 

See Section 4.11 for information on how to multiselect Field objects.

Figure 6-6.  Selecting Field Objects for a Compound
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2. Execute

Format->New->Compound 

An untitled Compound row, marked <new-compound>, appears in the Compounds
list and a new unlocked Compound object (Figure 6-7) appears. By default, the 
Compound object’s Properties view appears. 

Figure 6-7.  Compound Object Properties View
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NOTE — A Field object cannot participate in more then 
one Compound. If you select a Field object that 
participates in a Compound, the error dialog in Figure 6-8 
appears when you execute

Format->New->Compound . 

NOTE — When an Untitled Compound row exists in the 
Compound list, the New Compound  menu item is 
disabled until you save or close and discard the Untitled 
Compound object.

3. You must 

• Provide a Name for the newly created Compound object

• Generate at least one Tuple, which is a reference name given to the specific 
set of a Compound. (See Section 8.2.3.1.)

All other data input is optional. 

See Section 8 for more details about working with Compound objects.

4. Save the Compound object

The Fields view of the Format object are updated with the following:

• The Compound Name is populated in the Compound row item

• The Compound Name is populated in each participating Field row.

A Format Object cannot have two Compound objects with the same name. If you try to save 
a Compound object using the name of an existing Compound object, the AETG System 
prompts you to enter a new Compound name.

Figure 6-8.  Field used in Existing Compound Error Dialog
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6.2.2.2.2 Deleting Compound Objects

To delete Compound objects

1. Select one or more Compound rows in the Compounds  list.

2. Execute

Edit->Delete

The row corresponding to the deleted Compound object is removed from the Compounds  
list. The indicators in the Compounds column of the Field objects that participates in
Compound are also removed.

NOTE — If a Compound object is associated with a 
Relation (Section 9) an error dialog (Figure 6-9) appears 
telling the you which Relation(s) use this Compound.

6.2.2.3 Field Sequence Numbers and Rearranging Field Objects 

Field object sequence numbers determine the order that Field objects are displayed
Format object. Sequence numbers also determine the initial order in a new Relation 
(Section 9). 

The rows in the Field list are always sorted by the Sequence number. However, you
rearrange Fields by using a simple drag and drop method. This changes the Fields seq
You select a Field and drag it to a new position using the Middle mouse button. 

To rearrange Fields

1. If the Format object is locked, click on the lock icon to unlock it.

2. Position the pointer on the Field you want to move.

Figure 6-9.  Deleting Used Compound Error Dialog
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3. Press down and hold the Middle  mouse button while dragging the Field to a new 
position. The Field you select is “boxed”, i.e., the lines surrounding the Field are 
darkened. (See Figure 6-10.) 

4. Release the Middle  mouse bottom when the Field is in the position you want. 

The system moves the Field to the new location and the system regenerates the seq
numbers of all affected Fields. (See Figure 6-11.)

Figure 6-10.  Selecting a Field for Rearranging

Figure 6-11.  Resequenced Field Objects
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6.2.3 Associations Views 

The Format object Associations view (Figure 6-12) displays what Test(s) you have 
associated with this Format object, i.e., those Test objects that have access to the Field
Values defined by this Format object. See Section 9.3.2.1 for information on how to 
associate a Test object with a Format object. 

Figure 6-12.  Format Object Associations View
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6.2.4 Duplicating a Format Object 

When you want to copy a Format object, you must use the Duplicate  option on the 
Selected menu. Duplicate  creates a new Format object with many of the attributes of 
original object. 

When you execute

Selected->Duplicate

the Duplicate Format Dialog (Figure 6-13) appears. 

• If you select the New Version of Existing Format Object  option, the AETG System 
creates an exact duplicate of the Format object with an iterated Version Number. (S
Section 6.2.1 for information on Format object Version Numbers.)

NOTE — When you use this method to duplicate a 
Format object, all attributes of the original object are 
copied over to the new Format object except associated 
Test objects, e.g., all Fields and Compounds are copied to 
the new Format object.

• If you select the New Format Object  option, the AETG System creates a “clone” o
the Format object.

NOTE — When you use this method to duplicate a 
Format object, all attributes of the original object are 
copied over to the new Format object except for the name 
of the Format object and associated Test objects.

Figure 6-13.  AETG Duplicate Format Dialog
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Sections 6.2.4.1 and 6.2.4.2 assume you have the Format object in Figure 6-14. 

NOTE — Remember, the name of a Format object as it 
appears in a Folder’s List view is a combination of the 
name you entered on the Format object Properties view 
and the system generated Version Number.

6.2.4.1 Creating a New Version of Existing a Format Object

If you select the New Version of Existing Format Object  option, the system creates a new
Format object as a sibling of the original Format object, as shown in Figure 6-15. The 
Format object name is retained, but an iterated Version Number is created for the ne
Format object. In addition, the system assigns the duplicate Format object a new ID  
number. 

6.2.4.2 Creating a New Format Object

If you select the New Format Object  option, the system creates a new Format object a
sibling of the original Format object, as shown in Figure 6-16. The system gives the new 
Format object the name of Cloneof.<id>, where <id> is the ID number of the original 

Figure 6-14.  Original Format Object

Figure 6-15.  Creating a New Version of an Existing Format Object
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Format object, in this case the new Format object name is Cloneof.7008. The system 
assigns the duplicate Format object a new ID  number. 

Figure 6-16.  Creating a Clone of a Format Object
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7. Field Object

Field objects define the data values that are sent as input to an application. A Field o
belongs to a version of a Format object.

7.1 Why use a Field Object

A Field object, in combination with the Format object it belongs to, defines an interfac
testing situation. The Field object lets you enter such information about a Field on a Fo
as the name of the Field and a list of valid values for the Field.

7.2 Working with Field Objects

You create a Field object on a Format object (Section 6.2.2.1.1) by executing

Format->New Field 

The Field object has two views:

The default view is the Values view (Figure 7-1). 

Properties Used to define the Properties for the Field object. (See Section 7.2.2.)

Values Used to enter create the values that is entered in the Fields you de
for the Format object. (See Section 7.2.1.)
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7.2.1 Values View

The Field object Values view (Figure 7-1) lets you enter information for the Field object,
such as the name and valid values for the Field on the Format. 

The Values view contains the following parameters: 

Figure 7-1.  Field Object Values View

Name Lets you enter a name for the Field being specified. This should be
name of the Field as it appears on the Format, e.g., loginID .

NOTE — You can not include embedded spaces in a Field object 
name. 

This is a required field.

Logical Name Lets you enter an optional name for the Field that can be a name u
by other users to identify this field, e.g., login ID .

NOTE — You can include embedded spaces in a name you enter in
Logical Name  text area.
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7.2.1.1 Specifying Valid Values

The Valid Values  area contains a list showing all defined values for the current Field. The 
Valid Values  area also contains the following parameters that let you specify new va
or change the specifications for existing values: 

Seq. Displays the Sequence Number for this Field within the corresponding 
Format. (See Section 6.2.2.3.)

This is a display only field.

Parameters Lets you enter a list of parameters for this Field. (See Section 7.2.1.2.)

Valid Values Contains a list showing all values that have been specified for this 
Field. This area also lets you specify valid Values and Value Types
be used as input for your test cases. (See Section 7.2.1.1.)

The fields in this parameter are required.

Value A text entry box that lets you enter the values for this field.

Type A drop-down menu that lets you select what type of value is being specified:
Literal  or Non-Literal .

A literal value is a string that must be entered explicitly on the Format, such 
program name or login ID.

A non-literal is a string that you do not wish to (or cannot) explicitly specify. F
example, if you need to represent values that are long, you can use a non-lit
value. Another example would be when you want to specify a value that can
be typed, such as a dial-tone. 
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Table 7-1 provides some examples of value types.

NOTE — Values may contain embedded and leading 
blanks. However, Values cannot contain trailing blanks. If 
a Value must contain trailing blanks, set the Type  to 
Non-Literal  and let the system set the value.

When you create a new Value (See Section 7.2.1.1.1), a new, highlighted, Value row is 
added to the Value list. The Value column is prepopulated with the value <new value> , and 
the Type column is prepopulated with Literal  . The Value text box is also prepopulated wit
the value <new value>  . This value is automatically highlighted, indicating that you can
type in this text area to change the value. You can also select a different Type for this
Value. 

The new Value row in the list is updated when you hit Enter  or when you leave this area of
the window, either by tabbing or by clicking on any other parameter in the Values vie

You must enter all values you wish to include in the valid set of values for a Field. If a F
can take a large range of values, you can enter just a few values from the range. Fo
example, for a numeric field, you can enter the smallest value in the allowed range, 
largest value, and one value from the middle of the range.

Table 7-1.  Field Object Value Type Examples

Entered Value Specified Type Interpretation

“abc” Literal Specifies the string “abc” , including the quotes.

dog is brown Literal Specifies the string dog is brown . Note that the 
quotes are not necessary.

ADDRESS NonLiteral A non-literal value that represents an address.

DIALTONE NonLiteral A non-literal value that represents a dial-tone.

NULL NonLiteral A non-literal representation of a null value.

BLANK NonLiteral A non-literal representation of the absence of value.

OMIT NonLiteral A non-literal representation of the absence of a tag i
message.
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Values must be unique within a Field object. If you hit Enter  or Tab from the Value text 
area and the value is not unique, the error dialog in Figure 7-2 will appear. You must then 
enter a new, unique value. 

7.2.1.1.1 Creating New Values

To create a new Value

1. On an unlocked Field object, execute

Field->New Value

A new Value row is added to the list, as shown in Figure 7-3. 

Figure 7-2.  Non-unique Value Error Dialog

Figure 7-3.  Creating a New Value
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2. Enter a new value in the Value text box (Figure 7-4). Since the text box is already 
highlighted, you can start typing immediately, overwriting the prepopulated value. 

3. If you wish to change the Type of value, click on the Type  drop-down menu and select
the value type you desire.

4. Hit Enter  or Tab to update the Value list.

5. Perform one of the following:

• Repeate Steps 1 through 4 to enter another value.

• Save your values to the database by executing

Field->Save

NOTE — If a value is not unique, the error dialog in 
Figure 7-2 appears when you save the Field object.

Figure 7-4.  Entering a New Value
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7.2.1.1.2 Changing Values

To update an existing Value row to change a Value

1. On an unlocked Field object, select a Value row. The Value  text area is populated with
the current Value  and Type , as shown in Figure 7-5. 

2. Enter a new, unique Value (in the Value  text box) and/or change the Type .

3. Hit Enter  or Tab. The Value row is updated.

Figure 7-5.  Selecting a Value to Change
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7.2.1.1.3 Copying Values

To copy an existing value

1. On an unlocked Field object, select an existing value and execute

Edit->Copy

2. Execute

Edit->Paste

The copied value appears in the Valid Values  list. (See Figure 7-6.) 

3. Change the text in the Value  text box. (All values within a Field object must be 
unique.)

NOTE — If you save the Field object without changing 
the value text, the error dialog in Figure 7-2 appears 
telling you that the value text is not unique. 

Figure 7-6.  Pasting a Copied Value
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7.2.1.1.4 Deleting Values

To delete a Value row

1. On an unlocked Field object, select an existing row.

2. Execute

Edit->Delete

If the value is not currently being used by a Compound or Relation, the selected row
removed from the display. If the value is used by a Compound or Relation, an error d
similiar to the one in Figure 7-7 appears informing you what Compound and/or Relation
use the value. 

7.2.1.2 Specifying Parameters

You can specify a list of parameters that provide more information about the Field. F
example, you might enter Row=1, Col=1 indicating that this Field is in the upper left han
corner of a screen.

The Parameters attribute is free form text so it may be used in any way you desire.

Figure 7-7.  Deleting a Value Error Dialog
 7–9



AETG System Users Guide BR 007-252-007
Field Object Issue 1, October 1997
Release 1.0   
7.2.2 Properties View

The Field object Properties view (Figure 7-8) lets you enter a Description for the Field 
object. 

7.2.3 Printing a Field Object

To print a Field object, execute

xmyPrintFormatFields format_name.version_number

where format_name is the name you entered for a Format object and version_number is 
the system generated version number of the Format object.

NOTE — If a Format object name contains embedded 
spaces, replace the spaces with a backslash-escaped space 
character (‘\ ‘).

For example, to print the Field object in Figure 7-8, you would execute

xmyPrintFormatFields Main\ Screen.1

For more information on xmyPrintFormatFields , see Section 11.3.

Figure 7-8.  Field Object Properties View
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8. Compound Object

The Compound object lets you collect several Fields and treat them as one Field. 

NOTE — Compound objects are not required. However, 
using Compounds can help simplify your test cases.

8.1 Why use a Compound Object

By collecting several Fields and treating them as one, a Compound object simplifies
Formats having many blocks of interrelated fields. A Compound object can reduce the 
complexity of relations in the Relation Object. (See Section 10.)

8.2 Working with Compound Objects

You can create a Compound object when you have created more than one Field obj
Simply select the Fields you want added to the Compound object and execute

Format->New Compound 

You can create any number of Compound objects for a Format, but once a Field is u
a Compound it is no longer eligible for use in another Compound.

Once you have created a Compound object, you must create at least one Tuple for t
Compound object by executing

Compound->Generate Tuple

You can not save a Compound until you generate at least one Tuple. A Tuple  is a reference 
name given to the specific value set of a Compound. This symbolic value can be exp
into the specific values of the simple Fields represented by the compound. (See 
Section 8.2.3.)

If Tuples do exist but you have modified the Fields or Values and have not regenerate
Tuples, the AETG System ask you if want to save the changes and regenerated the 

The Compound object has three views:

The default view is the Properties view (Figure 8-1). 

Properties Used to define the Properties for the Compound object. (See 
Section 8.2.1.)

Fields Used to select the values that participate in the Compound. (See 
Section 8.2.2.)

Tuples Used to create Tuples for the Compound object. (See Section 8.2.3.)
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8.2.1 Properties View

The Compound object Properties view (Figure 8-1) lets you enter the name and a 
description of a Compound object. You can also select a maximum Tuples (Max Tuples
value. 

The Properties view contains the following parameters: 

Figure 8-1.  Compound Object Properties View

Name Lets you enter a name for the Compound object.

This is a required field.
8–2  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Compound Object
  Release 1.0

 

Max Tuples Determines the maximum number of Tuples that the AETG System 
generates in the Tuples view. 

See Section 8.2.3.1 for information on generating Tuples.

Valid values are in the range 1 to 30.

Default = 20

Note —  The system will not allow more than 30 Tuples because this
would cause too many test cases in the ultimate Test Matrix.

To specify a Max Tuple value, perform either of the following:

• Click on the Spin Button arrows to change the value 

• Type the value directly in the text box.

Description Lets you enter a description for the Compound object, e.g., the purpose or 
contents of the Compound.

Status Displays who create or revised the Compound object and when the 
Compound object was created or revised.

This is a display only field.
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8.2.2 Fields View

The Fields view (Figure 8-2) lets you select the fields and values that participate in the
Compound. 

The Fields view contains the following areas: 

Figure 8-2.  Compound Object Fields View

Interaction 
Degree 

Lets you specify how the fields will interact with each other when the
system generates Tuples. See Section 8.2.2.2.

Click on one of the following radio buttons:

• Unrelated

• Cross  Product .

The default setting is Unrelated .

Fields in 
Compound

Lists all of the Fields that were selected on the Format window when y
created the Compound object. All values for these Fields are also 
populated.
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8.2.2.1 Selecting Values to Participate in a Compound

You Ctrl-Click  on values from each Field’s value list (Figure 8-3) to multiselect the values 
to be assigned to the Fields for the current Compound when you generate Tuples fo
Compound. 

NOTE — See Section 4.11 for information on how to 
multiselect items.

NOTE — At least one value must be chosen from each 
Field in the Compound. 

To clear all selections, execute

Edit->Deselect All

NOTE — When selecting values to participate and 
generating Tuples for those values, it is important to 
attempt to minimize the number of values you choose. A 
large number of values may produce a large number of 
Tuples, which could lead to more complexity in the 
ultimate Test Matrix rather than simplifying it, defeating 
the purpose of the Compound field.

Figure 8-3.  Multiselecting Values to be used in a Compound
 8–5



AETG System Users Guide BR 007-252-007
Compound Object Issue 1, October 1997
Release 1.0   

ill use 
8.2.2.2 Selecting an Interaction Degree

You can specify the degree of interaction between selected values that the system w
during a Generate Tuples  operation (Section 8.2.3.1). This is done using one of the 
following radio buttons on the Fields views (Figure 8-2).

Unrelated Generate Tuples  produces enough Tuples to include each of the 
values at least once.

Cross Product Generate Tuples  produces enough Tuples to include every 
combination of every value.
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8.2.3 Tuples View

The Tuples view (Figure 8-4) shows the Tuples that have been generated for the Compo
object. See Section 8.2.3.1 for information on generating Tuples. 

The Tuples View contains the following parameters

Each Tuple is made up of a Name (which is initially generated by the AETG System) and
one value for each of the Fields in the Compound. These Tuples are the values for t
Compound. 

Figure 8-4.  Compound Object Tuples View

Tuples A list containing a column listing the Name of the Tuple and a column for ea
value in the Tuple.

Tuple 
Name

A text box displaying the name of a Tuple you selected in the Tuples list. The 
text box lets you change the name of the Tuple. (See Section 8.2.3.2.)

Count Displays the total number of generated Tuples.
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For example, if you 

1. Have three fields (e.g., F1, F2, F3) and two values for each field

2. Select all of the values 

3. Generate Tuples using Cross Product.

the AETG System generates eight (8) Tuples (e.g., value combinations). At this point, you 
can consider the Compound as one Field having eight possible values. 

8.2.3.1 Generating Tuples

To generate a Tuple

1. On the Compound object Fields view (Figure 8-5)

• Multiselect your desired values for each Field.

• Choose the Interaction Degree. 

Figure 8-5.  Selecting Fields and Interaction Degree for Generating Tuples
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2. Execute

Compound->Generate Tuples

The AETG System generates the appropriate Tuples (Figure 8-6) based on your selections
on the Fields view. 

NOTE — The Tuples view does not appear automatically 
when you generate Tuples. To view the Tuples, you must 
either execute

View->Change Views->Tuples

or click on the Tpl  button.

Generating Tuples can be an iterative process or it can be done all at once. 

For example, if you selected all values in a Compound and chose the Cross Product  
Interaction Degree, then Generate Tuples  produces the maximum possible number of 
Tuples for the value set. In this case, there would not be any point in generating mor
Tuples. In fact, if you tried to generate new Tuples, the new Tuples would be truncat

Figure 8-6.  Generated Tuples
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However, if you want to be more selective about the Tuples to be generated, then yo
generate the Tuples iteratively by

1. Selecting a few Values.

2. Generating the Tuples.

3. Selecting a different set of Values.

4. Repeating Steps 2 and 3 until you are satisfied with the resulting Tuple set.

In the iterative case, Generate Tuples  appends any new Tuples that are generated to t
list of already existing Tuples. You can also choose a different Degree of Interaction  for 
each iteration. Therefore, the setting of Degree of Interaction only has meaning for a
particular run of Generate Tuples . 

For each run of Generate Tuples , all duplicate Field/Values are discarded. However, th
AETG System will not discard any duplicate combinations when appending Tuples to an
existing Tuple list. 

For example, if you generate a set up Tuples using the selections from Figure 8-5 and 
generate a new set of Tuples without changing the selected Values, the AETG Syste
appends the Tuples list with a set of identical Field/Value combinations, but each ne
combination has a new Tuple name, as shown in Figure 8-7. 
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Figure 8-7.  Regenerating an Indentical Tuple Set
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When generating Tuples, the system generates only the number of Tuples specified bMax 
Tuple Count . Once this number is reached, all other Tuples are truncated. A confirm dialo
(Figure 8-8) appears if more than the maximum allowed Tuples are generated. 

You are asked if you want to add any Tuples, and, if so, whether to add Tuples up to
Max Tuple Count  setting.

If you have already generated the maximum number of tuples for this Compound and you 
attempt to add more Tuples, a warning dialog (Figure 8-8) appears. 

8.2.3.2 Changing a Tuple’s Name

The Tuple’s name is initially assigned by the system and takes the form xmyT1, xmyT2, … 
xmyTN, where N is the number of Tuples generated by the system. These names do
have any particular meaning. 

The names of Tuples are displayed in a Relation object and represent each value set
Compound. You may find it useful to provide a more meaningful name for one or mor
the Tuples. 

The text box at the bottom of the window on the Tuple view is populated with the Nam
the currently selected Tuple if one, and only one Tuple row is selected. 

Figure 8-8.  Generating Tuples Confirm Dialog

Figure 8-9.  Maximum Tuples Confirm Dialog
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You can type a new Name for the Tuple in this text box. Once you leave this field (b
tabbing or by clicking somewhere else on the window) the new Tuple Name is popul
in the Tuple row. The system validates the name you supplied to make sure it is uniq
within this Compound and that it does not begin with xmyT. 

To change the name of a Tuple

1. Click on one (and only one) Tuple in the Tuples list.

2. Click in the Name text box and delete the existing name.

3. Type a new Name.

4. Press the Tab key or click anywhere else on the Tuples view.

8.2.3.3 Regenerating System Generated Tuple Names

To regenerate all system generated names of Tuples, execute 

Compound->Rename Tuples 

This does not modify user edited names.

As noted before, the AETG System generates Tuples names in the form xmyT1, xmyT2, … 
xmyTN, appending an iterated number to the suffix xmyT. If you used an iterative process
to generate Tuples, then the system, when adding additional Tuples to the list, first fin
largest number in a system generated Name and then increments the iterated number for
new names.

If you delete one or more Tuples during the iterative process, then there will be gaps 
system generated names. For example, you may choose to keep only Tuples xmyT3, 
xmyT9, and xmyT22, and you may have edited one or more Tuple names. A sample lis
names might be

• xmyT3

• xmyT9

• hsbMain 

• xmyT22.

If you execute Rename Tuples , the resulting set of Names is

• xmyT1

• xmyT2

• hsbMain 

• xmyT3.
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8.2.3.4 Deleting Tuples

To delete Tuples 

1. Select or multiselect rows in the Tuples view 

2. Execute 

Edit->Delete 

If the Tuple is not used by a Relation, the system removes the rows from the display
updates the Count field. If the Tuple is used, an error dialog (Figure 8-10) appears telling 
the you which Relation(s) use this Tuple.

8.3 Saving a Compound

You cannot save a Compound until at least one Tuple has been generated.

If Tuples do exist but you have subsequently modified the Fields or values and have
regenerated the Tuples, the system will ask you if you would like to save the change
the regenerated Tuples. You can also decide to not save the changes.

An initial Save operation updates the Compound row in the Fields view of the Format 
(Figure 6-2).

Figure 8-10.  Deleting Used Tuple Error Dialog
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9. Test Object

Test objects define the means by which a requirement is verified in a software applic

9.1 Why use a Test Object

You use a Test object to create

• Relation objects, which are used to define the 

— Constraints on the combinations of Fields that are tested

— Actual values that are used in a set of generated test cases. 

• Matrices, which let you generate or view the AETG generated set of test cases. 

9.2 Using Test Hierarchies and Creating Test Objects

Test objects always appear in their own Test hierarchies. Test hierarchies are usefu
organizing your work. Hierarchies are relationships between Test objects organized 
levels similar to a UNIX directory structure, which has directories and sub-directories
Hierarchies are comprised of “parent” objects and “child” objects and can have seve
layers, i.e., child objects with other child objects below it. (See Figure 9-1.) 

Test hierarchies contain only Test objects, and Test hierarchies are the only place in
AETG System where you can place Test objects. You can, however, have several T
hierarchies and you can place the hierarchies in folders you create.

Figure 9-1.  Hierarchy Concept

Parent
Object

Child
Object2

/home/usr

/home/usr/appl2

Test Hierarchy UNIX Directory and Sub-Directory

/home/usr/appl2.1

Child
Object2.1

Child
Object1

/home/usr/appl1
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Figure 9-2 illustrates a Test object hierarchy. Hierarchies are most obvious when we 
at them in an expanded list view. 

9.2.1 Creating and Naming Test Hierarchies

You can create a Test hierarchy from the AETG Desktop or any folder you have crea

To create a new hierarchy

1. On the AETG Desktop, execute

AETG->New->Test Hierarchy

NOTE — To create a hierarchy in an open Folder, 
execute

Folder->New->Test Hierarchy

Figure 9-2.  Test Object Hierarchy
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The system places the new Test hierarchy in the topmost position of the Desktop or 
Folder as show in Figure 9-3. 

NOTE — To create a hierarchy in a closed Folder, select 
the Folder and execute

Selected->New->Test Hierarchy

2. Double click on the new hierarchy icon to open it.

The system displays the Test hierarchy List view (Figure 9-4). 

3. Click on the Lock  icon to unlock the hierarchy.

The system displays a Name dialog for the hierarchy you created. 

Figure 9-3.  New Test Hierarchy. 

Figure 9-4.  Test Hierarchy List View
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4. Type in a name for the new Test hierarchy, e.g., Regression Testing, and click OK. 
(See Figure 9-5.)

5. Save the hierarchy by executing

Hierarchy->Save 

9.2.2 Deleting Hierarchies

You delete hierarchies the same way you delete any other AETG object. (See Section 4.7.) 
The only people who can delete a hierarchy is the user who created it or the AETG 
Administrator.

However, since hierarchies contain other objects you must be careful. When you de
hierarchy you are deleting all the objects in the hierarchy from the AETG Database, 
matter who owns them! The system always reminds you of this with a confirmation di

9.2.3 Creating Test Objects in Hierarchies

Test objects can be created at the first level or at any level below that in a hierarchy.
continue the example we started in Section 9.2.1 by creating Test objects in the Test 
hierarchy we created.

To create an object at the first level of a hierarchy:

1. Open the hierarchy in which you are placing the new object. 

2. Make sure that no other objects are selected. If you need to, execute

Edit->Deselect-All 

to clear all selections.

3. Unlock the hierarchy by clicking on the Lock  icon. 

4. Execute 

Hierarchy->New Test

Figure 9-5.  Test Hierarchy Name Dialog. 
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The system places the new untitled Test object in the hierarchy. (See Figure 9-6.) 

To place a new object at a level below the first level of a folder or hierarchy,

1. Select the object below which you want the new object to appear. For example, sel
the object you just created. 

2. Execute

Hierarchy->New Test

The system places the new object in the Test hierarchy below the first Test object 
(Figure 9-7). Note that the new Test object is indented, indicating that it is a child objec
the original Test object. 

If you want to place another object at the first level

1. Make sure that no other objects are selected. If you need to, execute

Edit->Deselect-All

to clear all selections. 

2. Execute

Hierarchy->New Test

Figure 9-6.  New Test Object Dialog

Figure 9-7.  New Object at Second Level
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The system placed a new untitled Test object in the hierarchy. (See Figure 9-8.) 

3. Save the hierarchy by executing

Hierarchy->Save 

NOTE — You can not open Test objects in an unlocked 
Test hierarchy.

Normally, you would open the new Tests and fill in their attributes at this point.

9.2.4 Duplicating a Test Object

When you want to copy a Test object, you must use the Duplicate  option on the Selected  
menu. Duplicate  creates a new object with many of the attributes of the original. 

If you duplicate a Test object, the system gives the new Test object the name of 
Cloneof <id>, where <id> is the ID number of the original Test object. The system assig
the duplicate Test object a new ID  number so that you won’t overwrite the original objec

As an example we will duplicate a Test object within a Test hierarchy.

1. Click on the Lock  icon to unlock the hierarchy. 

2. Select the Test Object you want to duplicate. (See Figure 9-9.) 

Figure 9-8.  Another New Object at First Level

Figure 9-9.  Selecting a Test Object to Duplicate
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3. Execute 

Selected->Duplicate 

The system places an object labeled Cloneof in the hierarchy as a sibling of the object yo
duplicated. (See Figure 9-10.) 

Table 9-1 lists the attributes that are and are not duplicated in the new Test object. 

Figure 9-10.  Duplicated Test Object

Table 9-1.  Duplicated/Nonduplicated Test Object Attributes

Duplicated Not Duplicated

• Owner

• Version number

• Test case type

• Description

• Name

• Matrices

• Associated Format 
object

• Relations
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9.3 Working with Test Objects

You can create one or more Test objects to test the parts of a Format that you wish t
For example, you can test a subset of Fields on a Format with one Test object and a
subset using another Test object. You then associate a Format with each Test objec
validates some aspect of the Format.

You create Test objects within Test hierarchies, as detailed in Section 9.2. These 
hierarchies let you refine the area of a Format each Test object validates. 

For each Test object, you define the set of rules that are exercised by the Test in one o
objects called Relation objects.

NOTE — Before any Relations can be defined, the Test 
must have an associated Format object.

While in the Relations view of the Test object, you can either open an existing Relation 
object for editing or create a new one.

Once you’ve specified all of the Relations for a Test, you can have the AETG System
generate the efficient set of test cases for this Test.

The Test object contains the following views:

The default view is the Properties view (Figure 9-11). 

Properties Used to define the Properties for the Test object. (See Section 9.3.1.)

Relations Used to define the Relations for this Test object, including associat
a Format object with the Test. (See Section 9.3.3.)

Matrix Used to display the generated test cases. (See Section 9.3.2.)
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9.3.1 Properties View

The Test object Properties view (Figure 9-11) lets you enter or update such information a
the Name, Owner, and Type of a Test object. 

The Properties view contains the following parameters:

Figure 9-11.  Test Object Properties View

Owner Lets you specify the owner of the Test object. 

This is a required parameter, and is initially prepopulated with the log
ID of the person who created the object. You can change the owner o
object in the text box. 

Name Lets you specify the name of a Test object, e.g., login. 

This is a required parameter.
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Version Displays the version number of the Test object, which is generated by the 
AETG System. Note that, in the AETG System, this is always initially b
set to 1. 

This is a display only field

Type Lets you specify the type of test you are creating, which helps you 
organize tests. You must select one of the values from the drop-dow
menu. The delivered values are

• Area

• Feature

• Test  

• Test Case

The default value is Test Case .

Description Lets you enter a description of the test. 

Parent Type Displays the parent Test object type, if any, for the current object. 

Statused This parameter is not supported for this release of the AETG System. 

Status Displays who create or revised the Test object and when the Test obje
was created or revised.

This is a display only field
9–10  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Test Object
  Release 1.0

st 

ays 

 a 

 

9.3.2 Relations View

The Test object Relations view (Figure 9-12) lets you associate a Format object to the Te
and to view or create a set of Relations involving the Fields in that Format. 

The Relations view contains the following parameters: 

Figure 9-12.  Test Object Relations View

Format Lets you associate a Format object with this Test object. This list displ
the ID, Name, and Version number of the Format object.

See Section 9.3.2.1 for instructions on associating a Format object with
Test object.

Relations Contains a list displaying all Relations defined for this Test object. Using 
this list you can create new Relation objects or duplicate or delete existing 
objects.

Each line of the list displays the ID, Name, Degree, and Description of the
Relations object.

Note —  See Section 10 for detailed information on Relation objects.
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9.3.2.1 Associating a Format Object

When you create a test case, you must associate a Format with a Test object, which
the Test object access to the Fields and Values defined by the Format object.

NOTE — A Test object can only be associated with one 
Format at a time. However, a Format can be associated 
with more than one Test object at a time.

To associate a Format object to a Test object

1. Display the Database Browser, and display the list of Format objects.

2. Select a Format object from the Database Browser  list (Figure 9-13) and execute

Edit->Copy

NOTE — You can also select and copy the desired 
Format object from the AETG Desktop.

3. Display the Test object and click on the Lock  icon to unlock the object (if it is not 
already unlocked).

Figure 9-13.  Selecting a Format to Associate with a Test Object
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4. Click in the Format  parameter box, and execute

Edit->Paste

on the Test object Relations View to create the association. (See Figure 9-14.) 

9.3.2.2 Creating a New Relation

To create a new Relations object in an unlocked Test object Relations view, execute

Test->New Relation

NOTE — The Test object must have an associated 
Format object, and there cannot be an untitled Relation 
row in the list.

Figure 9-14.  Associating a Format with a Test Object
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An untitled row is added to the Relations  list. The new Relation object is automatically 
opened and unlocked so that you can provide a Name. (See Figure 9-15.) 

NOTE — See Section 10 for detailed information on 
using Relation objects.

9.3.2.3 Duplicating a Relation

When you want to copy a Relation object, you must use the Duplicate  option on the 
Selected  menu. Duplicate  creates a new object with many of the attributes of the origin

If you duplicate a Relation object, the system gives the new Relation object the nam
CloneOf <id>, where <id> is the ID number of the original Relation object. The system
assigns the duplicate Relation object a new ID  number so that you won’t overwrite the 
original object.

Figure 9-15.  Creating a New Relation Object
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To duplicate a Relation

1. On an unlocked Test object Relations view, select the Relation you want to dupl

2. Execute

Selected->Duplicate

The system creates and opens a new Relation object that is a duplicate of the selec
Relation. (See Figure 9-16.)

Figure 9-16.  Duplicate Relation Object
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Table 9-2 lists the attributes that are and are not duplicated in the new Relation.

Once you have entered a new Name, you can save the duplicated Relation. The new 
Relation appears in the Relation  list on the Test object Relations view.

9.3.2.4 Deleting a Relation

In an unlocked Test object

1. Select one or more Relation rows.

2. Execute

Edit->Delete

Table 9-2.  Duplicated/Nonduplicated Relation Object Attributes

Duplicated Not Duplicated

• The set of Fields in the 
original Relation

• The associated Test

• The associated Format

• Interaction degree

• Name

• Field Values

• Description

• Includes

• Excludes

• Invalids
9–16  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Test Object
  Release 1.0
9.3.3 Matrix View

The Test Object Matrix view (Figure 9-17) lets you 

• Generate or view the AETG generated set of test cases. 

• Delete test cases from the displayed Matrix.

• Save the Matrix to a file.

• Load a previously saved matrix.

• Delete previously saved matrices. 

The Matrix view is populated when you execute

Test->Matrix->Generate

The displayed Test Case Matrix is the efficient set of test cases that is produced by the 
Generate function for the set of Relations defined for this Test. 

Figure 9-17.  Test Object Matrix View
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The Matrix view contains the following parameters: 

Matrix 
Info

Displays the following information:

Generation Date The date and time when the Matrix was generated.

Name The name of the Test Case Matrix. This is marked 
<untitled> if the displayed matrix has not been saved
When you save the Matrix, you are asked to enter a 
name for the matrix. (See Section 9.3.3.3.)

Up To Date Indicates whether or not the involved Relations have
changed since the displayed Matrix was generated.

Valid Test Cases The number of valid generated test cases.

Invalid Test Cases The number of invalid generated test cases.

Total The total number of generated test cases.

Matrix Contains a list box that displays the Test Case Matrix as a set of rows. 

Each test case row contains the following columns:

TC Name Displays the name of the test case. The system automatically
generates a name using the forms V-N or I-N,  where 

V Indicates that this is a valid test case

I Indicates that this is a invalid test case

N Is an automatically iteration number. For each tes
case type, N is initially 0, e.g., V-0, I-0.

Type Indicates whether this test case is valid (V) or invalid (I ).

<Value> Displays a value for each participating Field in the test case.
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9.3.3.1 Generating a Matrix

The Generate menu function is enabled only when at least one Relation is defined for
Test object. 

When you execute

Test->Matrix->Generate 

the system displays the message 

Test Matrix being generated...

in the Relations view status area. When the operation is completed, the set of genera
cases is displayed in the Matrix  list (Figure 9-18) and the message

Test Matrix completed - N test cases generated

appears in the message area, where N is the number of generated test cases. 

Any existing test cases in the list are overwritten by the new set of test cases.

Figure 9-18.  Generated Test Case Matrix
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9.3.3.2 Deleting Test Cases

To delete test cases

1. Select or multiselect test case rows (Figure 9-19). 

Figure 9-19.  Selecting Test Case Rows to Delete
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2. Execute

Edit->Delete 

The display-only test case counts are updated (Figure 9-20). 

Figure 9-20.  Updated Matrix View
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9.3.3.3 Saving a Matrix

You can save a Matrix when there are test cases displayed in the Matrix  list. 

1. Execute

Test->Matrix->Save 

The Save Matrix Dialog (Figure 9-21) appears. 

2. Enter a name for the Test Case Matrix file, e.g., MainScreenTest (See Figure 9-22), 
and click on OK. 

Figure 9-21.  Save Matrix Dialog

Figure 9-22.  Entering a Name for a Test Case Matrix File
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The filename you entered in the Name field of the Matrix Info  parameter (Figure 9-23). 

The Matrix data is saved to an ASCII file in the UNIX operating system. 

The directory where this file resides is determined by the system and is always 
$XMYHOME/data/testMatrix/testID, where testID is the identification number for the Tes
object. For example, if you save a matrix for the Test object (ID number 3793) in 
Figure 9-15, your Test Case Matrix file is saved to $XMYHOME/data/testMatrix/3793.

See Section 9.4.2 for information on the Matrix file format.

You can save multiple test case matrices, each with a different Name. You simply provide
a new Name when you execute Matrix->Save . 

NOTE — Matrix->Save does not save the Test object. It 
only saves the Test Case Matrix data to the entered 
filename.

Figure 9-23.  Saved Matrix
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9.3.3.4 Loading an Existing Matrix

To view a previously Saved matrix, execute

Test->Matrix->Load 

A Load Matrix dialog (Figure 9-24) appears. 

Select one of the names in the list or type one in the Load From  box and click OK. The data 
in that matrix is loaded in the Test Case  list up to the amount specified by the AETG Max 
Test Cases  parameter. (See Section 3.7 and Section 9.3.3.6.) The Name, Generated Date, 
and Up To Date fields are also updated.

Figure 9-24.  Load Matrix Dialog
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9.3.3.5 Deleting a Matrix

To delete one or more previously saved matrices

1. Execute

Test->Matrix->Delete 

A Delete Matrix dialog (Figure 9-25) appears. 

2. Select a Matrix name and click OK. The matrix is deleted. 

9.3.3.6 Specifying the Maximum Number of Test Cases

The AETG Desktop’s Preferences view contains the preference Max Test Cases. This 
preference indicates the number of test cases that the system automatically loads into
object Matrix view. If the number of test cases in the Matrix exceeds the specified Max 
Test Cases value, a dialog (Figure 9-26) appears asking you if you wish to load all of th
generated test cases, load the maximum number of test cases, or cancel loading tes

Figure 9-25.  Delete Matrix Dialog

Figure 9-26.  Max Testcases Exceeded Dialog
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The system default Max Test Cases value is 500. You can change this value on the AET
Desktop Preference view. To change the Max Test Cases value, see Section 3.7.1.

The Max Test Cases value effects both the Generate Matrix  and Load Matrix  functions.

9.3.4 Test Save Implications

The Matrix Name is saved at Save time. Also, the test cases in the displayed Test Case  list 
are written to the file that is currently displayed in the Name field. If you have not sav
the current Test Case Matrix (i.e., Untitled appears in the Name field) the Save Matrix 
dialog appears prompting you to enter a name for the matrix.
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9.4 Obtaining Test Case Matrix Output

Once you have generated a Test Case Matrix, you can then use the martix as the in
your testing tool. The AETG System provides several methods of acquiring an electr
version or hardcopy of the Test Case Matrix.

9.4.1 Printing a Matrix

As stated in Section 9.3.3.3, saving a Test Case Matrix creates an ASCII file in the directo
$XMYHOME/data/testMatrix/testID. However, you can print a hard copy or create a loc
ASCII copy of the Test case matrix by executing

Test->Matrix->Print 

in an unlocked Test object. The Matrix Print dialog (Figure 9-27) appears. .

NOTE — While the Test object is unlocked, the Print  
option on the Test  menu is disabled.

This print dialog works the same as the standard AETG print dialog (Figure 3-21), letting 
you send data to a printer or save the data to a file. The difference is that this dialog 
the contents of the current matrix only, while the AETG print dialog lets you print 
information for the entire Test object.

For more information on using the print dialog, see Section 3.10.

NOTE — The contents of the printed file are exactly what 
you find in $XMYHOME/data/testMatrix/testID. 

Figure 9-27.  Matrix Print Dialog
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If you decide to print the matrix to a file, you only need to specify the directory. (This 
be the full path or the name of a subdirectory to the directory in which you started the A
System.) The system saves the file using the name of the current matrix as the filena

For example, if you want to print a copy of the matrix in Figure 9-23 to a file in the directory 
TestCases, which is a subdirectory of the directory in which you started the AETG Syst
then you could fill in the Matrix Print dialog as shown in Figure 9-28. 

Assuming your home directory is /users/kjd, the resulting path/filename for the printed 
matrix would be /users/kjd/TestCases/MainScreenTests. 

9.4.2 Matrix File Format

The format of the Matrix file is shown in Figure 9-29. 

All elements of the Matrix file are delimited by braces ({}).

The first line contains the information displayed in the Matrix view Matrix Info  parameter, 
e.g., the Generation Date or Valid Test Cases count. Each remaining line lists the 

Figure 9-28.  Printing a Matrix to a File

{id 501} {date {07/15/97 10:42:53}} {tc 32} {valid 30} {invalid 2} {staleFlag False}
{name V-0} {type V} {fields {{loginID ksb} {Date 01/01/00} {Passwd 5678}}}
{name V-1} {type V} {fields {{loginID ksb} {Date 01-01-2000} {Passwd abcde}}}
{name V-2} {type V} {fields {{loginID hyr} {Date 01-01-1999} {Passwd 5678}}}
{name V-3} {type V} {fields {{loginID hyr} {Date 12-31-1999} {Passwd abcde}}}
{name V-4} {type V} {fields {{loginID rkr} {Date 12/31/99} {Passwd abcde}}}
{name V-5} {type V} {fields {{loginID ksb} {Date 12/31/99} {Passwd 5678}}}
{name V-6} {type V} {fields {{loginID ksb} {Date 01-01-1999} {Passwd 5678}}}
{name V-7} {type V} {fields {{loginID rkr} {Date 12-31-1999} {Passwd 5678}}}
{name V-8} {type V} {fields {{loginID rkr} {Date 01-01-2000} {Passwd abcde}}}
{name V-9} {type V} {fields {{loginID hyr} {Date 01/01/00} {Passwd abcde}}}

Figure 9-29.  Matrix File Content
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information for a Test Case listed in the Matrix  parameter, i.e., TC Name, Type, and 
<Value>. Each value listed in the <Value> parameter is also delimited by a set of brace

9.4.3 Converting a Test Case Matrix File’s Format

The xmyConvMatrix  command lets you convert a Test Case Matrix file to a Comma 
Separated Values (CSV) format, which can be directly imported by most spreadshee
programs or you may be able to load into a testing tool.

Execute

xmyConvMatrix -t CSV matrixFileName

where matrixFileName is the name of the Test Case Matrix file you want to convert. T
file can be a Test Case Matrix file in $XMYHOME/data/testMatrix/testID or a local file you 
created using the Matrix Print dialog.

NOTE — xmyConvMatrix  prints the converted file to 
the standard output, which you can route to a file.

For example if you save the Test Case Matrix file in Figure 9-29 to the local file 
MainScreenTests, you could execute 

xmyConvMatrix -t CSV MainScreenTests > MainScreenTests.txt

in the directory containing the MainScreenTests. This would produce the output in 
Figure 9-30, saving the output to the file MainScreenTests.txt. 

NOTE — Relation information is not converted and is not 
included in the output. 

For more information on xmyConvMatrix , see Section 11.1.

"501", "07/15/97 10:42:53", "32", "30", "2", "False"
"V-0", "V", "ksb", "01/01/00", "5678"
"V-1", "V", "ksb", "01-01-2000", "abcde"
"V-2", "V", "hyr", "01-01-1999", "5678"
"V-3", "V", "hyr", "12-31-1999", "abcde"
"V-4", "V", "rkr", "12/31/99", "abcde"
"V-5", "V", "ksb", "12/31/99", "5678"
"V-6", "V", "ksb", "01-01-1999", "5678"
"V-7", "V", "rkr", "12-31-1999", "5678"
"V-8", "V", "rkr", "01-01-2000", "abcde"
"V-9", "V", "hyr", "01/01/00", "abcde"

Figure 9-30.  xmyConvMatrix Output
 9–29



AETG System Users Guide BR 007-252-007
Test Object Issue 1, October 1997
Release 1.0   
9–30  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Relation Object

Release 1.0

n the 

 input 
s a 

 

e 

his 
10. Relation Object

Relation objects let you collect requirements data to establish how fields and values o
format relate to one and another.

10.1 Why use a Relation Object

You use Relation objects to collect the requirements information necessary to provide
to an application under test. For example, a requirement may state, “When Field1 ha
value of blue, Field2 may not be pink or yellow.” This input constraint is usually found in
the application’s requirements document.

Relation objects also

• Let you tell the AETG System what test cases are important enough to always b
included in the set of generated test cases.

• Let you define a set of invalid values that you would like tested.

10.2 Working with Relation Objects

As mentioned in Section 9.3.2, a Relation object is accessed through a Test object’s 
Relations view. To create a new Relation object, execute

Test->New Relation 

in an unlocked Test object.

When you create a Relation object, you decide

1. What Fields will participate in this Relation.

2. If all of the rules governing the interactions of this set of Fields are specified in t
Relation or using several Relations (e.g., one rule is specified using one Relation, 
another using a second Relation, and so on).

For example, for a given set of Fields, you may want to do one of the following:

• Define one Relation for each rule.

• Define one Relation that contains all of the rules for the set of Fields.

• Define several Relations, each containing the rules for a subset of Fields.
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When deciding what Relations to create, the AETG System enforces several rules that yo
must keep in mind:

• A Relation can contain only Fields in the associated Format. 

• Multiple Relations defined for one Test object must have either completely disjoint 
Fields or must have all Fields in common.

The Relation object has five views:

The default view is the Properties view (Figure 10-1).

Properties Used to define the Properties for the Relation object. (See 
Section 10.2.1.)

Fields Lets you choose the Fields and Values that will participate in this 
Relation. (See Section 10.2.2.)

Includes Lets you specify field/value sets to be included in the list of generat
test cases. (See Section 10.2.3.)

Excludes Lets you specify value field/value sets to be excluded in the list of 
generated of test cases. (See Section 10.2.4.)

Invalids Lets you define invalid Field values to do error condition testing. (S
Section 10.2.5.)
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10.2.1 Properties View

The Relation object Properties view (Figure 10-1) lets you enter or change properties of th
Relation, such as the Name and Interaction Degree. 

The Properties view contains the following parameters: 

Figure 10-1.  Relation Object Properties View

Test Displays the ID, hierarchy, path, and name of the associated Test. Th
association is automatically populated by the AETG System and is 
display only.

You can display the Test object by double clicking on the ruler item.

Name Lets you enter or change the name of the Relation object. The name m
be unique within the set of Relations defined for the associated Test.

This is a required parameter.
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In addition to these areas, the associated Format name and version are displayed in th
space below the Tool bar area. 

Interaction 
Degree 

Lets you select an Interaction Degree for the Relation, which determi
how the fields in the presented generated test cases interact with ea
other. 

For example, a degree of 2 will guarantee that for any two fields all 
possible value combinations have been covered in the set of generated 
test cases. A degree of 1 means that the fields are not interdependent. 
the case where the degree is 1, the number of test cases generated for th
relation is equal to the largest number of values given to a single field

The interaction degree is restricted to an integer from 1 to N, where N is 
the number of fields in the relation. Typically, choosing a pair wise (2) or 
triple (3) field interaction will generate test cases that yield good 
functional coverage.

The Interaction Degree can be different on each individual Relation 
associated with a Test.

Default value = 2.

To choose an Interaction Degree, perform either of the following:

• Select the degree value using the spin controls.

• Type the degree value directly in the Interaction Degree text box

Description Lets you enter a description of the Relation. 

Status Displays who created or revised the Relation object and when the 
Relation object was created or revised.

This is a display only field
10–4  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Relation Object

Release 1.0

t 
der 

is 
10.2.2 Fields View

The Relation object Fields view (Figure 10-2) lets you choose the Fields and Values tha
participate in this Relation. After selecting the participating Fields, you may also reor
the Field columns to create a better arrangement for this Relation. 

The Fields view contains the following parameters: 

Figure 10-2.  Relation Object Fields View

Test Displays the ID, Hierarchy, Path, and Name of the associated Test. Th
association is automatically populated by the AETG System and is 
display only.

You can display the Test object by double clicking on the ruler item.

Interaction 
Degree

Displays the Interaction Degree you selected on the Relation object 
Properties view.
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If the participating Fields or Values are changed on this view, those changes are refl
on the other views of this object even if you have not saved the changes on this view
Therefore, if you switch to another Relation object view from an unlocked Fields view
other views are updated with any changes made on the Fields view.

Use Lists the Fields and Values that participate in this Relation.

The top of this list is a ruler divided into columns, one column for eac
defined Field, with each column listing the Fields in this Relation. Und
this ruler is a scrollable list showing the defined values in the 
corresponding Field. Initially, this list is populated with all Fields and 
corresponding Values from the associated Format that are not alread
used in another Relation.

Compounds appear in the Fields ruler with the Compound Name 
enclosed in brackets (<>), e.g., <compound1>. The corresponding 
Values for Compounds are the Tuple names defined in the Compound 
object.

Note —  The simple Fields that make up the Compound are not 
displayed.

In the simplest case, you would have all initially populated Fields and 
Values participate in the Relation. If that is the case then you do not h
to do anything on this view. However, that is more often then not the
typical case. In this case, you can

• Change what Fields participate in the Relation by executing

Relation->Change Fields  

See Section 10.2.2.1 for information on changing the participating 
Fields.

• Change what Values participate in the Relation using the arrow 
buttons below the list.

See Section 10.2.2.2 for information on changing the participating 
Values.

Don’t Use Lists the Fields and Values that do not participate in this Relation.

The Fields ruler contains the exact same set of Fields as the Use list. 
Initially, the scroll area listing the values in the Fields is empty.
10–6  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Relation Object

Release 1.0
10.2.2.1 Changing Participating Fields

To add or subtract Fields to a Relation, execute

Relation->Change Fields

on an unlocked Fields view. The Change Fields confirm dialog (Figure 10-3) appears. 

The Use list displays all of the Fields that will participate in the Relation, and the Don’t 
Use list displays all of the remaining valid Fields that will not participate. 

To move Fields from one side to the other 

1. Highlight one or more Fields.

NOTE — You cannot remove all Fields from the Use list. 

2. Click one of the arrow buttons. (See Figure 10-4.)

• Click on the left arrow (<-) to add Fields to the Use list

• Click on the right arrow (->) to add Fields to the Don’t Use  list. 

Figure 10-3.  Change Fields Confirm Dialog

Figure 10-4.  Changing Fields
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3. The Change Fields confirm dialog is modal; you must close the dialog before wor
on any other AETG process. You must therefore perform one of the following:

• To cancel your changes, click on Cancel . The dialog closes.

• To accept your changes, click on OK. The dialog closes and the Relation object’
Fields view is updated to show the Fields that participates in the Relation. 

NOTE — If you change a Relation that already has data 
on other views, you can only add Fields to the Use list. 
Fields that are currently participating in a Relation cannot 
be removed and the bottom arrow is disabled.

Figure 10-5.  Updated Fields View Showing Affect of Changing Fields
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10.2.2.2 Changing Participating Values

You can move Values for a participating Field between the Use and the Don’t Use  lists. 

To move values from the Use to the Don’t Use  list,

1. On an unlocked Fields view, highlight one or more Values in the Use scroll list. (See 
Figure 10-6.) 

NOTE — Remember, to multiselect values, Ctrl-Click  on 
the desired values.

Figure 10-6.  Selecting Values to add to the Don’t Use List
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2. Click on the down arrow. The selected Values move to the Don’t Use  list. (See 
Figure 10-7.)

Conversely, you can move values from the Don’t Use  to the Use list by clicking on the up 
arrow after you highlight the desired values.

NOTE — You cannot remove all Values from the Use 
list.

10.2.2.3 Rearranging Field Columns

You can rearrange the columns in an unlocked object. Rearranging the columns in o
rearranges the columns in the other list, too. However, the rearrangement is not save
the object nor is the rearrangement propagated to the Include or Exclude views. This m
that the arrangement on these other views can be different.

See Section 3.4.5 for information on rearranging columns.

Figure 10-7.  Values added to the Don’t Use List
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10.2.3 Includes View 

The Relation object Includes view (Figure 10-8) lets you select specific field/value sets tha
you want to ensure are included in the list of generated test cases. You can also vie
modify, or delete Include Test Cases. 

The Includes view contains the following parameters: 

Figure 10-8.  Relation Object Includes View

Test Displays the ID, Hierarchy, Path, and Name of the associated Test. Th
association is automatically populated by the AETG System and is 
display only.

You can display the Test object by double clicking on the ruler item.
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For example, a Test may have the Fields F1, F2, F3, F4, and F5 and you want to ensu
there is a test case having 

• F1 = blue

• F3 = red 

• F5 = green. 

Included Test 
Cases

Contains a list showing all defined Included Test Cases. You can cre
new Included Test cases and view, modify or delete existing Included 
Test Cases. When you create new Included Test Cases, you must sp
a Name and, optionally, a description of the Included Test Case. (See 
Section 10.2.3.1.)

Note —  An Included Test Case name cannot contain embedded spa

Values The value combinations defined here are included in the generated lis
tests. 

This list displays the defined Fields and Values for this Relation. All 
Fields that participate in the Relation are represented as columns in 
ruler at the top of this list, and all participating Values are populated i
the appropriate columns. 

Compounds appear in the Fields ruler with the Compound Name 
enclosed in brackets (<>), e.g., <compound1>. The corresponding 
Values for Compounds are the Tuple names defined in the Compound 
object.

Initially, this list is populated with all valid Values, i.e., all Values that 
you selected on the Fields view.

When selecting Values for an Included Test Case, you can select an
number of values in a Field or Compound column.

Note —  If two or more Relations have the same set of Fields and yo
execute 

Relation->Change Fields 

a pop-up error message appears stating the name of the other Relati
that use the same set of Fields and explaining that they can therefore
change the set of Fields.

Set Applies the selected values to the Included Test Case, that is, the sys
defines the values for this particular Included Test Case. If you do not 
click on the Set button, then the values will not be set.
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You can then multiselect the corresponding Values for each field, and the generated
case is guaranteed to be included in the Test Matrix view of the Test Object. That is, at least 
one test case will have this desired combination in the list of generated test cases. This test 
case will not be dropped out when the AETG System generates the efficient set of te
cases.

10.2.3.1 Adding New Includes

To add an Include row to the Included Test Cases  list

1. On an unlocked Relation object Includes view, execute

Relation->New->Include 

A new row is added to the Included Test Cases  list and the Name field is populated 
with <new-test-case>. (See Figure 10-9.) 

Figure 10-9.  Creating a New Include
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2. Edit the Name field and optionally enter text in the Description  field.

NOTE — Remember, an Included Test Case name cannot 
contain embedded spaces.

3. Select the value cells from any of the Field or Compound columns in the Values  list 
to determine the values you want to participate in this Included Test Case. (See
Figure 10-10.) 

4. Click on the Set button. 

Figure 10-10.  Defining a new Included Test Case
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NOTE — If you do not click on the Set button and you 
try to save the Relation object, the error dialog in 
Figure 10-11 appears. 

WARNING — The AETG System does not check for 
duplicate value sets, e.g., if two or more Included Test 
Cases use the exactly same values.

NOTE — More then one value can be selected in any 
column. Selecting more then one value means that the 
Included Test Case will represent more than one test case.

5. When you are satisfied with your edits and selections, perform one of the followin

• Execute 

Relation->New->Include

and repeat Steps 2 through 4 to define a new Included Test Case.

• Save the Relation object, e.g., execute 

Relation->Save 

An error dialog appears if

— A Name is not unique among the Included Test Cases

— There are no set values for an Included Test Case.

• Change to one of the other Relation object views to further define your test c

Figure 10-11.  Undefined Relation Error Dialog
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WARNING — If an Included Test Cases name is not 
unique among the Included Test Cases when you execute 
New->Include  or when you save of the object, an error 
dialog (Figure 10-12) appears prompting you to enter a 
new name. 

10.2.3.2 Viewing/Modifying Existing Includes

To view an existing Include, simply select an Included Test Case row. When you do 

• The Name and Description  test areas are populated with the current contents of t
Included Test Case row. You may edit the Name or the Description  text on an 
unlocked Relation object.

• The included Values are automatically highlighted in the Values  list. To change the 
included Values, simply select new or different value cells on an unlocked Relat
object.

Figure 10-12.  Non-unique Included Test Case Name Error Dialog
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10.2.3.3 Duplicating Include Test Cases

To create a new Included Test Case that is similar to an already existing Included Test Case, 
click on the existing Included Test Case and execute

Selected ->Duplicate 

A new Included Test Case row (Figure 10-13) is populated with the same

• Name as the original Included Test Case, but with a 1 appended to it

• Description

• Set of Values 

You may want to duplicate an Included Test Case if you have many values chosen f
existing Included Test Case and you need to create another Included Test Case and 
only a few of those values. 

Figure 10-13.  Duplicating an Included Test Case
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If you accidentally click in the Values area and cause all selections to become desel
select a different Included Test Case row, then select the Included Test Case row you
working on.

10.2.3.4 Deleting Existing Includes

To delete an existing Included Test Case, 

1. Select the appropriate row.

2. Execute

Edit->Delete
10–18  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Relation Object

Release 1.0

 
te the 

is 
10.2.4 Excludes View 

The Relation object Excludes view (Figure 10-14) lets you specify value combinations to
be excluded from the generated set of test cases. You can also view, modify or dele
Exclude Test Cases. 

The Excludes view contains the following parameters: 

Figure 10-14.  Relation Object Excludes View

Test Displays the ID, Hierarchy, Path, and Name of the associated Test. Th
association is automatically populated by the AETG System and is 
display only.

You can display the Test object by double clicking on the ruler item.
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For example, a Test may have the Fields F1, F2, F3, F4, and F5 and you want to ensu
the application under test will never encounter the following combination:

• F1 = d

• F4 = pink

You would then 

1. Multiselect the Value d from the Field F1 and the Value pink from the Field F4 

2. Click on the Set push button. 

This indicates that this combination is not allowed regardless of the values of other f
The resulting matrix of test cases will not contain any test cases having the excluded
field/value pairs.

Excluded Test 
Cases

Contains a list showing all defined Excluded Test Cases. You can create 
new Excluded Test cases and view, modify or delete existing Exclud
Test Cases. When you create new Excluded Test Cases, you must sp
a Name and, optionally, a description of the Excluded Test Case. (Se
Section 10.2.4.2 for information on adding new Excluded Test Cases.)

Note —  An Excluded Test Case name cannot contain embedded spa

Values The value combinations defined here are excluded from the generated
of tests. 

This list displays the defined Fields and Values for this Relation. All 
Fields that participate in the Relation are represented as columns in 
ruler at the top of this list, and all participating Values are populated i
the appropriate columns. 

Compounds appear in the Fields ruler with the Compound Name 
enclosed in brackets (<>), e.g., <compound1>. The corresponding 
Values for Compounds are the Tuple names defined in the Compound 
object.

Initially, this list is populated with all valid Values, i.e., all Values that 
you selected on the Fields view.

When selecting Values for an Excluded Test Case, you can select any 
number of values in a Field or Compound column.

Set Applies the selected values to the Excluded Test Case, that is, the sy
applies the values to this particular Excluded Test Case. If you do no
click on the Set button, then the values will not be set.
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If you create conflicting Include and Exclude Test Cases rules, preference is given to
exclusion rule. For example, if you define an Include Test Cases rule with the following:

• F1 = blue 

• F2 = green 

and an Exclude Test Cases rule of

• F2 = green. 

all test cases having the Field F2 with a Value of green are excluded, which also excludes
your Include Test Case.

10.2.4.1 Examples of Field Constraints

There are many type of constraints that can be placed on field interaction. Here are 
examples:

When you define exclude conditions, you must be aware of the implicit exclude 
conditions/problem . This type of condition occurs when multiple excludes are 
combined in one relation. For example, suppose you have the following:

This implies that when F1=x, then F3=x.

The AETG System will not guarantee the correct processing of implicit exclude conditi
However, when such a condition exists the system will display a warning dialog telling
that such a condition may exist.

Constraint Effect

If Field1= x then Field2 must be > 10 The Excludes view will have Field1 having 
the value x (only) and Field2 having 
selected values less than or equal to 10.

If Field1= blank then Field2 != blank The Excludes view will have both Field1 
and Field2 having the value BLANK 
selected only.

If Field1= x then Field2 must be either y or z The Excludes view will have Field1 having 
the value x (only) and Field2 having all 
values except y and z selected.

Exclude # Constraint

Exclude-1 When F1=x, F2 must be x 

Exclude-2 When F2=y, F3 must be x 
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10.2.4.2 Adding New Excludes

To add an Exclude row to the Excluded Test Cases  list

1. On an unlocked Relation object Excludes view, execute

Relation->New->Exclude 

A new row is added to the Excluded Test Cases  list and the Name field is populated 
with <new-test-case>. (See Figure 10-15.) 

2. Edit the Name field and optionally enter text in the Description  field.

NOTE — Remember, an Excluded Test Case name 
cannot contain embedded spaces.

Figure 10-15.  Creating a New Exclude
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3. Select the value cells from any of the Field or Compound columns in the Values  list 

to determine the values you want to participate in this Excluded Test Case from
Values  list. (See Figure 10-16.) 

4. Click on the Set button. 

NOTE — If you do not click on the Set button and you 
try to save the Relation object, the error dialog similar to 
the one in Figure 10-11 appears. 

WARNING — The AETG System does not check for 
duplicate value sets, e.g., if two or more Excluded Test 
Cases use the exactly same values.

NOTE — More then one value can be selected in any 
column. Selecting more then one value means that the 
Excluded Test Case will represent more than one test case.

Figure 10-16.  Defining a new Excluded Test Case
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5. When you are satisfied with your edits and selections, perform one of the followin

• Execute

Relation->New->Exclude

and repeat Steps 2 through 4 to add a new Excluded Test Case.

• To save the Relation object, e.g., execute 

Relation->Save 

• Change to one of the other Relation object views to further define your test c

WARNING — If an Excluded Test Cases name is not 
unique among the Excluded Test Cases when you execute 
New->Exclude  or when you save of the object, an error 
dialog (Figure 10-12) appears prompting you to change 
enter a new name.

10.2.4.3 Viewing/Modifying Existing Excludes

To view an existing Exclude, simply select an Excluded Test Case row. When you d

• The Name and Description  test areas are populated with the current contents of fr
the Excluded Test Case row. You may edit the Name or the Description  text on an 
unlocked Relation object.

• The excluded Values are automatically highlighted in the Values  list. To change the 
excluded Values, simply select new or different value cells on an unlocked Rela
object.
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10.2.4.4 Duplicating Excluded Test Cases

To create a new Excluded Test Case that is similar to an already existing Excluded T
Case, click on the existing Excluded Test Case and execute

Selected ->Duplicate 

A new Excluded Test Case row (Figure 10-17) is populated with the same

• Name as the original Excluded Test Case, but with a 1 appended to it

• Description

• Set of Values. 

NOTE — If you do not change the set of values and then 
use the Set button, an error is produced when you save the 
Relation object.

Figure 10-17.  Duplicating an Included Test Case
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You may want to duplicate an Excluded Test Case if you have many values chosen 
existing Excluded Test Case and you need to create another Excluded Test Case and
only a few of those values. 

If you accidentally click in the Values area and cause all selections to become desel
select a different Excluded Test Case row, then select the Excluded Test Case row yo
working on.

10.2.4.5 Deleting Existing Excludes

To delete an existing Excluded Test Case, 

1. Select the appropriate row.

2. Execute

Edit->Delete
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10.2.5 Invalids View

The Invalids view (Figure 10-18) defines invalid Field values to be tested, which are 
specific values you want to try on an application to do error condition testing. The value
for the Fields are not supplied by the Format object. You must provide the invalid va
to be used. 

The Invalids view contains the following parameters: 

Figure 10-18.  Relation Object Invalids View

Test Displays the ID, Hierarchy, Path, and Name of the associated Test. Th
association is automatically populated by the AETG System and is 
display only.

You can display the Test object by double clicking on the ruler item.
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10.2.5.1 Adding New Invalids

To add new Invalid Test Cases

1. On an unlocked Relation object Invalids view, execute

Relation->New->Invalid

A new row of empty cells is added to the Invalid Test Cases  list, one for each Field 
in the Relation.

NOTE — Remember, Compounds are not displayed on 
this view.

Invalid Test 
Cases

Contains a list showing all defined Invalid Test Cases. You can creat
new Invalid Test cases and view, modify or delete existing Invalid Te
Cases. When you create new Invalid Test Cases, you must specify a
Name and, optionally, a description of the Invalid Test Case. (See 
Section 10.2.5.1 for information on adding new Invalid Test Cases.)

A column heading for each participating Field is prepopulated in the 
Invalid Test Cases list. 

Note —  Only one field value at a time can be made invalid. That is, y
can enter only one invalid value for one field at a time; you cannot en
one invalid value for one field, another invalid value for a second field
and so on. Neither can you enter multiple invalid values for a field at o
time. Each invalid value must denote a separate Invalid Test Case. Invalid 
combinations are not allowed in this release of the system. 

The invalid test cases are included in the Test Matrix. Typically, the 
AETG System forms an invalid test case by duplicating a valid test ca
and then corrupting it, entering the values you defined for the Invalid T
Case.

Note —  Compounds are never displayed on this view. Also, the simple
Fields that participate in Compounds are never displayed on this view

When this view is first displayed the Invalid Test Cases list is empty.

To create values for an Invalid Test Case, 
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2. Click in the empty cell for the Field for which you want to enter an invalid value 
(Figure 10-19). 

Figure 10-19.  Creating a New Invalid Test Case
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3. Click in the Invalid Value  text area and enter the invalid value for that Field.

4. Click on the Type  menu (if needed), and select the appropriate Value type, e.g., literal  
or non-literal  (Figure 10-20). 

5. When you are finished, perform one of the following: 

• To add a new Invalid Test Case 

Relation->New->Invalid

and repeat Steps 2, 3, and 4.

• To save the Relation object, e.g., execute 

Relation->Save 

• Change to one of the other Relation object views to further define your test c

Figure 10-20.  Specifying a Value for an Invalid Test Case
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10.2.5.2 Viewing/Modifying Existing Invalids

To view an existing Invalid, simply select an Invalid Test Case row. When you do so
Value in the row and the Type of the Value are automatically populated in the 
Invalid Value  text area and the Type  field, respectively.

You may edit the Invalid Value  text or may change the Type  field on an unlocked Relation
object.

10.2.5.3 Deleting Existing Invalids

To delete an existing Invalid Test Case

1. Select the appropriate row.

2. Execute

Edit->Delete
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11. Command Line Tools

This section describes the CLUI commands that are provided with the AETG System

11.1 xmyConvMatrix

Syntax

xmyConvMatrix ?-h? -t CSV matrixFileName

Description

The xmyConvMatrix  command reads in a Test Case Matrix file and prints the ma
information, to standard the output, in Comma Separated Values (CSV) format.

xmyConvMatrix  takes following option: 

Example

Assume you printed the following Test Case Matrix saved to the file 
/u/kjd/AETG/Payment. 

-h Provides a help message

-t Determines the format of the output. Only CSV is supported in 
Release 5.2.

matrixFileName Specifies the names of the Test Case Matrix file.

Note —  matrixFileName can be a Test Case Matrix file saved
to $XMYHOME/data/testMatrix/testID or it can be a local file 
you created using the AETG Matrix Print Dialog (Figure 9-27). 

{id 3166} {date {06/05/97 15:07:10}} {tc 7} {valid 4} {invalid 3} {staleFlag True}
{name V-0} {type V} {fields {{C c} {P A} {DAA-02 LDB} {DAA-01 LDA}}}
{name V-1} {type V} {fields {{C c} {P A} {DAA-02 LDB} {DAA-01 BLANK}}}
{name V-2} {type V} {fields {{C c} {P A} {DAA-02 BLANK} {DAA-01 BLANK}}}
{name V-3} {type V} {fields {{C c} {P A} {DAA-02 BLANK} {DAA-01 LDA}}}
{name I-0} {type I} {fields {{C c} {P A} {DAA-02 LDAA} {DAA-01 LDA}}}
{name I-1} {type I} {fields {{C c} {P A} {DAA-02 LDB} {DAA-01 LDAA}}}
{name I-2} {type I} {fields {{C c} {P A} {DAA-02 BLANK} {DAA-01 BLANK}}}
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Executing

xmyConvMatrix -t CSV /u/kjd/AETG/Payment

will create the following output:

You can save the output to a file, such as by executing

xmyConvMatrix -t CSV /u/kjd/AETG/Payment> Payment.csv

The CSV formated file can be imported directly by most spreadsheet programs.

NOTE — Relation information is not converted and is not 
in the output. 

11.2 xmyCreateFormats

Syntax

xmyCreateFormats filename(s)

Description

The xmyCreateFormats command lets you automatically create Format and Fiel
objects if the information for these objects is stored in a file in a specific format. 

xmyCreateFormats takes the following option: 

When you execute xmyCreateFormats, the named file(s) are used as input for 
creating Format and Field objects in the AETG database.

NOTE — xmyCreateFormats processes one Format 
object per file.

"3166", "06/05/97 15:07:10", "7", "4", "3", "True"
"V-0", "V", "c", "A", "LDB", "LDA"
"V-1", "V", "c", "A", "LDB", "BLANK"
"V-2", "V", "c", "A", "BLANK", "BLANK"
"V-3", "V", "c", "A", "BLANK", "LDA"
"I-0", "I", "c", "A", "LDAA", "LDA"
"I-1", "I", "c", "A", "LDB", "LDAA"
"I-2", "I", "c", "A", "BLANK", "BLANK"

filename The name of a file containing one or more Format definitions.
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The files containing the information about one or more Formats must follow a 
prescribed structure. Figure 11-1 shows an example file. 

The following tags must be specified in the file:

BEGIN MYNAH OBJECT
FORMAT

NAME
TYPE
FIELDS

FIELD # at least one
NAME
VALUES # at least one

END MYNAH OBJECT

All other tags are optional. 

NOTE — When specifying VALUES for FIELD tags, 
you may specify either LITERAL or NON-LITERAL; 
LITERAL is the default.

If any unknown tags appear in the file, they are ignored.

# any comments
BEGIN MYNAH OBJECT
{FORMAT

{NAME fmt-1}
{TYPE 3270SCREEN}
{DESCRIPTION “description of fmt-1”}
{FIELDS

{FIELD 
{NAME field-1}
{LOGICAL-NAME “field-1”}
{DESCRIPTION “description of field-1”}
{PARAMETERS “location (100,100)”}
{VALUES

{alpha beta gamma {delta NON-LITERAL}}
}

}
{FIELD

{NAME field-2}
{LOGICAL-NAME “field-2”}
{DESCRIPTION “description of field-2”}
{PARAMETERS “location (100,200)”}
{VALUES {one {two NON-LITERAL} three}}

}
}

}
END MYNAH OBJECT
# any other comments

Figure 11-1.  Format File Structure
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If any of the following conditions are not true, an error message will be produced
the Format and Fields objects will not be produced:

1. The user id of the person running the command must be a known user in the A
database.

2. All required tags must be present.

3. FORMAT NAME must not already exist in the database.

4. FORMAT TYPE must be a valid type, which is one of the following:

• 3270Screen

• AsyncScreen

• Message

• GuiScreen

• Configuration

• other.

5. FIELD NAME must be unique within the FORMAT.

6. FIELD VALUE must be unique within the FIELD.

Formal Syntax

There can be more than one format definition embedded in the file. Each format 
definition must be delimited by “BEGIN MYNAH OBJECT ” and “END MYNAH 
OBJECT”.

The formal syntax of the file is described in the following:

arbitrary-text

BEGIN MYNAH OBJECT
format description

END MYNAH OBJECT

arbitrary text

BEGIN MYNAH OBJECT
format description

END MYNAH OBJECT

...

format description:

{ FORMAT format-tag*}
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format tag:

{ NAME text }
{ TYPE valid-format-type }
{ DESCRIPTION text}
{ FIELDS  field-description *}

field-description:

{ FIELD  field-tag *}

field-tag:

{ NAME text }
{ LOGICAL-NAME text }
{ DESCRIPTION text }
{ PARAMETERS text }
{ VALUES field-value *}

field-value:

value-name
{ value-name  LITERAL }
{ value-name  NON-LITERAL}

field-name:

text

value-name:

text
 11–5
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Example

If you type

xmyCreateFormats formatfile

and formatfile contains the information in 

then one Format object named Order  and two Field objects named Item  and 
Color , respectively, will be created in the AETG database.

# any comments
BEGIN MYNAH OBJECT
{FORMAT

{NAME Order}
{TYPE MESSAGE}
{DESCRIPTION “this format represents a message type for app1 to app2”}
{FIELDS

{FIELD 
{NAME Item}
{LOGICAL-NAME “item”}
{DESCRIPTION “the kind of item being requested”}
{VALUES

{box pail bucket {container NON-LITERAL}}
}

}
{FIELD

{NAME Color}
{LOGICAL-NAME “color”}
{DESCRIPTION “the color of the item being requested”}
{VALUES {red blue yellow}}

}

}
END MYNAH OBJECT
# any other comments

Figure 11-2.  Example Format File
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11.3 xmyPrintFormatFields

Syntax

xmyPrintFormatFields format_name . version_number

Description

The xmyPrintFormatFields  command takes a Format object name and Version 
number as input and produces a list of the Fields and Values defined in the Form
object.

The output from xmyPrintFormatFields goes to standard ouput. You may redirec
the output to a file or may pipe it to another program.

NOTE — If a Format object name contains embedded 
spaces, replace the spaces with a non-breaking space (‘\ ‘).

Example

To print Version 1 of the Format object Decorator Screen, execute

xmyPrintFormatFields Decorator\ Screen.1

which will print text similar to that found in Figure 11-3 to the standard output. 

format: Decorator Screen.1

field: Primary Colorseq: 1  logical: PC
parameters:

literal value: Red
nonliteral value: Blue
literal value: Yellow

field: Other Colorseq: 2  logical: OC
parameters:

literal value: Orange
nonliteral value: anycolor

Figure 11-3.  Sample Output from xmyPrintFormatFields
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12. Input Modeling with the AETG System

This section provides tips on how the AETG System could be used to model various 
of applications. The sample modeled applications include graphical menus, 3270 Sc
and command line interfaces. Although the descriptions do not include details describing
how these applications would be implemented in the AETG System, you can apply t
models in a similar way as the example used in the Quick Start (Section 2). 

12.1 Modeling GUIs (Menus)

When testing menus on a GUI, it is important to verify that the appropriate functiona
are available under the various states the application may have. In most applications,
items are disabled to prevent the use of a function that would be invalid or meaningl
under certain conditions. 

For example, presume you have a menu with two options: Format  and Edit . Each option 
has a cascading submenu with the options listed in Table 12-1. 

Figure 12-1 illustrates the various states of this menu. 

The objective is to verify that menu items are enabled or disabled under the “correct s
factors that affect the menus under test. In our example, user controlled parameters
affect the menu state are the lock , clipboard , and selection  statuses. The menu in 

Table 12-1.  GUI Modeling Menu Example

Menu Option Submenu Options

Format • New Field

• Save

• Close

Edit • Delete

• Copy

• Paste

Figure 12-1.  GUI Modeling Menu Example

Format  
Edit

New Field
Save
Close

Format  
Edit

Format  
Edit Delete

Copy
Paste
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Table 12-1 and Figure 12-1 could be modeled using the AETG System as shown in 
Table 12-2. 

Once the fields and their values have been identified, the relationships between these 
parameters are defined or revealed. In this example, the relations are as listed in Table 12-3. 
These will be used to create the Included and Excluded Test Cases. 

Table 12-2.  GUI Menu Fields and Values

Fields NewField Save Close Delete Copy Paste lock clipb select

Values
enbld enbld enbld enbld enbld enbld on full on

disbld disbld enbld disbld disbld disbld off empty off

Table 12-3.  Menu Relations

Rel# Description

1 NewField  is enabled when the Format  menu is unlocked (lock  = off)

2 Save is disabled when the Format  menu is unlocked (lock  = off)

3 Close  is always enabled (Close  = enbld)

4 Delete  is enabled when select  = on and lock  = off

5 Copy  is enabled when an item is selected (select  = on)

6 Paste  is enabled when the object is unlocked and the clipboard is full 
(lock = off AND clipb  = full ).
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Figure 12-2 shows an example Test Case Matrix that can be used to test this GUI me
model. 

12.2 Command Line Interface (Asynchronous Command)

To test a sample command line using the AETG System, we will use the UNIX ls 
command. The various options of the ls command (such as c, l, t, r, and a) will be used to 
formulate a set of parameters and values. Their respective relationships need to be ob
during the definition of the Relation object. 

NOTE — Refer to a UNIX User’s Guide for further 
details about the ls command.

The ls command options will have two values: present  or not  (yes/no) as shown in 
Table 12-4. To model this test presume that ls may have no options or one or more of th

Figure 12-2.  Test Matrix for Testing the GUI Menus Model
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options mentioned above. Although some options are invalidated by others, we will n
define any exclude conditions for this model. 

Figure 12-3 shows an example Test Case Matrix that can be used to test the ls command. 

Table 12-4.  Modeling ls  UNIX Command

Fields c l t r a

Values
y y y y y

n n n n n

Figure 12-3.  Test Matrix for Testing the ls Command Model
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12.3 Configurations (Config)

In most cases software products are made up of many subsystems. Often these subsystem
have various versions that are designed to work together with other versions of system
this reason, it is important to test if the different versions of each sub-system work tog
as expected. 

Consider a product that consist of five systems (A, B, C, D, and E) and three of the 
subsystems have three versions and the other two have four versions. Table 12-5 shows the 
combinations of sub-system versions that can make up a product. 

Table 12-5 contains the various releases of each subsystem. Table 12-6 contains the 
constraints that exist in integrating these systems. These will be used to create the In
and Excluded Test Cases.

Table 12-5.  Modeling Configuration Scenarios

Fields A B C D E

Values

1 1 1 1 1

2 2 2 2 2

3 3 3 3 3

4 4

Table 12-6.  System Configuration Restrictions

Rel# Description

1 Version 1 of system A will not work with version 4 system D.

2 Version 2 of system B will only work with versions 2 and 3 of system E.

3 Version 4 of system E will only work with version 4 of system D.

4 Version 1 of system C will not work with versions 3 and 4 of systems D 
and E.
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Figure 12-4 shows an example Test Case Matrix that can be used to test configuratio

Figure 12-4.  Test Case Matrix for Testing Configuration Model
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13. Installing the AETG System

This section discusses the steps for installing the AETG System and related softwar
packages, e.g., Telexel.

13.1 Introduction

In addition to the AETG System software, you must also install the Telexel software 
package (which the AETG System uses for interprocess communications and logging) and 
an Oracle database.

Table 13-1 lists, in order, the steps needed to create our example AETG installation. 

13.2 Hardware and System Requirements

The AETG System runs on a SPARC™ machine running the Solaris operating system, 
Release 2.5.1. 

NOTE — If you are running the Oracle software on the 
same machine on which you are running the AETG 
System, then operating system patches may also be 
needed. Refer to the Oracle7 Server Installation Guide for 
your operating system.

The end-user display devices (X-terminals, workstations running X, or PCs running a
emulator) provide graphical/windowing capabilities and a UNIX command-line interface 
to AETG functionality. The display device should support a minimum resolution of 10
by 768 pixels. 

Table 13-1.  Installation Steps

Step Section

Installing the AETG System Section 13.6

Installing the Telexel System Section 13.7

Installing Oracle Section 13.8
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Table 13-2 lists the required software products (and versions) required to use the AETG 
system. 

13.3 Networking

AETG processes can be distributed across multiple hosts. All AETG processes use 
network services of the Database Management System for database access and the 
services of Telexel IPC processes for AETG interprocess communications and logging, as 
shown in Figure 13-1.

Figure 13-1.  Networked Services

In addition, the AETG processes rely on a single location for executables, but these c
have multiple locations for configuration information. The file system where this 
information is stored must be accessible (typically via NFS) by every host machine t
runs a AETG process.

a. TELEXEL IPC is provided with the AETG System distribution. It must be installed 
separately.

Table 13-2.  Required Software Packages

Product Version Vendor

Solaris 2.5.1 Sun

Oracle DBMS 7.3.2.3 Oracle

TELEXEL IPCa 7.0 Bellcore

X Window System X11R5 Sun

Telexel IPC

Logger

logs
 Database

DBMS

GUI
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13.4 Preliminary Background Information

There is background information you need to know before you install the AETG System.

13.4.1 Assumptions and Recommendations

The following subsections make certain assumptions about your installation. If you do not 
follow these assumptions, remember to make the necessary changes while installing
software. 

1. All packages are installed in /opt.

2. Under this directory you should create a directory named SUNWxxx, where xxx is the 
first three letters of the package, e.g., SUNWora for the Oracle software and 
SUNWmyn for the AETG System.

3. Under each package’s SUNWxxx directory you create a directory for the version 
number, e.g., 7.3.2.3 for the Oracle software.

4. You create a symbolic link in each package’s SUNWxxx directory pointing to the 
version directory, e.g., for the Oracle software you would execute

ln -s /opt/SUNWora/7.3.2.3/app/oracle/product/7.3.2.3 oracle

in the Oracle directory (/opt/SUNWora).

You create such symbolic links so you change only the link to the new version 
directory when you install a new version of the software. All user references sho
be made to the symbolic link name. This will make software upgrades easy sinc
library names will have to be changed if the users are referencing the symbolic link. 

NOTE — For the AETG and Telexel products, this will 
be done automatically by the BAIST installation product. 
You must do this yourself for Oracle.

Figure 13-2 shows an example of the recommended Oracle directory structure. W
configuring the AETG System, there are several places where you must specify
full path for the Oracle software, i.e., /opt/SUNWora/oracle. If you later install a new 
version of the Oracle software (e.g., Version 8.0) and you wish to retain the old ve
of the Oracle software, you will have to change only the symbolic link definition 
/opt/SUNWora/oracle. However, if you used /opt/SUNWora/7.3.2.3 to specify the 

WARNING — Do not actually create any directories or 
links at this time.
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path for the Oracle software, you must change each occurrence of this path 
declaration. 

In each subsection we will specify these environmental specifications (i.e., the SUNWxxx 
directory, version directory, and symbolic link names) for that package.

13.4.2 Environment Settings and xmyProfile and xmy Login

You will be prompted to enter a value for the shell variable $XMYHOME during the 
BAIST installation process. (See Section 13.6.2.2.) This variable is set in the files 
xmyProfile and xmyLogin, which are installed in the $XMYHOME/config directory, 
assuming you have used our recommended directory structure.

Users who wish to access the AETG System must source either xmyProfile or xmyLogin 
into their .profile or .login, respectively. See the AETG postinstallation steps in 
Section 13.6.2.3.

Figure 13-2.  Recommended Oracle Software Directory Structure

/opt

SUNWora

7.3.2.3 oracle

app

oracle

product

7.3.2.3
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NOTE — The AETG System is installed into two 
different directory structures. The $XMYDIR variable 
designates the directory containing the AETG software. 
(Using the recommended directory structure, this is 
/opt/SUNWmyn/aetg.) The $XMYHOME variable 
designates the directory containing your configuration 
files and run logs. We require that this be a directory that 
all AETG users have access to since the run log directory 
needs to have open write permissions. The default will be 
/opt/SUNWmyn/aetg_home.

The xmyProfile file contains the declarations for ksh environment variables for the installed
software based on our recommended locations. The xmyLogin file contains the declarations
for csh environment variables for the installed software based on our recommended 
locations. For example, the recommended location for the home of the Oracle software, 
ORACLE_HOME, is /opt/SUNWora/oracle. 

The xmyProfile and xmyLogin files also contain “place-holders” for certain environmen
settings that will be unique for your installation, such as the Telexel processes port nu
As you determine the values for these settings you can either enter them directly into these 
files or write them down and make all of your changes at one time.

Once you have completed installing the AETG System and all other required and op
software packages, you should source the xmyProfile or xmyLogin file into your .profile or 
.login, respectively, depending on which shell you are using.

NOTE — Most of the environment variables will be 
updated automatically during the BAIST installation 
process, but the xmyProfile and/or xmyLogin file need to 
be verified manually.

• If you are using ksh, source the xmyProfile file into your .profile (and all AETG user’s 
.profile’s) by including the following line:

. /opt/SUNWmyn/aetg_home/config/xmyProfile

This assumes that the user chose the default path for XMYHOME. (See 
Section 13.6.2.2.)

See Appendix C.1.3 for an example of the xmyProfile file.

• If you are using csh, source the xmyLogin file into your .login (and all AETG user’s 
.login’s) by including the following line:

source /opt/SUNWmyn/aetg_home/config/xmyLogin

See Appendix C.1.4 for an example of the xmyLogin file.
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NOTE — During installation you may have to reset the 
environment variable LD_LIBRARY_PATH due to its 
value being lost after executing an su command.

NOTE — While the other shells (sh and csh) are 
supported, all example shell commands shown in the 
installation steps assume you are using ksh.

13.4.3 Requirements

The $XMYDIR and $XMYHOME directories must be accessible to all AETG machines a
users. This can usually be accomplished by automounting these file systems on all o
machines. If X-Terminals or PCs are used then the user will be logging on to the AE
server, so this will not be necessary for these users.

13.5 Preliminary Actions

Before you install the AETG System, there are certain actions you must perform.

13.5.1 Obtaining License Keys

The AETG System software uses a floating license scheme involving a license-serve
daemon that runs on one machine in your network and takes requests for licenses fro
machine on your network. 

To run the AETG System software, you must first install a licensing key.

Generating the licenses is performed by Bellcore, and the keys are then sent to the 
customers. The contract between the customers and Bellcore defines which of the 
preceding products will have keys generated and for what time period.

Perform the following steps to obtain your license keys:

1. Decide which machine on your network will run the License Server daemon. (Th
daemon will run only on the machine for which it is licensed.) This is usually the
machine on which the AETG System software is installed, although it can be an
machine on your network.

2. Once you have decided which machine will run the License Server, determine i
hostid by typing the either of the following: 

• /usr/sbin/sysdef -h 

• /usr/sbin/hostid
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WARNING — The License Server software 
(LicenseServ) does not properly process dashes (-) in a 
directory path.

The hostid (in hexadecimal) is used to create the license key.

3. Once you have obtained this information, call

1-908-699-2668, Option 3 or 1-(800)-795-3119, Option 3

or send e-mail to

mynah-support@cc.bellcore.com

You will receive a list containing your key(s). This list is sent to you via the medi
of your choice—letter, e-mail (if available), phone, or fax.

NOTE — Save these keys until you are ready to install 
them. (See Section 13.9.)

13.5.2 Creating the mynah Group and AETG Administrator logid (madmin)

Perform the following steps before you begin installing the AETG System:

1. Decide which machine will be used as the AETG server.

2. Become a superuser, i.e., type

su root

3. Create a group called mynah.

4. Create a logid for the AETG Administrator in the group mynah, i.e., madmin.

NOTE — The AETG Administrator, madmin, should 
have a home directory and default shell, e.g., ksh.

5. Log onto the machine (as madmin) where you will be installing the system.

13.5.3 Changes to /etc/services

During installation, several changes must be made to the /etc/services file. For example, 
when configuring the Telexel System (Section 13.7.3), you must define and export 
vxIpcPort , which is the port used by the Telexel processes. 
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During installation, a file called etc.system.changes.eg is placed in the 
$XMYDIR/examples/admin/scripts directory. This file contains changes that should be 
added to the /etc/system file. Once the changes have been made, type

reboot -- -rt

to reboot the system. The system will be reconfigured with the changes to /etc/system 
incorporated in the kernel. You must do this as root on each system running a AETG 
component and on the ORACLE server.

NOTE — See Appendix C.1.2 to see a copy of the 
etc.system.changes.eg.

13.5.4 BAIST Considerations

The AETG System is delivered using the Bellcore standard UNIX installation proces
BAIST. The BAIST archive is delivered via a file archive obtained from the AETG ftp  
server or a CD-ROM. Whichever medium you use, the BAIST package contains arc
for the AETG and Telexel software.

This subsection describes the BAIST preinstallation procedures.

Installation must be performed as root on the AETG machine, and root must have write 
permission to the file system where the installation will be performed. 

If installation is performed via CD-ROM, the CD-ROM drive must be local to the mach

Create a directory for the BAIST installation database, e.g., /usr/local/BCRDB, if it has not 
already been created. This directory must be owned by root. You must also perform severa
actions to set the environment variable called BCRDB to the location of the BAIST 
installation database directory. How you set BCRDB depends on which UNIX shell (sh, 
csh, or ksh) you are using.

For all three shells, perform the following:

su root
mkdir /usr/local/BCRDB

If you’re using sh, enter

BCRDB=/usr/local/BCRDB
LOCAL_BCRDB=yes
export BCRDB LOCAL_BCRDB

If you’re using csh, enter

setenv BCRDB /usr/local/BCRDB
setenv LOCAL_BCRDB yes
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If you’re using ksh, enter

export BCRDB=/usr/local/BCRDB
export LOCAL_BCRDB=yes

Create the directory into which the installed software will go (e.g., /opt/SUNWmyn) prior 
to performing the installation. This directory must be owned by a user other than root, e.g., 
the AETG System Administrator, madmin.

For its own scripts, BAIST uses the ksh in $BCRDB/tools. However, some of the scripts 
used by the products BAIST installs, such as configuration scripts, may be using /bin/ksh. 
So it will be advisable to install the newer version of ksh.

The commands you use to start installation from the BAIST archive depends on whic
medium you use and will be explained in the following subsections. Whichever method
use, after you start the BAIST archive, the BAIST Opening Screen  ( Figure 13-3) appears.

   __________________________________________________________________________
  |                                                                          |
  |              Bellcore Application Installation Setup Tool                |
  |              -        -           -            -     -                   |
  |                                 BAIST 2.1                                |
  |                                                                          |
  |           COPYRIGHT  (c) 1996 Bell Communications Research Inc.,         |
  |                         All Rights Reserved.                             |
  |                                                                          |
  |            PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.           |
  |                                                                          |
  |                                                                          |
  |                   A UNIX Packaging and Installation Tool                 |
  |                                                                          |
  |                      For further information on BAIST                    |
  |                      Contact:  Raymond C. Gray                           |
  |                                BAIST Project Manager                     |
  |                                (908)699-7960                             |
  |                                                                          |
  |                                                                          |
  |__________________________________________________________________________|

Figure 13-3.  BAIST Opening Screen
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Following the BAIST Opening Screen , the BAIST  Product Menu  ( Figure 13-4) appears, 
prompting you for which package you wish to install. 

After a software package is installed, the BAIST Product Menu  will reappear. You can 
then select to install one of the other packages or exit from the archive. For example, d
initial installation of the AETG System, you may wish to first install the AETG softwa
followed by the Telexel software. You can then perform the necessary post installation or 
configuration steps needed by the AETG and Telexel software packages. You may in
wish to install one software package, exit from the BAIST archive, configure the insta
software, and then restart the BAIST archive and install and configure another packa

Prior to installing any package, a home directory must be created for the package. You
find it convenient to create all of these directories up front rather than individually. (S
Section 13.6.1 and Section 13.7.1.)

The following subsections detail installing one package at a time. You may also use 
method if you wish to install only one of the packages, such as if you receive an upd
version of one software package while retaining the currently installed versions of the other
packages.

NOTE — If you wish to install the AETG and Telexel 
software packages during one BAIST session, remember 
to perform the necessary preinstallation steps for each 
package before starting the archive. 

               BAIST 2.1 FLOW CONTROL
                    PRODUCT MENU
                        Archived Products List

                         1) AETG 1.0
                         2) AETG UPDATES
                         3) TELEXEL 7.0

                         I) Installed Products
                         R) Registered Products
                         E) Exit

                 Enter your Selection: 

Figure 13-4.  BAIST Product Menu
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13.6 Installing the AETG System

13.6.1 AETG System Preinstallation Steps

Perform the following steps before installing the AETG System:

1. Become a superuser, i.e., type

su root

2. Change to the /opt directory, i.e., type

cd /opt 

3. Create the SUNWmyn directory, i.e., type

mkdir SUNWmyn

4. Change the owner of /opt/SUNWmyn to madmin, i.e., type

chown madmin /opt/SUNWmyn

5. Change the group of /opt/SUNWmyn to mynah, i.e., type

chgrp mynah /opt/SUNWmyn

13.6.2 AETG Software Installation

The AETG System is delivered, along with the Telexel software, via a CD-ROM or a
archive obtained from the AETG ftp  server. You are prompted for the package you wish
install.

NOTE — When installing the AETG System as root on 
a remote filesystem (i.e., installing the software in a 
filesystem that is not local to the machine on which the 
installation is being performed), you may not really have 
root access to that file system. The installation could fail 
with permissions errors.

Install the AETG software using one of the following methods:

13.6.2.1 AETG Software CD-ROM Installation

For installation from CD-ROM, see the instructions in the CD-ROM case.
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13.6.2.2 AETG Software File Archive Installation

If you are installing from a file, perform the following steps:

1. Obtain the BAIST archive file from the ftp  server.

2. Enter the following command:

/bin/sh archive-file-name

where archive-file-name is the name of the BAIST archive file.

3. Select the AETG 1.0 option from the BAIST  Product Menu  (Figure 13-4).

NOTE — See Appendix C.1.1 for an example of a BAIST 
installation session of the AETG System software.

4. Answer the following questions asked by the BAIST installation software:

Where should the AETG directory be created? /opt/SUNWmyn

Who should own the AETG application? madmin

Where should XMYHOME be? <enter your location for XMYHOME>

NOTE — $XMYHOME must be different than the AETG 
software directory ($XMYDIR).

5. After the AETG software is installed, perform one of the following:

• Install the Telexel (Section 13.7) software package if it has not already been 
installed, and then exit from the BAIST archive.

• Exit from the BAIST archive and perform the AETG post installation steps in 
Section 13.6.2.3.
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13.6.2.3 AETG Post Installation Steps

Once you’ve installed the software, verify and correct, if necessary, the value assign
XMYDIR in your working copy of the xmyProfile or xmyLogin files. 

1. Become madmin, i.e., type

su madmin

2. Verify that a symbolic link exists pointing to the version directory (created by the 
BAIST installation process), i.e., type

cd /opt/SUNWmyn

ls -al

3. Verify and correct, if necessary, the value assigned to XMYDIR in your working copy 
of the xmyProfile or xmyLogin files. 
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13.7 Installing the Telexel System

The AETG System requires the Telexel System for inter-process communications an
logging.

NOTE — The Telexel System must be installed on a local 
filesystem or on a remote filesystem that is mounted with 
the suid option.

13.7.1 Telexel System Preinstallation Steps

Perform the following steps before installing the Telexel System:

1. Become a superuser, i.e., type

su root

2. Change to the /opt directory, i.e., type

cd /opt 

3. Create the SUNWtel directory, i.e., type

mkdir SUNWtel

4. Change the owner of the SUNWtel directory to madmin, i.e., type

chown madmin SUNWtel

5. Change the group of the SUNWtel directory to mynah, i.e., type

chgrp mynah SUNWtel

NOTE — The Telexel installation process automatically 
creates a separate directory for the version of the software 
being installed. In addition, the software package includes 
a utility program, vxInstall , that creates a series of 
symbolic links from the version directory into 
/opt/SUNWtel. This is handled by the BAIST Telexel post 
installation step.
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13.7.2 Telexel Installation

The Telexel System is delivered, along with the AETG software, via a CD-ROM or a
archive obtained from the AETG ftp  server. You are prompted for the package you wish
install.

NOTE — When installing the Telexel System as root on 
a remote filesystem (i.e., installing the software in a 
filesystem that is not local to the machine on which the 
installation is being performed), you may not really have 
root access to that file system. The installation could fail 
with permissions errors.

Install the Telexel software using one of the following methods:

13.7.2.1 Telexel Software CD-ROM Installation

For installation from CD-ROM, see the instructions in the CD-ROM case.

13.7.2.2 Telexel Software File Archive Installation

If you are installing from a file, perform the following steps:

1. Obtain the BAIST archive file from the ftp  server.

2. Enter the following command:

/bin/sh archive-file-name

where archive-file-name is the name of the BAIST archive file.

3. Select the Telexel 7.0  option from the BAIST  Product Menu  (Figure 13-4).

NOTE — See Appendix C.2 for an example of a BAIST 
installation session of the Telexel System software.

4. Answer the following questions asked by the BAIST installation software:

Where should the TELEXEL directory be created? /opt/SUNWtel

Who should own the TELEXEL application? madmin
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5. After the Telexel software is installed, perform one of the following:

• Exit from the BAIST archive and perform the Telexel post installation, 
configuration, and verification steps in Sections 13.7.2.3, 13.7.3, and 13.7.4, 
respectively.

• Install the AETG software package (Section 13.6) if it has not already been 
installed, and then exit from the BAIST archive.

13.7.2.3 Telexel Post Installation Steps

Once you’ve installed the software, execute the following commands to verify that a 
symbolic link exists to the version directory:

su madmin
cd /opt/SUNWtel
ls -al

13.7.3 Configuring the Telexel System

To configure the Telexel System, you must define and export the following environm
variables. You must have already installed and configured the AETG software for the
files to exist and before performing the following steps.

NOTE — Remember to edit your working copy of the 
xmyProfile or xmyLogin file, defining and exporting these 
variables.

1. Become madmin, i.e., type

su madmin

NOTE — Steps 2 through 7 can be accomplished as per 
Section 13.4.2 or manually as described below.

2. The following constraints must be followed in the /etc/system file:

A. The Message Queue parameters MSGMNB and MSGMAX must be equal, e

set msgsys:msginfo_msgmnb=65535

set msgsys:msginfo_msgmax=65535

NOTE — MSGMNB defines the maximum bytes on the 
queue, and MSGMAX sets the maximum size of the 
message.
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B. MSGMAX must be less than or equal to the product of MSGSEG and the MSG
parameters. 

NOTE — MSGSEG sets the number of message 
segments, and MSGSSZ sets the segment size of message.

For example, if MSGSEG is set to 16384 and MSGSSZ is set to 64, then 
MSGMAX must be less than or equal to 1,048,576.

13.7.4 Verifying the Telexel System

To manually verify your Telexel installation, cd to $TELDIR/bin then perform the 
following tasks:

1. Become madmin and change to the $TELDIR/bin directory, i.e., type

su - madmin
cd $TELDIR/bin

2. Type 

./vxIpcDir

to start the IPC process.

3. Type 

./vxIpcProcesses

to verify that the process started. You should get this:

IPC Registered Processes

ID PID HOST QUEUE USER
== === ==== ===== ====

If you get this,

vxIpcProcesses: can’t retrieve process list (error 1-IP-0024, errno 146).

then vxIpcDir  did not start. If you have to restart this process, you may have to w
for the port to time-out.

4. Type

./vxIpcUp

to start the Telexel Gateway. This starts a process called vxIpcRecvd.

5. Type

./vxLogToFile $XMYHOME/syslog/adminLog

to start the Telexel Logger.
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6. Type

./vxErrorServer $TELDIR/lib/errorText \ 
$XMYDIR/lib/xtw_error_text $XMYDIR/lib/xmyErrorText

to start the Telexel Error Server.

NOTE — The XMYDIR environment variable must be 
set to the AETG 5.2 installation directory. Both the 
XMYHOME and XMYDIR variables must be exported 
for Steps 5 and 6. See Section13.6.2.3. This was done as 
part of the AETG installation process.

7. Execute

ps -ef | grep vx

You should expect output similar to the following:  

These four processes should always be running on the AETG server.

NOTE — Other vx (Telexel) processes may also appear. 
The preceding processes constitute the minimum set.

madmin  4479 1 80  Jul 01 ?  9:59 vxIpcDir
madmin  4511 1 80  Jul 01 ?  0:31 /opt/SUNWtel/telexel/lib/vxIpcRecvd
madmin 22281 1 80  Jul 05 ?  0:01 vxLogToFile /opt/SUNWmyn/aetg/syslog/adminLog
madmin 22290 1 80  Jul 05 ?  0:02 vxErrorServer /opt/SUNWtel/telexel/lib/errorText
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13.8 Installing Oracle  

The AETG System requires the use of an Oracle database.

Although you will follow the Oracle installation procedures, there are certain factors t
you must take into consideration. For example, you must install several specific Ora
packages and create specific environment variables. This subsection discusses thes
factors. 

13.8.1 Oracle Preinstallation Steps

NOTE — Refer to the Oracle Installation and 
Configuration Guide for the version of the software being 
loaded. (Hereafter we refer to this guide as the Oracle 
Manual). For this installation we will reference those 
items relating to Oracle 7.3.2.3.

Perform the following steps before installing the Oracle System:

NOTE — The following steps assume you are using the 
ksh shell.

1. Create a new user named oracle with a group id of dba. (If necessary, create the group
first.)

NOTE — You must be root  to do perform this step.

2. Become a superuser, i.e., type

su root

3. Change to the /opt directory, i.e., type

cd /opt 

4. Create the SUNWora directory, i.e., type

mkdir SUNWora

5. Change to the /opt/SUNWora directory, i.e., type

cd /opt/SUNWora 

NOTE — This subsection assumes you do not have an 
existing Oracle database and are installing one for use 
with the AETG System.
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6. Under /opt/SUNWora, create the version directory, i.e., type

mkdir 7.3.2.3

7. Create the symbolic link pointing to the version directory in /opt/SUNWora, i.e., type

ln -s /opt/SUNWora/7.3.2.3/app/oracle/product/7.3.2.3 oracle

8. The owner of the /opt/SUNWora directory must be set to oracle and the group id to 
dba. Execute the following steps:

cd /opt
chown -R oracle SUNWora
chgrp -R dba SUNWora

9. When installing Oracle, ensure that the correct packages are loaded. For Oracle
Release 7.3.2.3, the following packages are required:

You can use the Oracle utility pkginfo to ensure that a package exists. For exampl
to verify that the SUNWbtool package has been loaded (if you are using the Sol
version), type

pkginfo -i SUNWbtool

See Solaris version of the Oracle Manual for updated information.

10. Define and export the following environment variables, but update only 
ORACLE_HOME and TWO_TASK in your working copy of the xmyProfile or 
xmyLogin file:

export ORACLE_HOME=/opt/SUNWora/oracle
export ORACLE_TERM=sun5
export ORACLE_SID=mynah5
export TWO_TASK=mynah5

NOTE — TWO_TASK should be unset until you 
perform Step 5 when configuring the AETG Oracle 
database (Section 13.8.4).

Solaris Version

SUNWbtool

SUNWsprot

SUNWtoo

SUNWarc

SUNWlibm

SUNWlibms
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11. Create a directory under $ORACLE_HOME named mynah5 with the owner set to 
oracle and the group to dba, i.e., type

cd $ORACLE_HOME
mkdir mynah5
chown oracle mynah5
chgrp dba mynah5

12. Under $ORACLE_HOME/mynah5 create the datafiles and logfiles directories with the 
owner set to oracle and the group to dba:

cd mynah5
mkdir datafiles logfiles
chown oracle datafiles logfiles
chgrp dba datafiles logfiles

13. The following is the recommended Oracle database disk configuration:

• disk1 - Tables and system

• disk2 - Index and some logs and control files

• disk3 - Rollback segments. 

A. Under $ORACLE_HOME/mynah5/datafiles create the directories d01, d02, and 
d03 with the owner set to oracle and the group to dba, i.e., type

cd datafiles
mkdir d01 d02 d03
chown oracle d01 d02 d03
chgrp dba d01 d02 d03

NOTE — Directory d01 contains items in disk1, 
directory d02 contains items in disk2, and directory d03 
contains items in disk3.

Proceed to Step 14.

B. Under $ORACLE_HOME/mynah5/datafiles create the following symbolic links to 
the directories on other disks, e.g., type

cd datafiles
ln -s <disk1> d01
ln -s <disk2> d02
ln -s <disk2> d03

Proceed to Step 14.

If you have only one disk available for the Oracle database, proceed to Item A.
you have multiple disks, proceed to Item B.
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14. Copy the following files from $XMYDIR/examples/dbadmin to 
$ORACLE_HOME/mynah5:

• configmynah5.ora (See Appendix C.3.2 for an example configmynah5.ora.)

• initmynah5.ora (See Appendix C.3.3 for an example initmynah5.ora.)

• crdbmynah5.sql (See Appendix C.3.4 for an example crdbmynah5.sql.)

• crdb2mynah5.sql (See Appendix C.3.5 for an example crdb2mynah5.sql.)

• crdb3mynah5.sql (See Appendix C.3.6 for an example crdb3mynah5.sql.).

After you’ve copied the files, you must change the permissions on the file by 
executing the following:

cd $ORACLE_HOME/mynah5
chmod 775 *

You may need to edit the *.ora and *.sql files to update the correct directories path
(such as where Oracle is installed) and possibly to change the sizing information

NOTE — Do not use environment variables to define 
these paths.

15. Make the changes to the /etc/system file (See Section 13.5.3) as shown in 
$XMYDIR/examples/admin/scripts/etc.system.changes.Sun.eg.

You must reboot the system with the ste reconfiguration options before you insta
Oracle database (Section 13.8.2).

To reboot, execute

reboot -- -rt
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13.8.2 Oracle Installation

To install the Oracle database, follow these steps.

NOTE — The system must be rebooted using the -r  
option before executing the Oracle installation software.

For assistance, refer to the Oracle Manual.

NOTE — Do not use environment variables or symbolic 
links until Oracle is installed.

1. Mount the CD-ROM containing the Oracle software using one of the three follow
methods

• Execute

mount -r -F hsfs /dev/dsk/cot6d0s1 /cdrom

• Execute

volcheck cdrom 

• If you’re using volume manager, the CD-ROM is automatically mounted wh
you insert the disk.

2. Become the user oracle, i.e., type

su oracle

3. Change to the /cdrom/oracle/orainst directory. i.e., type 

cd /cdrom/oracle#1/orainst

4. Make sure the terminal type is set to vt100, and clear the screen, i.e., type

export TERM=vt100
clear

5. Start an xterm window, i.e., type

xterm &

This will let you use the arrow keys and display used by the Oracle installation 
software.

6. Start the Oracle install program. i.e., type in this xterm window

./orainst
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Table 13-3 lists the Oracle installation items and appropriate responses you mus
perform to ensure that the database will work properly with the AETG System.  

Table 13-3.  Oracle Installation Items and Responses (Sheet 1 of 2)

Item Response

Preamble.txt OK

Installation Activity Choice Install, Upgrade, or De-Install

Installation Option Install New Product

Mount Point /opt/SUNWora/7.3.2.3

Home Location 7.3.2.3

DB Objects - Create? No

Logging and Status OK

readme.first OK

Skip readme OK

Install source CD-ROM

NLS Amer.

Relink all Exec. No

Information OK

On-line Help Load All Prod (Optional)

UNIX Documentation Yes (Optional)

Product Documentation Library All Prod (Optional)

Oracle Documentation /opt/SUNWora/7.3.2.3/app/oracle/doc

Software Asset Manager At this step of the installation process, the Oracle 
System displays a scrollable list showing the availab
Oracle packages. To select which packages to inst

1. Use the arrow keys to scroll through the list of 
packages.

2. Press the space bar to select a package when i
highlighted.

3. When you have selected all of your desired 
packages, press the TAB key to go to the Instal
button and press the Return key.

Table 13-4 lists the packages that must be installed

Official Hostname Enter your machine name (including the domain).

TCP Surf Port 8888 or any unused port number.

Password and Verify Password any
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13.8.2.1 Verifying an Installation

To verify your actions during the installation, view the install.log file by executing either 
of the following in $ORACLE_HOME/orainst:

tail -f install.log 

cat install.log | grep code

You should not get errors from the install process (i.e., all return codes should equal

13.8.2.2 Oracle Error Messages

If you get ORACLE error messages, type

oerr xxx #### 

to find out what the error is, where xxx is ORA or DBA and ####  is the error number.

DBA Group OK

OSOPER Group OK

DBA doesn’t exist Yes (continue)

Enter Oracle Sid mynah5

X Libraries /usr/openwin/lib

Run root.sh OK

Table 13-4.  Oracle Software Asset Manager Packages

Package Version Number

Oracle Server Manager V2.3.2.0.0

Oracle UNIX Installer V4.0.0.0.0

Oracle Server RDBMS V2.3.2.3.0

PL/SQL V2.3.2.3.0

SQL*Net (V2) V2.3.2.1.0

SQL*Plus V3.3.2.0.0

TCP/IP Protocol Adapter V2.3.2.3.0

Table 13-3.  Oracle Installation Items and Responses (Sheet 2 of 2)

Item Response
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13.8.3 TNS Configuration

The Oracle environment must be configured for the TNS Listener process. These file
either stored in /var/opt/oracle or in $ORACLE_HOME/network/admin. In the latter case 
or if these files are in a directory other than /var/opt/oracle, then an environment variable,
TNS_ADMIN, must be defined to point to this directory. See the S96oracle.eg file in 
$XMYDIR/examples/admin/scripts for an example. 

NOTE — This environment variable must be updated in 
the $XMYHOME/config/xmyProfile and 
$XMYHOME/config/xmyLogin files.

Sample tnsnames.ora.eg and lisenter.ora.eg files are also included in 
$XMYDIR/examples/admin/scripts and in Appendix C. These example files must be edit
for your environment, renamed without the .eg extension, and moved to the desired 
location.

13.8.4 Configuring the AETG System Oracle Database

NOTE — This subsection contains several example 
executions of the utilities used to configure the Oracle 
database. All-user supplied entries appear in bold.

Since Oracle is now installed, you are ready to configure the AETG Oracle database

1. If you are still not a superuser, become one, i.e., type 

su root

2. Create a directory in /var/opt named oracle with the owner set to oracle and the group 
to dba, i.e., type

cd /var/opt
mkdir oracle
chown oracle oracle
chgrp dba oracle

This directory could also be a symbolic link from /var/opt/oracle/oratab to 
/etc/oratab.

3. Copy the initmynah5.ora and the configmynah5.ora files from 
$ORACLE_HOME/mynah5 (See preinstallation Step 14 in Section 13.8.1) to 
$ORACLE_HOME/dbs. Make sure these files have been edited and updated.

4. Change to $ORACLE_HOME/mynah5 and become the user oracle, i.e., type 

cd $ORACLE_HOME/mynah5
su oracle
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5. Execute the following commands (being sure to complete the preinstallation Ste13 
first):

svrmgrl 
SVRMGR> connect internal
SVRMGR> startup nomount pfile=/opt/SUNWora/oracle/dbs/initmynah5.ora
SVRMGR> @crdbmynah5.sql
SVRMGR> connect internal
SVRMGR> @crdb2mynah5.sql
SVRMGR> connect internal
SVRMGR> @crdb3mynah5.sql
SVRMGR> connect internal
SVRMGR> shutdown immediate
SVRMGR> exit

6. Change to $ORACLE_HOME/orainst, i.e., type 

cd $ORACLE_HOME/orainst

7. Become a superuser, i.e., type

su root

8. Run root.sh, which was created by the Oracle install process.

The following is a sample run.

./root.sh
Running ORACLE7 root.sh script...

The following environment variables are set as:
ORACLE_OWNER= oracle
ORACLE_HOME= /opt/SUNWora/oracle
ORACLE_SID= mynah5

Are these settings correct (Y/N)? [Y]: Y

Enter the full pathname of the local bin directory 
[/opt/bin]: /usr/local/bin

Checking for “oracle” user id...
ORACLE_HOME does not match the home directory for oracle.
Okay to continue? [N]: Y

Creating /var/opt/oracle/oratab file...
Updating /var/opt/oracle/oratab file...

Please raise the ORACLE owner’s ulimit as per the IUG.

Leaving common section of ORACLE7 root.sh.
Setting orasrv file protections

9. Edit the /var/opt/oracle/oratab file, then change the N to Y on the actual data line (i.e.,
the last line). 
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WARNING — Do not use a symbolic link name in this 
file. This entry is case-sensitive, so you must enter a 
capital Y.

See the comments in the oratab file for more information. 

10. Become the user oracle, i.e., type

su oracle

11. Execute the following commands:

svrmgrl  

svrmgrl: Release 7.3.2.3.0 - Production on Thu Apr 18 11:07:43 1996

Copyright (c) Oracle Corporation 1979, 1994.  All rights reserved.

Oracle7 Server Release 7.3.2.3.0 - Production Release
With the distributed, replication and parallel query options
PL/SQL Release 2.1.6.2.0 - Production

connect internal
Connected.
startup pfile=/opt/SUNWora/oracle/dbs/initmynah5.ora
ORACLE instance started.
Total System Global Area       5079016 bytes
              Fixed Size         39696 bytes
           Variable Size       4621528 bytes
        Database Buffers        409600 bytes
            Redo Buffers          8192 bytes
Database mounted.
Database opened.
exit

12. To verify the database creation process, execute the following:

svrmgrl  
SVRMGR> connect internal
SVRMGR> select * from v$controlfile;

$ORACLE_HOME/dbs/ctrl1mynah5.ctl
$ORACLE_HOME/mynah5/datafiles/d02/ctrl2mynah5.ctl
$ORACLE_HOME/mynah5/datafiles/d03/ctrl3mynah5.ctl

SVRMGR> select file_name,status from dba_data_files;
$ORACLE_HOME/mynah5/datafiles/d01/systmynah5.dbf AVAILABLE
$ORACLE_HOME/mynah5/datafiles/d02/rbsmynah5.dbf AVAILABLE
$ORACLE_HOME/mynah5/datafiles/d03/toolmynah5.dbf AVAILABLE
$ORACLE_HOME/mynah5/datafiles/d03/my5mynah5.dbf AVAILABLE
$ORACLE_HOME/mynah5/datafiles/d01/usrmynah5.dbf AVAILABLE
$ORACLE_HOME/mynah5/datafiles/d01/tempmynah5.dbf AVAILABLE

13. Become the AETG Administrator (madmin), i.e., type

su madmin
13–28  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Installing the AETG System
  Release 1.0

se is 

ase 

not 
14. Execute xmyProfile or xmyLogin in the AETG config directory ($XMYHOME). Make 
sure that TWO_TASK is unset when the database is local and set when the databa
remote to the system which you are on.  Make sure ORACLE_SID equals mynah5.

15. Create the AETG database using the xmyCreate commands (e.g., 
xmyCreateSequences and xmyCreateDemoObjects).

A. cd to $XMYDIR/dbadmin.

B. Execute 

xmyCreateTables

You should see the following:

Database connection opened.
Tables do not exist, creating them. 

C. Execute 

xmyCreateSequences

xmyCreateSequences creates all of the sequences needed by the AETG datab
to operate. 

See Appendix C.3.7 for an example xmyCreateSequences execution.

D. Execute

xmyCreateTemplates

See Appendix C.3.8 for an example execution.

16. Verify the TCP port in the /etc/services file by searching for an entry such as the 
following:

tnslsnr 1521/tcp #oracle listener

If this line is not present and NIS is not used, add this line to the /etc/services file. 

WARNING — You must do this in every /etc/services 
file on all machines running the AETG System. 

If NIS is used, then the following can be in the ypserices 
file to verify this /etc/services file entry:

ypcat services | grep 1521

If the 1521 port is being used, then choose another port on all machines that is 
being used.
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13.8.5 Dropping the Oracle Database

During installation, the following commands are installed in $ORACLE_HOME/mynah5:

• xmyDropSequences.

• xmyDropTables

Execute these commands if something goes wrong and the database needs to be cl
up/deleted. 

If problems are encountered with the database, consult AETG support before runnin
previous commands.

WARNING — These operations are drastic in nature, and 
thus they should not be run if the database has been 
populated with important data. They may, however, be 
useful when first installing a database. 

Once these commands have finished executing, run the xmyCreate commands 
(Section13.8.4, Step 15) to recreate the tables in the AETG database.

13.8.6 Verifying Oracle

To verify if everything is up and working in Oracle, do the following: 

1. Copy the S96oracle.eg file from $XMYDIR/examples/admin/scripts to /etc/rc2.d and 
then rename it S96oracle.

2. Set the ORACLE_HOME variable in S96oracle to the correct path, then verify all 
other paths.

3. Execute

su root

/etc/rc3.d/S96oracle start

or

/etc/rc3.d/S90oracle start

The following Oracle processes should be up and started:

• tnslsnr LISTENER

• ora_reco_mynah5

• ora_smon_mynah5

• ora_pmon_mynah5
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• ora_lgwr_mynah5

• ora_dbwr_mynah5

• ora_s000_mynah5

• ora_d000_mynah5

4. Execute a command of the following form:

svrmgrl system/manager@mynah5

You should get a good connection.

You can also try any of the following to verify your Oracle installation:

1. Verify the existence of the $ORACLE_HOME/rdbms/log/alert_mynah5.log file.

2. If problems occur, try to set up a symbolic link in /etc, for example,

ln -s /var/opt/oracle/oratab oratab

3. Verify 

• oracle permissions 6751

in $ORACLE_HOME/bin.

4. If you must relink, try the following:

$ORACLE_HOME/rdbms/lib /usr/ccs/bin/make -f oracle.mk install
$ORACLE_HOME/network/lib /usr/ccs/bin/make -f network.mk install
$ORACLE_HOME/sqlplus/lib /usr/ccs/bin/make -f sqlplus.mk install

5. To verify what is linked in Oracle, use the adapters and drivers command, as in the 
following:

adapters
Installed SQL*Net V2 Protocol Adapters are:
V2 BEQ Protocol Adapter
V2 IPC Protocol Adapter
V2 TCP/IP Protocol Adapter
V2 Raw Protocol Adapter
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13.9 Installing the License Keys

Before you use the AETG System, you must install the AETG System license key. (S
Section 13.5.1 for information on obtaining license keys.)

Perform the following steps to install the license keys:

1. Put each key on a line by itself in a file called xmyLicenses.

2. Place the xmyLicenses file in $XMYHOME/config. If xmyLicenses already exists and 
contains other keys, add the new key after the last line in the file. Expired keys sh
be deleted.

3. Execute the following command to check that port 5093 is not currently being u

netstat | grep 5093

If this port is being used, call the AETG hotline. (See Section 13.5.1.) Otherwise, edit 
the /etc/services file, then add the following line:

LicenseServ        5093/udb

4. Set and export the variable LSHOST, which is the license server machine. Reme
to verify/update that LSHOST is set in the $XMYHOME/config/xmyProfile or 
$XMYHOME/config/xmyLogin file.

5. Selected or deselect license keys by uncommenting or commenting (#) the keys
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13.10 Installing the On-line Documents

This document is available on-line in the Adobe Acrobat PDF format (Release 3.0). W
installing the AETG System, a tar file, mynah_aetg.tar is placed in $XMYDIR/doc. This 
archive contains the PDF file and an HTML web page, which will let users access the
file from non-local systems, such as if the AETG System is installed on a server and the
users must telnet to the AETG server.

Viewing the PDF file requires that users have installed the Adobe Acrobat Reader. S
Section 13.10.2 for information obtaining the Acrobat Reader.

13.10.1 Installing the PDF Files

Unpackage the tar  archive by executing the following commands:

cd $XMYDIR/doc

tar -xvf mynah_aetg.tar

A directory called mynah_aetg is created under $XMYDIR/doc containing the MYNAH 
and AETG documentation in PDF format. 

13.10.2 Obtaining the Acrobat Reader

The Acrobat Reader is available directly over the Internet from Adobe at www.adobe.
In addition, the Acrobat Reader is included on the CD-ROM or as a file archive obtain
from the AETG ftp  server.

The following versions of the Acrobat Reader are available via the CD-ROM or file 
archive:

• Solaris

• HP-UX™

• Microsoft® Windows™ 3.1 (16-bit)

• Microsoft Windows 95 and Microsoft Windows NT® (32-bit)

• Macintosh®.
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13.10.2.1 Obtaining the Acrobat Reader from the CD-ROM 

To install the Acrobat Reader from the CD-ROM

1. Mount the CD-ROM as per the instructions in the CD-ROM case.

2. Copy the appropriate Acrobat Reader and README files from the directory 
/cdrom/mynah/acroread.

3. Install the Acrobat Reader as per the instructions in the README file.

13.10.2.2 Obtaining the Acrobat Reader as a File Archive

To obtain the Acrobat Reader as a file archive:

1. Obtain the appropriate Acrobat Reader and README files from the FTP site.

2. Install the Acrobat Reader as per the instructions in the README file.

13.10.2.3 Obtaining the Acrobat Reader from Adobe

You can download the Acrobat Reader directly over the Internet from Adobe at 
www.adobe.com. Follow the instructions detailed on the web page.

13.10.3 Accessing the PDF Files

Once you have installed the Acrobat Reader, users can read the file

• Using the Acrobat Reader directly from $XMYDIR/doc/mynah_aetg if they are 
running the AETG System on the system where it was installed

• Using the Acrobat Reader as plug-in to a browser if the AETG System has not b
installed on a local system.

In this case, you would move the mynah_aetg directory to an internal web site. You 
must install the mynah_aetg directory in such a way that will ensure that it shall not b
accessed over a public, non-secured Internet connection or shared with any Third 
Party, such as through an extranet connection. 

If the users access the PDF file via a browser, they may wish to download the file to
local system, which will give them direct access to the file the next time they need to
the file, rather than waiting for the browser to load it. 
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14. Configuring the AETG System

Once you’ve installed the software, you must configure the AETG System. This sect
describes the syntax and content of the AETG configuration files.

14.1 Introduction

The AETG configuration files are stored in the directory assigned to the variable 
$XMYHOME. This must be different from $XMYDIR (/opt/SUNWmyn/mynah). For 
example, if multiple configurations are desired for different user communities of the s
AETG installation, then multiple $XMYHOME locations may be created. 

This section covers the two AETG configuration files, the xmyConfig.General and 
xmyConfigOP files, that you can edit to customize an installation.

14.2 The xmyConfig.General File

During the AETG install process, an example configuration file was  copied from the
$XMYDIR/examples/config directory to the $XMYHOME/config directory. 

An example xmyConfig.General entry is shown in Figure 14-1. 

xmyConfig.General file entries take the format

General Default
parameter = option,
parameter = option;

and use the following conventions:

• Each parameter listing, except for the last parameter for an entry, is delimited b
comma (,). 

• Each entry is delimited by a semicolon (;). 

The valid xmyConfig.General configuration parameters are 

General Default
DefaultSD = SD1, # not supported 
Database = yes, # "no" if Oracle is not used
WelcomeNewUsers = yes, # "no" if Oracle is not used
NonOwnerObjectModification = yes, # true or false
OMPort = 5000; # 

Figure 14-1.  xmyConfig.General Entry

DefaultSD This configuration parameter is not supported for thi
release of the AETG System.
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Database Indicates whether or not this configuration of the 
AETG System makes use of a database. The datab
is required if users need to use the AETG test 
management abilities.

yes Use a database

no Do not use a database

Default = yes

WelcomeNewUsers Indicates whether or not the GUI will automatically 
create a person object for a new user (i.e., a user th
does not exist yet in the database).

yes The GUI will create a Person object for the ne
user.

no The GUI will notify the user that they are not 
an authorized user of the AETG System, and
the GUI will exit. 

Default = yes

NonOwnerObjectModification Specifies whether a user has the ability to modify oth
people's objects in the AETG GUI. If this parameter i
set to false, only the owner of an object or an 
administrator will be able to edit the object. 

Note —  All users will still be able to open the object
in read-only mode.

The ability to open Test Hierarchies for editing 
purposes is not affected by the setting of this 
configuration tag; nonowners and nonadministrators
can open Test Hierarchies for editing even if 
NonOwnerObjectModification  is set to no. 

Default = yes 

OMPort Specifies the port number used by the OA processes
communicate with the xmyOM  start, stop, and status 
methods. This must be set to a valid unused port 
number greater than 5000 and less than 65000.

Refer to the /etc/services files to determine what ports 
are unused.

This is a required parameter.
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14.3 The xmyConfigOP File Syntax

Configuration information for the Operability Management processes is contained in
xmyConfigOP file. This file is located in $XMYHOME/config.

NOTE — Operability Management (OM) gives you a 
single mechanism to start, stop and obtain status on all of 
the AETG processes from any host, including those 
processes not developed by AETG but that are an integral 
part of the AETG operation (e.g., all of the Telexel 
processes). 

This section describes the entries of the xmyConfigOP 
file, which creates configuration information for the 
AETG Operability Management structure. 

xmyConfigOP file entries use the same format as the xmyConfig file entries:

entry_name LogicalName
parameter = option,
parameter = option;

xmyConfigOP entry_names can be one of the three following reserved names, each of 
which is used to create specific operability configurations: 

The LogicalName argument is used to assign a unique name to an entry_name.

The following sections detail the parameters and their values for each entry_name.

14.3.1 General Entry

The xmyConfigOP file must contain the same General entry as the xmyConfig.General file 
(Section 14.2). This entry is includes into the xmyConfigOP file by entering the line 

%INCLUDE xmyConfig.General

at the beginning of the xmyConfigOP file.

General Used to create configuration parameters that apply to the ent
AETG System.

Process Used to define processes to be managed.

OperabilityAgent Used to define the OA for the host.
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14.3.2 Process Entries

There are processes that must be running before you start the AETG System, and e
process must have a Process entry in the xmyConfigOP file. These processes can be Telex
processes or the license server. The syntax of a Process entry is shown in Figure 14-2. 

The Process configuration parameters are 

The names you enter for the LogicalName are used as elements in the Responsibility list 
parameter for the OperabilityAgent  entry. (See Section 14.3.4) This list tells the OA what 
processes it is responsible for.

The Start, Stop, and Status commands for the background processes are standard Tel
commands.

Process LogicalName
Mynah = {yes|no},
AutoStart = {yes|no}, # Yes tells the OA to start

# process at boot time
Start =“ start command ”,
Stop =“ stop command ”,
Status =“ status command ”;

Figure 14-2.  xmyConfig Process Entry

Mynah Indicates whether the process is a AETG process. For example, there 
Telexel processes that are required by AETG, but they themselves are not 
AETG processes. In this case, this parameter is set to no. In addition, you 
can use the Operability feature to bring up your own processes.

yes This is a AETG process

no This is not a AETG process.

AutoStart Indicates whether the process is automatically started when the OA is 
booted.

yes Start this process when the OA is booted.

no Do not start this process when the OA is booted.

Start Specifies the command that starts the process.

Stop Specifies the command that stops the process.

Status Specifies the command that returns the status of the process.
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14.3.3 License Server Start, Stop, and Status Commands

The License Server Start, Stop, and Status commands are

Start = xmyStartLS

Stop = xmyStopLS

Status = xmyStatusLS

All of the following commands accept the following options:

14.3.4 OperabilityAgent

Operability Agents (OAs) are responsible for communicating the start, stop, and status 
requests to individual processes.

OAs are started at host boot time or by the user using the CLUI commands.

The OA reads the xmyConfigOP file to determine what platform and application process
it is responsible for. 

The OA relies on the Start, Stop, and Status parameters that are defined for each proce
that the OA is responsible for. 

NOTE — Each process entry contains an Autostart  
parameter. If a process’s Autostart  parameter is set to 
Yes, the OA automatically start sthat process when the 
OA starts. By default, the delivery configuration entries 
for all Telexel processes are set to Yes.

There is one OA per host and every OA is defined in the xmyConfigOP file. 

NOTE — This must be done on each AETG system host, 
and not just on the AETG server system.

The syntax of an OperabilityAgent  entry is shown in Figure 14-3. 

-h Returns a brief help message for the command.

-H Returns a detailed help message for the command.

-R Returns the current release number of the AETG System.

OperabilityAgent OA_Hostname
Responsibility =( list of names); # managed processes

Figure 14-3.  xmyConfigOP OperabilityAgent Entry Structure
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The OperabilityAgent  configuration parameter is 

NOTE — The OperabilityAgent  LogicalName must be 
the name of the host on which the OA runs.

Figure 14-4 contains an example of an OperabilityAgent  entry. 

While there is only one OA per host, you must define the OAs for all hosts in the 
xmyConfigOP file. In addition, each process will be able to appear in multiple OAs’ 
responsibility lists. This way you don’t have to redefine the processes for each host.

When the OA starts, it determines its name by looking at what host it was started on
OA then looks for its entry in the xmyConfigOP file to see what processes it is responsib
for and immediately starts the ones with Autostart = yes. 

Each LogicalName that appears in the Responsibility list for an OA must correspond to a
defined Process entry.

The OA starts these processes in the order listed in the Responsibility list. 

NOTE — This is very important because some processes 
must be up and running before other processes can start. 
These are

1. vxIpcDir 

2. The rest of the Telexel processes

Responsibility Specifies the names of all of the processes for which the OA has 
responsibility. They must appear in a comma-separated list enclose
parentheses in the format

Responsibility = (<process1>, <process2>, …,<processN>)

OperabilityAgent selene
Responsibilities = (vxDir, vxGatewayselene, vxLogToFile, 

vxErrorServer, xmyLS);

Figure 14-4.  Example xmyConfigOP OperabilityAgent Entry
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14.3.5 Example xmyConfigOP File

Figure 14-5 contains an example xmyConfigOP file for an AETG configuration. The 
xmyConfig.General file in Figure 14-1 has been included into the xmyConfigOP file via the 

%INCLUDE xmyConfig.General

statement.

This example defines the following Operability processes:  

vxGatewayhost This defines the Telexel gateway daemon. One occurrence of thi
process must be running on each host in the AETG System 
configuration. 

vxIpcDir This defines the Telexel directory service. One occurrence of this
process must be running. It provides the directory name service for 
all other processes. 

vxErrorServer This defines the Telexel error server. 

vxLogToFile This defines the Telexel log to file process. 

xmyLS This defines the Operability configuration for the License Server.
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14.4 The .xmyMYNAHrc File

The xmyRunAetg process creates and maintains a .xmyMYNAHrc file in the user’s home 
directory. This file is used to store desktop and preference information. It is read by t
process upon start-up. 

%INCLUDE xmyConfig.general
#OPERABILITY ENTRIES FOR INDIVIDUAL PROCESSES ON host1
 
Process vxGatewayselene

Mynah = no,
Autostart = Yes,
Start = ”vxIpcUp”,
Stop = ”vxIpcDown”,
Status = ”vxIpcMgr”;      # AETG provides an xmy shell

 
Process vxIpcDir

Mynah = no, 
Autostart = Yes,
Start = ”vxIpcDir”,
Stop = ”vxIpcDown -d”,
Status = ”vxIpcMgr”;

 
Process vxErrorServer

Mynah = no, 
Autostart = Yes,
Start = ”vxErrorServer $TELDIR/lib/errorText\

$TRAXWAYHOME/config/xtw_error_text\
$XMYDIR/lib/xmyErrorText”,

Stop = ”?”,
Status = ”xmyLogStatus”   ;

 
Process vxLogToFile

Mynah = no, 
Autostart = Yes,
Start = ”vxLogToFile $XMYHOME/syslog/adminLog”,
Stop = ”vxIpcTerm vx”,
Status = ”vxIpcMgr”;

Process xmyLS
Mynah =  Yes,
Autostart =  Yes,
Start =  “xmyStartLS”,
Stop    =  “xmyStopLS”,
Status  =  “xmyStatusLS”;

#OPERABILITY ENTRIES FOR AGENTS
 
OperabilityAgent selene

host = selene,
Responsibilities=(vxDir, vxGatewayselene, vxLogToFile,

                          vxErrorServer, xmyLS);

Figure 14-5.  Example AETG xmyConfigOP File
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15. Operability Management — Starting and Stopping AETG 
Processes

Operability Management  gives the AETG administrator a single mechanism for 
starting, stoping, and getting status of the AETG processes from any host, including 
processes not developed by AETG but that are an integral part of the AETG operation (e.g., 
all of the Telexel processes). 

This mechanism is composed of an Operability Manager (OM), an Operability Agent (O
and configuration information. The OM is invoked by typing the xmyOM  command.

NOTE — See Section 16.2 for a discussion of the 
xmyOM  command.

15.1 Basic Steps

This section briefly lists the basic steps used for configuring the Operability Managem
files and starting AETG processes. The following sections provide detailed descriptio

1. Set up the xmyConfigOP file. This file contains all of the configuration information fo
the platform  processes required by the OM and the OA.

2. Start the OA on each AETG System host. Generally this is done by including th
xmyStartUp command in a start-up file. The file S99mynah.eg is included in the 
$XMYDIR/examples/admin/scripts directory. It can be updated for the correct path a
machine names and then placed in the /etc/rc3.d directory. (See Section 15.8.)

The OA reads the xmyConfigOP file to determine which processes it is responsible f
and then starts those processes on that machine that have Autostart = Yes, such as 
Telexel processes.
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15.2 Overview

For start-up, all processes that are required by the AETG System,must be started. 

For each host in the AETG configuration, these processes are composed of

• An AETG OA

• The required Telexel processes, e.g., the Telexel IPC and logger processes

15.3 Operability Design

As mentioned earlier, the design is composed of an OM, an OA, and configuration 
information.

There is only one OA per AETG host machine, per AETG configuration. The OA 
“manages” all AETG required processes on a host. The OM, via the xmyOM  
subcommands, provides a user interface to the OAs. The basic design is depicted in
Figure 15-1.

Figure 15-1.  Operability Architecture

User

OM

OA1

P1 Pn. . .

Host 1 Host 2

OA2

P1 Pn. . .
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15.3.1 Operability Manager (OM)

The OM provides you with a set of commands to manage all AETG processes. The 
management is very high level. You can start or stop a process or determine if a proc
running properly. 

15.3.2 Operability Agent (OA)

The OAs are responsible for communicating the start, stop, and status requests to individual 
processes, and then communicating the reply back to the OM.

OAs are started at host boot time or by the user using the CLUI commands.

NOTE — This must be done on each AETG system host 
and not just on the AETG server system.

The OA reads the xmyConfigOP file to determine what platform and application process
it is responsible for. The xmyConfigOP tells the OA:

• The port number to use to listen on for messages from the OM. (This port number
be greater than 5000 and less than 65000.)

• The name of the individual processes it is to manage.

• All information it needs to know about each individual process that it is to manage.

The OA relies on the Start, Stop, and Status parameters that are defined for each proce
that the OA is responsible for. 

NOTE — Each process entry contains an Autostart  
parameter. If a process’s Autostart  parameter is set to 
Yes, the OA automatically start sthat process when the 
OA starts. By default, the delivery configuration entries 
for all Telexel processes.
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15.3.3 Operability xmyOM Subcommands

The CLUI’s xmyOM  commands takes a series of subcommands that let you manage
AETG processes. Table 15-1 lists the xmyOM  subcommands and their functions. See 
Section 16.2 for complete descriptions of each subcommand. 

When a subcommand is executed, the OM takes the appropriate action.

• If the request is a query, the OM simply produces the output information.

• If the request is to start, stop, or obtain the current status of a process, the OM 
forwards the request to the appropriate OA(s) (the OA for the host machine that t
targeted process runs on).

• If the request is to reread the xmyConfigOP file (i.e., readconfig subcommand), the 
OM sends a request to all OAs defined in the xmyConfigOP file, telling each OA to 
reread the xmyConfigOP file.

This request provides a convenient method for you to get xmyConfigOP changes to 
take effect. Without this request in the OM, you would have to bring down all OA
and then restart all OAs to effect a configuration change.

• If the request is to shutdown, autostart, autostop, or recycle, the OM forwards the 
request to the OA indicated on the command-line.

Table 15-1.  xmyOM Sub-commands

Command Function

autostart Causes the OA on the specified host to start up all Autostart  processes 
defined for that OA.

autostop Causes the OA on the specified host to shut down all the Autostart  
processes defined for that OA.

query Provides information on all managed processes. 

readconfig Lets you request that all OA processes re-read the xmyConfigOP file.

recycle Shuts down and restarts all Autostart  processes on the specified host.

shutdown Terminates an OA.

stop Stops a process.

start Starts a process.

status Sends a status request to a process.
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15.4 Licensing

This section describes the commands and utilities used to control AETG licensing.

15.4.1 AETG Licensing Commands

The AETG System provides the xmyStartLS, xmyStopLS, and xmyStatusLS commands 
to let you stop and start the License server and obtain information about the status o
License server.

15.4.2 Starting the License Server

After the licensing code is installed, start the license server by typing 

xmyStartLS

while logged in to the machine that will run the server. xmyStartLS assumes that the 
license server resides in $XMYDIR/bin and that the licensing key resides in the director
$XMYHOME/config in a file called xmyLicenses. 

The license server runs in the background and does not require regular monitoring. 
problem does develop, use xmyStatusLS (see Section 15.4.4.1) to confirm that the server 
is responding properly. If not, try stopping and restarting the server, after bringing dow
licensed AETG System products. 

NOTE — The License Server can also be started or 
stopped using the xmyConfigOP file.

15.4.3 Stopping the License Server

To stop the license server, type

xmyStopLS

If problems persist after restarting the license server, contact the AETG System sup
staff for assistance.

xmyStartLS Starts the License server. xmyStartLS will look for the file 
$XMYHOME/config/xmyLicenses for the licensing keys.

xmyStopLS Stops the License server. 

xmyStatusLS Displays the key information in xmyLicenses in a readable format.
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15.4.4 License Utilities

15.4.4.1 Monitoring

The xmyStatusLS1 program provides information about the installed licenses. It has t
following syntax:

xmyStatusLS ? machine_name?

where machine_name is the name of the machine on which the server is installed. 
machine_name is optional if:

• The environment variable LSHOST is set.

• A file called LicenseServ in the current directory contains the name of the machin
running the server.

• The server runs on the local machine.

xmyStatusLS writes the information to the standard output.

xmyStatusLS provides information about all software and users that are currently licen
through xmyLicenses and all licenses in use, as in the following:

xmyStatusLS
lsmonitor for LicenseServ 3.0 Copyright (c) Viman Software

Feature Name: SCRIPTEXEC(v5.0) (floating license) No expiration date.
Concurrent licenses: 65535
Available unreserved    : 65535         In Use: 0
Available reserved      : 0     In Use: 0
Number of subnets       : 0
Site License info       : *.*.*.*
Hostid based locking

Feature Name: XMYTERMASYNC(v5.0) (floating license) No expiration date.
Concurrent licenses: 65535
Available unreserved    : 65535         In Use: 0
Available reserved      : 0     In Use: 0
Number of subnets       : 0
Site License info       : *.*.*.*
Hostid based locking

Users:
wunn            (DefaultGrp)
Host name       : ariel
X display name  : ariel:0
Shared ID name  : viman default shared id
Number of keys  : 1
Q wait time     : 10
Hold time       : 0 minute(s)

1. The xmyStatusLS program uses the lsmonitor utility from Viman Software.
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15.4.4.2 Decoding

A vendor utility called lsdecode is shipped with the AETG System in the directory 
$XMYDIR/bin. It decrypts part of the information in the file containing licensing codes
(usually xmyLicenses). If you have trouble using AETG System products after installing the 
licensing code, use lsdecode to confirm that the installed license code is correct.

The lsdecode utility has the following syntax:

lsdecode ?-s license_key_file?

where -s license_key_file is the name of the file containing the license, as in the followi
example:

lsdecode -s $XMYHOME/config/xmyLicenses

           License Decoding Utility
   Copyright (c) Viman Software 1992, 1993

Reading license codes from file: "/opt/SUNWmyn/mynah/config/xmyLicenses"

License code: "YEXSUIHFTTLFKWTTBACXT9K6TIM8PX49BKUATTMS"
Feature Name: "SCRIPTEXEC", Feature Version Number: "5.0"
Exclusive license (will override additive licenses).
Floating license with
  Server host ID: "8E" (2 least significant hex characters)
Maximum concurrent users : 65535
Vendor Info              : ""
Lifetime of keys         : 2 minute(s)
Held licenses disabled.
Shared licenses disabled.
License has no expiration.
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15.5 Starting Processes

As stated earlier, the OAs are started at host boot time. The OA has its setuid and setg
set. (This was done at installation time.) xmyOA should be owned by an AETG 
administrator. This means that when an OA starts, it changes its uid and groupid to b
same as the uid and groupid of the logid that owns xmyOA. All processes that an OA starts
will run with the same uid and groupid as the OA.

NOTE — The OA will not run as root, so if the owner of 
xmyOA is root, the OA will not come up. Normally, all 
processes will be owned by the AETG Administrator, 
madmin.

NOTE — Normally, it is recommended that all processes 
start and stop via the xmyConfigOP file and either the 
/etc/rc3.d/S99mynah file (see Section 15.8).

15.5.1 Solaris Start-up Mechanism

At start-up, Solaris looks in the /etc/init.d directory for the scripts used to start the system
Solaris then executes, in order, the start and kill process files in the rc?.d (where ? can be 
one of S or 0-6, e.g., rcS.d, rc0.d, or rc4.d) directories. Each /etc/rc[S0 - 6].d directory is 
designed for a specific function or state. For example, user-defined processes are st
/etc/rc3.d.

The file names for start processes begin with S, such as /etc/rc3.d/S99mynah. All start files 
are executed in numeric and alphabetic order, i.e., S01, then S02, etc. 

The file names for termination processes begin with K, such as /etc/rc0.d/K01mynah. All 
start files are executed in numeric and alphabetic order, i.e., K01, then K02, etc. 

15.5.2 Starting at Boot Time

An AETG start-up file, S99mynah (Section 15.8.1 and Appendix C.1.5) is delivered with 
the system. You are not required to use this file, but it is strongly recommended sinc
contains environmental settings (such as library paths, hostports, and the hostname
you will have to manually set if you do not use this file.

NOTE — Remember to edit this file so that settings 
reflect site-specific values.

If you do not use the S99mynah file but still want to start AETG processes at boot time, yo
must create your own start-up process file in the /etc/rc3.d directory on each OA host (each
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host that will run platform or application processes), and each file must contain two A
commands.

15.5.2.1 .xmyRemovePips

The first command is .xmyRemovePips. 

The .xmyRemovePips command removes “local” pip files (pip files of processes that r
on the local machine) from the run directories in the configuration. This includes the 
$XMYHOME/run/oa directory

The .xmyRemovePips command takes the following options:

The .xmyRemovePips command is run from the start-up script and should be peformed as
the AETG Adminstrator, madmin. Therefore, you should add a line such as the followin
to your start-up file:

/bin/su - madmin -c '/opt/SUNWmyn/mynah/bin/.xmyRemovePips all'

For example, if the machine is called selene, then .xmyRemovePips removes the following 
file (assuming the OA runs on selene) $XMYHOME/run/oa/pip.oa.selene.

15.5.2.2 xmyStartUp

To start the OAs at boot time, the start-up file must contain the following command a
the .xmyRemovePips command:

xmyStartUp

The OA starts those processes it is responsible for that have Autostart = yes. The OA 
simply executes the indicated Start command to start a process.

The OA then sits idle, listening on the OMPort for any incoming start, stop, status, 
readconfig, shutdown, autostop, autostart, or recycle requests.

As with .xmyRemovePips, xmyStartUp is run from the start-up script and should be 
peformed as the AETG Adminstrator, madmin. Therefore, you should add a line such a
the following to your start-up file:

/bin/su - madmin -c '${XMYDIR}/bin/xmyStartUp'

-h Provides a usage statement

-v Provides verbose output (shows what's about to be removed)

oa Remove pip file in the OA's run directory for the OA on this host

all Remove pip files for all processes that run on this host
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If all other processes are started via the xmyConfigOP file, then nothing else needs to be 
done. Otherwise see Section 15.5.3.

15.5.3 Starting a Specific Process

The start subcommand (Section 16.2.7) lets you start specific processes. The basic synt
for xmyOM start  is

xmyOM start ?-o oa_name? logical_process_name

where 

• -o oa_name specifies the name of an OA in the xmyConfigOP file.

• logical_process_name is the name of the process as it appears in the Responsibility 
list of the OA in the xmyConfigOP file

If you do not supply an OA name, xmyOM  start verifies that the logical_process_name 
appears in exactly one OA’s responsibility list.

For example, the logical_process_name xmyLS in the example xmyConfigOP file in 
Figure 14-4 specifies the start command for the License Server. Therefore, to start th
License Server, execute the following:

xmyOM start xmyLS

The OM process reads the xmyConfigOP file, sending a message to an OA, which also 
knows the contents of the xmyConfigOP file. The OA executes the command and sends
output back to the OM. The OM prints the output to the user and quits.

15.5.4 Starting Autostart Processes

The autostart subcommand (Section 16.2.1) lets you have the OA on a specific host sta
all processes for that OA that have the Autostart  = yes. The basic syntax for xmyOM 
autostart is

xmyOM autostart oa_name

where oa_name is the name of the OA whose Autostart  processes you want to start.

For example, to start all Autostart processes for the OA selene (as defined in the example
xmyConfigOP file in Figure 14-4), you would execute

xmyOM autostart selene
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15.6 Stopping Processes

15.6.1 Stopping a Specific Process

The stop subcommand (Section 16.2.7) lets you stop specific processes. The basic synt
for xmyOM stop is

xmyOM stop ?-o oa_name? logical_process_name

where 

• -o oa_name specifies the name of an OA in the xmyConfigOP file.

• logical_process_name is the name of the process as it appears in the Responsibility 
list of the OA in the xmyConfigOP file.

If you do not supply an OA name, xmyOM  start verifies that the logical_process_name 
appears in exactly one OA’s responsibility list.

For example, the logical_process_name xmyLS in the example xmyConfigOP file in 
Figure 14-4 specifies the stop command for the License Server. Therefore, to stop th
License Server, you would execute the following:

xmyOM stop xmyLS

15.6.2 Stopping Autostart Processes

The autostop subcommand (Section 16.2.2) lets you have the OA on a specific host stop
all processes for that OA that have the Autostart  = yes. The basic syntax for xmyOM 
autostop is

xmyOM autostop host_name

where host_name is the name of the host whose Autostart  processes you want to stop.

For example, to stop all Autostart  processes for the OA selene (as defined in the example
xmyConfigOP file in Figure 14-4), execute

xmyOM autostop selene

xmyOM autostop shuts down the processes in the reverse order that they were started up. 
The OA continues to run after stopping the processes.
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15.6.3 Stopping an OA and all Autostart Processes on the Local Host

The xmyShutDown command lets you gracefully terminate (stop and shut down) an O
on the local host. The basic syntax for xmyShutDown is

xmyShutDown

xmyShutDown first stops all Autostart  processes the local OA is responsible for and th
shuts down the local OA itself. This is in contrast to the autostop subcommand, which 
leaves the OA up and running.

15.6.4 Stopping an OA and all Autostart Processes on a Specific Host

The shutdown subcommand (Section 16.2.6) lets you gracefully terminate (stop and shu
down) an OA on a specific host. The basic syntax for xmyOM shutdown is

xmyOM shutdown oa_name

where oa_name is the name of an OA in the xmyConfigOP file.

As with xmyShutDown, xmyOM shutdown stops an OA and all related processes, bu
does so for a specified host. For example, to stop the OA selene, you would execute

xmyOM shutdown selene

xmyOM shutdown first stops all Autostart  processes the OA selene is responsible for and 
then shuts down the OA selene itself. This is in contrast to the autostop subcommand, 
which leaves the OA up and running.

15.6.5 Stopping an OA

In addition to xmyShutDown and xmyOM shutdown, both of which stops an OA and all
of the Autostart  processes the OA is responsible for, there is also the xmyStopOA 
command, which only stops the OA. All Autostart  processes continue running.

The basic syntax for xmyStopOA is

xmyStopOA 

xmyStopOA only takes the ?-hHR? options listed in Section 14.3.3. In order to stop the 
OA on a particular machine, you must be on that machine.
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15.6.6 Stopping and Restarting a Host

The recycle subcommand (Section 16.2.5) lets you stop and restart the Autostart  processes 
on a specific host. The basic syntax for xmyOM recycle is. xmyOM recycle 

host_name

where host_name is the name of the host whose Autostart  processes you want to stop an
restart.

This subcommand is useful to reinitialize log files that have grown very large.

For example, to stop and restart the Autostart  processes for the OA selene, execute

xmyOM recycle selene

15.7 Obtaining Information about Processes

The AETG CLUI provides several subcommands to the xmyOM command for obtain
information on the AETG processes and configuration.

15.7.1 Obtaining the Status of Processes

The status subcommand (Section 16.2.7) lets you get the status of specific processes. T
basic syntax for xmyOM status is

xmyOM status ?-o oa_name? logical_process_name

where 

• -o oa_name specifies the name of an OA in the xmyConfigOP file.

• logical_process_name specifies the name of the process as it appears in the 
Responsibility list of the OA in the xmyConfigOP file.

If you do not supply an OA name, xmyOM  start verifies that the logical_process_name 
appears in exactly one OA’s responsibility list.

For example, the logical_process_name vxLogToFile in the example xmyConfigOP file in 
Figure 14-4 specifies the status command for vxLogToFile. Therefore, to obtain the status
information vxLogToFile, execute

xmyOM Ststus vxLogToFile
 15–13



AETG System Users Guide BR 007-252-007
Operability Management — Starting and Stopping AETG Processes Issue 1, October 1997
Release 1.0   
The result takes the form

IPC Registered Processes

ID                              PID     HOST            QUEUE   USER
==                              ===     ====            =====   ====
vxLogDestFile                   28517   selene          3001    madmin

Another example would be to obtain the status information for the process vxGateway 
(which appears in Figure 14-4 in the responsibility list for the OA luna) by executing

xmyOM status -o luna vxGateway

The results take the form:

vxIpcMgr: vxErSrv00             on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000000 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000001 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000002 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000003 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000004 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000005 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000006 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000007 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000008 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000009 on luna       .. selected. no action.

15.7.2 Displaying Operability Configuration Settings

The query subcommand (Section 16.2.3) displays the configuration settings from the 
xmyConfigOP file for OAs and the managed processes. The basic syntax for 
xmyOM query is

xmyOM query ?-o oa_name  | -p logical_process_name  |-s?

where 

• -o oa_name specifies the name of an OA in the xmyConfigOP file.

• -p logical_process_name specifies the name of a process as it appears in the 
Responsibility list of the OA in the xmyConfigOP file.

• -s displays a list of all of the OAs defined in the xmyConfigOP file.

You can use only one of these options at a time, e.g., you can not use the -s option with the 
-o oa_name option. 

For example, to see what OAs are defined in your installation, execute

xmyOM query -s

which generates output of the form:

selene
luna
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Then, if you wanted to see what processes the OA selene is responsible for, execute

xmyOM query -o selene

which generates output of the form:

The OA on selene is responsible for the following processes:
vxIpcDir
vxGateway
vxIpcClean
vxLogToFile
vxErrorServer

If you do not specify any options, xmyOM query lists the defined OAs in your 
configuration and the processes that appear in the Responsibility lists for those OAs in the 
xmyConfigOP file. This is equivalent to executing xmyOM query -s followed by 
xmyOM query -o oa_name, except that instead of seeing the defined processes for one
only, you would see the defined processes for all OAs in the system.

For example, if you type

xmyOM query

and you have defined the OAs selene and luna, you would see output of the form:

------------------------------------------------------------
The OA on selene is responsible for the following processes:
vxGateway
------------------------------------------------------------
The OA on luna is responsible for the following processes:
vxIpcDir
vxGateway
vxIpcClean
vxLogToFile
xmyCollector
vxErrorServer
------------------------------------------------------------

To see settings for the process vxIpcDir , execute

xmyOM query -p vxIpcDir

which generates output of the form:

Process      : vxIpcDir
StartCommand : /opt/SUNWmyn/mynah/bin/.xmyStartup
StopCommand  : vxIpcDown -d
StatusCommand: vxIpcProcesses
Autostart    : Yes
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15.8 Starting and Stopping AETG Software Packages

After installation, the $XMYDIR/examples/admin/scripts directory contains a start-up 
script for the various AETG software packages, e.g., S99mynah.eg. 

To start these packages when the system is booted, copy this file from the 
$XMYDIR/examples/admin/scripts directory to the /etc/rc3.d directory. 

If you want the software packages to terminate correctly when the system is rebooted
can create logical links from the files in the /etc/rc3.d directory to the /etc/rc0.d directory, 
preappending the link with the kill prefix, K.

NOTE — The owner of the start files (and the terminating 
links) must be root, and you must set the permissions on 
these files (and links) to 755.

15.8.1 Automatically Starting the AETG System

To automatically start-up the AETG and Telexel processes at boot time, perform the
following tasks:

1. Copy the example start-up file S99mynah.eg from the 
$XMYDIR/examples/admin/scripts directory to the /etc/rc3.d directory and rename the
copy S99mynah.

NOTE — See AppendixC.1.5 for a copy of 
S99mynah.eg.

2. Edit S99mynah for library paths, hostport, hostname, etc.

3. Create a logical link to S99mynah in /etc/rc0.d to terminate the AETG processes 
correctly at reboot time, e.g., 

cd /etc/rc0.d

ln -s /etc/rc3.d/S99mynah K01mynah

15.8.2 Automatically Starting Oracle

To automatically start-up the Oracle processes on a client machine at boot time, perform 
the following tasks:

1. Copy the example start-up file S96oracle.eg from the 
$XMYDIR/examples/admin/scripts directory to the /etc/rc3.d directory and rename the
copy S96oracle.
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NOTE — See AppendixC.3.1 for a copy of 
S96oracle.eg.

2. Edit the S96oracle file to correct directories and paths, etc.

3. Create a logical link to S96oracle in /etc/rc0.d to terminate the Oracle processes 
correctly at reboot time, e.g., 

cd /etc/rc0.d

ln -s /etc/rc3.d/S96oracle K02oracle

4. It is recommended that you change the shutdown command in 
/opt/SUNWora/oracle/bin/dbshut from shutdown to shutdown immediate.

15.9 User Defined Processes

If users want to add their own processes to the xmyConfigOP file, their start, stop, and status
commands must follow these rules:

• They must exit with a 0 return code upon success.

• They must exit with a non-zero on failure. Any output to standard out or standard ror 
will be included in the reply to the OM from the OA that ran this command.

• These commands must exit after performing their task. That is, when starting up
process, they must exit when that process is “up” and running by whatever defin
makes sense for that process. They can not stay around or the OA will hang, waiting
for a response from the command in terms of its exit.
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15.10 Operability Summary

An administrative user needs to be able to start, stop, or determine the status of any 
application process, and any platform process that a AETG application process relies
The operability design allows a user, from a single user interface and a single host machine, 
to perform this function. 

The flexibility of the configuration portion of the operability design allows the AETG 
Administrator to add new types of managed processes as the need arises.

Only one process for each host needs to be explicitly started at boot time, the OA process. 
The OA process will start everything else that should be started at boot time.

The Operability feature is summarized in Figure 15-2.  

Figure 15-2.  Operability Feature Summary

OM

vxIpcDir
vxIpcGw

LogToFile

.

OA

User Interface for
Start, Stop and Status

Error Server

Operability Interface

Application Interface (not part of Operability)
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16. Administrative CLUI Commands

This section describes the Administrative Command Line User Interface (CLUI) 
commands. Administrative CLUI commands are only available to the AETG user who
administrative privileges, e.g., madmin. All other CLUI commands are available to all 
AETG users.

16.1 CLUI Command Help Messages

All CLUI commands and subcommands have an -h option that displays a brief help 
message listing the usage and syntax of the subcommand. For example

xmyOM query -h 
query: display info about the AETG configuration
Usage: xmyOM query [-h] [-p<process_name> | -o<oa_name> | -s ]

-h               :  display this message
-p<process_name> :  process name as in config file
-o<oa_name>      :  Operability Agent name as in config file
-s               :  List all systems (OAs) defined in xmyConfigOP

In addition, each main command has an -h option to tell you what subcommands exist fo
the command, for example

xmyOM -h
Usage:

xmyOM command_name command_args
The command_args depend on which command_name you use.
To obtain usage information on an individual command_name,
simply type:

xmyOM command_name -h
Here is a list of all the valid xmyOM command_names and a brief
description of what they do:

start      - start a platform/application process
stop       - stop a platform/application process
status     - display status of platform/application process
query      - display AETG configuration
readconfig - request OA to re-read the configuration file
autostop   - request OA to bring down all autostart processes
autostart  - request OA to start up all autostart processes
recycle    - request OA to re-cycle (bring down then up)autostart proc's
shutdown   - stop OA (brings down all autostart processes too)
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16.2 xmyOM

The xmyOM command subcommands can be used to control and administer the plat
and application processes that constitute the AETG System. These subcommands a
implemented as part of the Operability Manager (OM), which is discussed in Section 15.

A user, at any point in time, can invoke the xmyOM  command from any machine in the 
network.

16.2.1 autostart

Syntax

xmyOM autostart host_name

Description

The autostart subcommand causes the OA on the specified host (host_name) to start 
up all autostart processes defined for that OA, i.e., all processes in that OA's 
responsibility list whose Autostart  entry is set to yes.

Example

xmyOM autostart selene
16–2  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Administrative CLUI Commands
  Release 1.0

 

16.2.2 autostop

Syntax

xmyOM autostop host_name

Description

The autostop subcommand causes the OA on the specified host (host_name) to shut 
down all the autostart processes defined for that OA. It shuts them down in the reverse
order from which they were started up, however, the OA continues to run after shutting 
them down. This distinguishes the autostop subcommand from the shutdown 
subcommand in that with the shutdown subcommand, not only does the OA shut 
down all its autostart processes, but it also shuts itself down.

Example

xmyOM autostop selene
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16.2.3 query

Syntax

xmyOM query ?-o oa_name  | -p logical_process_name ? | -s?

Description

The query subcommand displays configuration file entries (from the xmyConfigOP 
file) for OAs and the managed processes.

query takes the following options: 

If no option is used, then all OA entries in the configuration file are displayed.

Example

xmyOM query -o mimir
The OA on mimir is responsible for the following processes:
vxGateway
vxIpcClean

-o oa_name Displays the processes the entered Operability Age
(OA) is responsible for. (See Section 15.3.2 for 
information on OAs.)

-p logical_process_name Displays information for the entered process as 
defined in the xmyConfigOP file.

-s Displays a list of all OAs (i.e., all hosts) defined in 
the xmyConfigOP file.
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16.2.4 readconfig

Syntax

xmyOM readconfig

Description

The readconfig subcommand instructs the OAs on all hosts to read the configura
file. readconfig should be used only if some changes have been made to the 
xmyConfigOP file. The OM broadcasts readconfig to all the OAs in the AETG 
configuration.

Example

xmyOM readconfig
OA(selene): config file read
OA(mimir): config file read
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16.2.5 recycle

Syntax

xmyOM recycle host_name

Description

The recycle subcommand shuts down and restarts all Autostart processes on the
specified host (host_name). This is identical to an xmyOM autostop host_name 
followed by an xmyOM autostart  host_name.

Example

xmyOM recycle selene
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16.2.6 shutdown

Syntax

xmyOM shutdown oa_name

Description

The shutdown subcommand gracefully terminates an OA. The OA first stops all 
autostart processes it is responsible for, terminating them in the reverse order from 
which they were brought up. Lastly, the OA shuts itself down.

If you want to bring only the OA and not the Autostart processess down, you must b
logged into the OA’s machine and then use the xmyStopOA command. This will only 
work if you are root or the person who started the OA, usually madmin.

oa_name is the name of the OA as it appears in the xmyConfigOP file.
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16.2.7 start/stop/status

Syntax

xmyOM start ?-o oa_name? logical_process_name
xmyOM stop ?-o oa_name? logical_process_name
xmyOM status ?-o oa_name? logical_process_name

Description

These subcommands can be used to start, stop, or get the status of the application or 
platform processes. The application or platform processes on which these 
subcommands operate must be present in the responsibility list of at least one OA in 
the xmyConfigOP file. 

logical_process_name is the name of the process as it appears in the responsibility list 
of the OA in the xmyConfigOP file.

If -o oa_name is not supplied, xmyOM  verifies that the logical_process_name 
appears in exactly one OA’s responsibility list and forwards the request to the OA. I
-o oa_name is supplied, xmyOM  makes sure that the logical_process_name appears 
in that OA’s responsibility list and forwards the request to that OA.

Example

xmyOM status -o cardinals vxGateway 
vxIpcMgr: vxErSrv00             on selene     .. selected. no action.
vxIpcMgr: vxErrMessageClient0000000 on selene     .. selected. no action.
vxIpcMgr: vxErrMessageClient0000001 on selene     .. selected. no action.
vxIpcMgr: vxErrMessageClient0000002 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000003 on cardinals  .. selected. no action.
vxIpcMgr: vxErrMessageClient0000004 on cardinals  .. selected. no action.
vxIpcMgr: vxErrMessageClient0000005 on cardinals  .. selected. no action.
vxIpcMgr: vxErrMessageClient0000006 on luna       .. selected. no action.
vxIpcMgr: vxErrMessageClient0000007 on yankees    .. selected. no action.
vxIpcMgr: vxErrorServer         on selene     .. selected. no action.
vxIpcMgr: vxLogDestFile         on selene     .. selected. no action.
vxIpcMgr: xmyBDcardinals        on cardinals  .. selected. no action.
vxIpcMgr: xmyBDluna             on luna       .. selected. no action.
vxIpcMgr: xmyBDselene           on selene     .. selected. no action.
vxIpcMgr: xmySDSD1              on selene     .. selected. no action.
vxIpcMgr: xmySDa                on cardinals  .. selected. no action.
vxIpcMgr: xmySE0000SD1          on luna       .. selected. no action.
vxIpcMgr: xmySE0000a            on cardinals  .. selected. no action.
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17. Person Object

The Person object is a AETG GUI object that lets an AETG Administrator control the
AETG database settings for the AETG users. These functions include creating Perso
objects and assigning Inactive  status to a user.

A Person object must exist in the database for each AETG user. A Person object is c
in one of two ways: 

• If you set the Welcome New Users parameter in the xmyConfig.General file to yes 
(see Section 14.2), the GUI automatically creates a Person object when a new us
starts the GUI. In fact, if the Welcome New Users parameter is set to no, the GUI 
exits.

Therefore, setting the Welcome New Users parameter to no lets you prevent 
nonauthorized users from using the AETG GUI.

• You can create a Person object in the GUI before the new user starts the GUI. T
way, if you set the Welcome New Users parameter to no (e.g., to limit the number of 
new users) you can create a Person object for a specific user before she/he sta
GUI.

NOTE — There can be only one Person object in the 
database per UNIX ID. 

AETG users can edit their general properties attributes (i.e., their name, phone number, an
e-mail address) and the keywords associated with their Person object only. As a AE
Administrator, however, you can change these attributes for other users. In addition, you 
can edit the authority attribute for other users.

NOTE — While users can create untitled Person objects 
on the AETG Desktop, they cannot edit or save these 
Person objects. AETG uers can, however, access the 
Person objects for all AETG users and edit their own 
Person object from the Database Browser.
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17.1 Creating a Person Object

In the AETG Desktop, execute

AETG->New ->Person  

as shown in Figure 17-1. 

17.1.1 Editing Properties Attributes

Once you’ve created a Person object, you can enter user information. 

1. Open the new Person object by performing either of the following:

• Double clicking on the Person object icon 

• Selecting the icon and then executing

Selected->Open  

An empty Person object opens. By default, the Person object opens in the Prop
View (Figure 17-2).

Figure 17-1.  Creating a New Person Object
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2. Unlock the Person object.

NOTE — An AETG user can only unlock his or her own 
Person object. An AETG Administrator can unlock (and 
edit) any AETG user’s Person object.

3. Enter the user’s UNIX ID, name, e-mail address, and phone number. As an AETG 
Administrator, you can also set the user’s authority level by selecting one of the t
following options in the Authority  list:

Figure 17-2.  New Person Object Properties View

Administrator This gives administrative privileges to a user. An administrative
user can grant other users Administrator Authority. In addition, 
Administrator can edit the attributes of other users.

Inactive This gives a user inactive status, meaning that the user can no
longer access the AETG System. The Person object remains in
database. If you want to reactivate a user, use the Database 
Browser to grant the user either Administrator or User Authority

NOTE — You cannot cut a Person object from the database. 
Giving a Person object inactive status is the only way of removi
AETG privileges for a user, e.g., if a user leaves.
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Figure 17-3 shows an example of an edited Person object Properties View. 

The Person object is not added to the database until you save it. Execute 

Person->Save

The window exits Edit Mode. The Authority  field is grayed out.

At a minimum, you must enter the User ID for a new Person object. You can then

• Fill in the rest of the fields on the Properties view.

• Save the object.

• Close the window by executing 

Person->Close 

(The system asks you if you want to save your changes if you have not already 
so.)

• Change to the Information View to edit Keyword associations for the Person obj

User This gives the user the standard User Authority, such as when you 
are removing administrative privileges. Someone with User 
Authority can edit her/his attributes, but cannot change their 
Authority. In addition, someone with User Authority can view but 
cannot edit the Person objects for other users.

Figure 17-3.  Edited Person Object Properties View
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There can be only one Person object in the database per UNIX ID. If you try adding 
Person object with a UNIX ID that already has a Person object, the error dialog box 
Figure 17-4 appears. 

If you’ve edited a Person object and then try closing it without first saving it, the dialog
in Figure 17-5 appears. 

• If you click on Yes, your changes are saved and the Person object window closes.

• If you click on No, your changes are discarded and the Person object window clo

• If you click on Cancel , the Person object window remains open.

Figure 17-4.  Duplicate UNIX ID Error Box

Figure 17-5.  Close Dialog Box
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17.1.2 Editing Information Attributes

The Person object Information view (Figure 17-6) lets you enter comments regarding the
Person object. 

NOTE — The Keywords parameter is not supported by 
the AETG System.

17.2 Editing an Existing Person Object

As a AETG Administrator, you can edit Person objects for other users. Your main reason 
for editing a user’s Person object is to change their Authority, e.g., to grant or remov
administrative privileges.

WARNING — You can remove administrative privileges 
for all users, including yourself.

While you can create Person objects in your AETG window, all Person objects for a A
installation are listed in the Database Browser. In fact, if the Welcome New Users 
parameter in the xmyConfig.General file is set to yes, the resulting Person objects can be
found only in the Database Browser. Therefore, you will most often want to edit a use
Person object from the Database Browser. 

Figure 17-6.  Person Object Information View
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In our example, if you wish to apply inactive status to a user who was added automati
follow these steps.

1. Execute 

Tools->Database Browser 

If the list of Person objects is not visible when the Browser appears, select Person  
from the Database object menu to access the list of Person objects (Figure 17-7). 

2. Open the Person object you want to edit. You can do this by either

• Clicking on the row listing the object and executing 

Selected->Open  

• Double clicking on the row listing the object.

Figure 17-7.  Database Browser - List of Person Objects
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3. When the Person objects opens, unlock the window, and select the Inactive  option 
from the Authority  list (Figure 17-8). 

4. Save and close the object. 

5. If you look at the Database Browser, you will not see any change in the Authority
the Person object. To view the change, execute

View->Refresh 

The Database Browser is redisplayed, and you will see that the user is now liste
Inactive (See Figure 17-9).  

Figure 17-8.  Edited Person Object — Granting Administrative Privileges
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Figure 17-9.  Refreshed Database Browser
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Appendix A: Using the AETG System with the MYNAH 
System

The AETG System can be licensed with the MYNAH System, letting you generate script 
code that executes your test cases.

In this configuration, the AETG System is full integrated into the MYNAH System, an
you see several changes to the GUI. This Appendix describes the changes you enco

A.1 Related Documentation

The following documents are available, detailing the use of the MYNAH System:

• BR 007-252-005, MYNAH System Administration Guide

• BR 007-252-006, MYNAH System Users Guide

• BR 007-252-008, MYNAH System Scripting Guide
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A.2 Changes to Format Objects

The Keywords and SUTs parameters on the Format object Associations view (Figure A-1) 
are enabled, letting you create associations to these object. 

NOTE — See the MYNAH System Users Guide for 
information Keywords and SUTs and on how to associate 
an object with another object.

Format objects can be associated with SUT objects to indicate that the defined Form
valid for that particular version of the System Under Test. 

More than one Format can be associated with one SUT. You can associate all of the
Formats that are valid with a particular SUT.

One Format can be associated with more then one SUT. You may want to do this w
Format does not change from one SUT to the next. In that case, you may associate 
Format with the new SUT.

If a Format changes however (e.g., a new Field is added), you would create a new v
of the Format by executing

Selected ->Duplicate

and associating the new Format with the appropriate SUT. 

Figure A-1.  Format Object Associations View
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A.3 Changes to SUT Objects

The following changes occur when you work with SUT objects.

The Formats parameter on the SUT object Associations view (Figure A-2) is enable, 
displaying what Formats are associated with this SUT. 

Figure A-2.  SUT Object Associations View
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A.4 Changes to Keyword Objects

The Formats parameter on the Keyword object Associations view is enable, displayi
what Formats are associated with this Keyword (Figure A-3). 

Figure A-3.  Keyword Object Association View
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Appendix B: Generate Tcl Scripts for AETG Testcases

If you license the AETG System with the MYNAH System, you can automate test case
directly reading the Test Case Matrix file from a Tcl script using standard TclX keyed
commands. 

NOTE — See the MYNAH System Scripting Guide for 
information on Tcl and TclX keyed lists.

However, you may want to have the MYNAH System generate the automation code.
section describes the MYNAH script generation process.

B.1 Test Object Script Generation View

The Test object Script Generation view (Figure B-1) lets you specify the parameters the 
MYNAH System uses to generate a script that automates the test cases in the Test 
view (Section 9.3.3). 

Figure B-1.  Test Object Script Generation View
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The Script Generation view contains the following parameters:

Tcl Procedure Names Lets you enter the names of Tcl procedures that will use the t
case matrix to create your testing script.

Note —  You must provide a Body procedure. The Setup and
Cleanup procedures are optional.

Setup The name of the user provided procedure that will bring th
SUT to the appropriate state to accept input. In addition
this procedure should perform any other necessary setu
operations.

One setup operation the Setup procedure must perform is 
setting the actual values for nonliteral values. The Setup 
procedure will always be passed the name of an array t
must contain the actual values for the non-literal values
For example a Setup procedure might contain the line

set arr(daynum) 555-1212

where daynum is a nonliteral value and 555-1212 is the 
actual value

Body The name of the user provided procedure that consitutes 
the body of the Tcl script. This procdure performs the 
following functions when given an input list:

• Builds the input 

• Sends the input to the SUT

• Captures the value in the Validation Field

• Reinitializes to the input state

• Returns the captured validation value.

Cleanup Name of the user written procedure that performs all 
cleanup operations, for example, logging off of the SUT

Validation Lets you enter strings and Field names that will be used to 
determine if a test case is valid or invalid.

Valids Field The SUT field name that contains the information that wi
indicate the success or failure of a valid test case.
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When you execute 

Test->Script Generate 

the MYNAH System creates Tcl code that

1. Calls the Setup procedure once

2. Calls the Body procedures for each test case

3. Calls the Cleanup procedure.

The code also contains xmyBegin and xmyEnd statements for the Test object so that 
labeled compare statements can be used for the validation steps. If you enable Code 
Compares, the MYNAH System generates a labeled compare for each test case in the
Matrix, using the TC Name as the label.

All valid test cases are generated first, then the invalid test cases are generated.

Invalids Field The SUT field name that contains the information that wi
indicate the success or failure of an invalid test case. 

Note —  This may be the same as the Valids Field entry b
it also may be different.

Valids String The value that the validation field should contain if the 
valid test case is successful. This string is passed to the
Body procedure. This string is also used in the 
automatically generated compare statement.

Invalids String The value that the validation field should contain if the 
invalid test case is successful. This string is passed to t
Body procedure. This string is also used in the 
automatically generated compare statement.

Pass Parameters Lets you specify if the value(s) of the Field object’s Parameters  
attribute (Section 7.2.1.2) should be included in the Field data in
the generated script.

Code Compares Lets you specify if the generated code should contain an 
xmyCompare statement for each test case. 

If the xmyCompare statements are generated, it is assumed th
the Body procedure sets a variable called result. This variable is 
compared to the Validation String. The result of the compare 
will be recorded in the Result object for the Test and will be 
“labeled” with the test case name.
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B.2 Example

Assume you are generating a test case with the following:

• You have a Test Matrix with the following two test cases:

• The following procedures are in a procedure library:

proc phone_setup {upArr} {
upvar $upArr arr
set arr(daynum) 555-1212
set arr(evenum) 555-1212
logon

}

proc phone_body {upList} {
upvar $upList localList
# build, enter, and get result string
keylset localList result “[join [$conn1 screen \

-label “Info” -dimension {3 1}]]”
}

proc cleanup { } {
logoff

}

• Disable the Pass Parameters  parameter.

• Enable the Code Compares  parameter.

Testcase Type eveAC eveNum dayAC dayNum

V-0 V 908 evenum 917 daynum

I-0 I 201 evenum 609 daynum
B–4  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Generate Tcl Scripts for AETG Testcases
  Release 1.0
The Script Generation view will appear as in Figure B-2. 

Figure B-2.  Edited Script Generation view
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When you execute 

Test->Script Generate 

the code in Figure B-3 will be created. 

After running this script, there will be one Result object for the Test with testid of 1. T
Result object will contain the results of the two labeled compares, one for V-0 and one for 
I-0. 

Figure B-3.  Sample Generated Script Code

l user-defined Setup procedure 

 data

t begins

egin -testid 2389

tcase: V-0

et list tcName V-0 tcType V expectField info
et list expectString “transaction processed”
et list fields.dayAC.value 908 fields.dayNum.value $data(daynum)
et list fields.eveAC.value 917 fields.eveNum.value $data(evenum)
list
s ““
et list result res
ompare -expr {$res == [keylget list expectString]} -label V-0

tcase: I-0

et list tcName I-0 tcType I expectField info
et list expectString “transaction error”
et list fields.dayAC.value 201 fields.dayNum.value $data(daynum)
et list fields.eveAC.value 609 fields.eveNum.value $data(evenum)
list
s ““
et list result res
ompare -expr {$res == [keylget list expectString]} -label I-0

t complete

nd -testid 2389

l user-defined Cleanup procedure

up

- The Setup Procedure i
an array called data as an
argument.

- The overall Test begin

- The testcase name is p
the comment

- A list is constructed th
contains the info for the
testcase

- The Body procedure is
with the list as an argum
- The result is analyzed

- Everything is repeated
second testcase

- The overall test ends

- The Cleanup procedur
called
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B.2.1 Effects of Code Compares

If you change the Code Compares  parameter to No, the resulting script code would not 
contain the lines

set res ““
keylget list result res
xmyCompare -expr {$res == [keylget list expectString]} 

-label V-0

for any of the test cases. In this case, it is assumed that the Body procedure will perform the 
validation.

B.2.2 Effects of Pass Parameters

The Parameters  parameter on the Field object Values view (Figure 7-1) lets you can 
specify a list of parameters that provide more information about the Field ont. For exam
you might enter Row=1, Col=1 indicating that this Field is in the upper left hand corner o
a screen.

The Parameters  parameter is free form text so it may be used in any way you desire.

You can specify on the Test object GenScript view whether Parameters attribute 
information is passed to an automation script along with the Field name and Value. 

If you set the Pass Parameters  parameterto Yes, Parameters  parameter information is 
passed to the automation script along with the Field name and Value. The generated
includes the Field Parameter information for each involved field. For example,

keylset list fields.dayAC.value 908 fields.dayAC.parms “0,0”
keylset list fields.eveAC.value 917 fields.eveAC.parms “0,1”

where the fields.<fieldname>.parms entry (e.g., fields.dayAC.parms) contains the value of 
the Parameters attribute of the specific Field object. In the example code, the numbe
might represent offset values for where the Body procedure is to type into a field on 
screen.

The Body procedure would be written to make use of the parameter information. 

B.3 Generate Script Processing

When you execute 

Test->Script Generate 

the Script Generate Confirm Dialog (Figure B-4) appears so that the you can indicate whe
you would like to place the code. 
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If a Script object is already associated with the Test, you can choose to overwrite the S
object’s code, or create a new Script object.

When you click on Ok, the choosen Script object is opened and the generated code is p
in the Code view. You can save the Script object or close the Script object without sa
changes. 

NOTE — If this is a new Script object, you must provide 
a Name and Filename prior to saving the Script object.

B.4 Using Script Generation

Script generation can be performed for the entire Test Matrix. However, it can also b
performed on any subset of the test cases in the Test Matrix. This is done by first 
highlighting the desired test cases and executing

Test->Generate Script

There are several potential circumstances under which it would be desirable to gene
script for a subset of the test cases.

B.4.1 Automation Considerations

There may be a large number of test cases in the Test Matrix and it would be inefficie
generate a single script that automates all of them. In this case, a subset could be s
and new script code could be generated. The new Script object could be associated
different Test object that indicates the general category, if any, of the selected sub-s

Figure B-4.  Script Generate Confirm Dialog
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B.4.2 Debugging Procedure Code

You may want to test the Setup, Body, and Cleanup procedures and the generated scrip
code by generating one or two test cases. Again, you can highlighting one or two test
and execute

Test->Generate Script 

The resulting script code could be loaded into the Script Builder and run. 

Once satisfied that the procedures and generated script code work well together, you 
generate code for all of the test cases in the matrix.

B.4.3 Analyzing Failures

Generated script code may contain code for a large number of test cases. If, after an
execution of the script, you can see that one or more of the test cases have failed, yo
wish to rerun just these test cases.

You can do this by highlighting the test cases of interest and executing

Test->Generate Script 

You would choose Create New Script Object  on the Script Generate Confirm Dialog 
(Figure B-4) because there is only a temporary need for this code. You could then load th
new Script code into the Script Builder and run the code until it finds a failed compar
 B–9



AETG System Users Guide BR 007-252-007
Generate Tcl Scripts for AETG Testcases Issue 1, October 1997
Release 1.0   
B–10  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Example Installation Files
  Release 1.0

 files 
Appendix C: Example Installation Files

This appendix contains examples of start-up scripts and example profile and system
mentioned in Section 13.

C.1 Example AETG System Files

C.1.1 Example AETG Installation Session

This is an example BAIST installation session of the AETG System software. 

  __________________________________________________________________________
  |                                                                          |
  |              Bellcore Application Installation Setup Tool                |
  |              -        -           -            -     -                   |
  |                                 BAIST 2.1                                |
  |                                                                          |
  |           COPYRIGHT  (c) 1996 Bell Communications Research Inc.,         |
  |                         All Rights Reserved.                             |
  |                                                                          |
  |            PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.           |
  |                                                                          |
  |                                                                          |
  |                   A UNIX Packaging and Installation Tool                 |
  |                                                                          |
  |                      For further information on BAIST                    |
  |                      Contact:  Raymond C. Gray                           |
  |                                BAIST Project Manager                     |
  |                                (908)699-7960                             |
  |                                                                          |
  |                                                                          |
  |__________________________________________________________________________|
  
                               Please Wait ...
WARNING: You are using LOCAL BCRDB
********* BAIST Installation Tool Release 2.1 *********
Initializing.  Please wait.
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               BAIST 2.1 FLOW CONTROL
                    PRODUCT MENU
                        Archived Products List

                         1) AETG 1.0
                         2) AETG UPDATES
                         3) TELEXEL 7.0

                         I) Installed Products
                         R) Registered Products
                         E) Exit

                 Enter your Selection: 1
Load AETG? [Y]: y
Extracting Application Profile

Getting the name of PRODUCT_HOME dir

Where should the AETG directory be created ?
Enter a full pathname starting with /, or q to Quit processing
: /opt/SUNWmyn
Getting the name of RELEASE_HOME dir
Making the PRODUCT_HOME dir
Making the RELEASE_HOME dir

Who should own the AETG application ?
Enter a valid login name  : madmin

Running PRELOAD script

Extracting the AETG application
Please wait. This may take a while ...
100226 of 100226 blocks loaded 100% COMPLETED 

Running POSTLOAD script

Where should XMYHOME be installed? [/opt/SUNWmyn/mynah/releases/aetg_home]
/u/sol/XmyHome
is /u/sol/XmyHome correct yes/no:
yes
Remember to:

1) edit /u/sol/XmyHome/config/xmyProfile
        edit port number
        edit LSHOST machine name
        edit ORACLE server machine name (if using ORACLE)
        edit vxIpcDirectory machine name

   add . /u/sol/XmyHome/xmyProfile to user profiles

2) export your DISPLAY variable
   export DISPLAY=machine:0.0
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Product AETG AETG_1.0 loaded successfully

               BAIST 2.1 FLOW CONTROL
                    PRODUCT MENU
                        Archived Products List

                         1) AETG 1.0
                         2) AETG UPDATES
                         3) TELEXEL 7.0

                         I) Installed Products
                         R) Registered Products
                         E) Exit

                 Enter your Selection: E
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C.1.2 Example System Changes File

This file contains changes that should be added to the /etc/system file. 

Once the changes have been made, type

reboot -- -rt

to reboot the system. The system will be reconfigured with the changes to /etc/system 
incorporated in the kernel. You must do this as root on each system running a AETG 
component or on the ORACLE server.

set maxusers=128
set pt_cnt=60
# Settings for Message Queue parameters
# MSGMNI : # of messaage queue identifiers
# MSGTQL : # of system message headers
# MSGMAP : # of entries in message map
# MSGSSZ : segment size of message
# MSGMNB : maximum bytes on queue
# MSGMAX : maximum messaage size
# MSGSEG : # of message segments
set msgsys:msginfo_msgmni=800
set msgsys:msginfo_msgtql=2000
set msgsys:msginfo_msgmap=1600
set msgsys:msginfo_msgssz=64
set msgsys:msginfo_msgmnb=65535
set msgsys:msginfo_msgmax=65535
set msgsys:msginfo_msgseg=16384
# Settings for Shared Memory parameters
# SHMSEG : segments per process
# SHMMAX : maximum shared memory segment size
# SHMMNI : # shared memory identifiers
set shmsys:shminfo_shmseg=20
set shmsys:shminfo_shmmax=234881024
set shmsys:shminfo_shmmni=300
# Settings for Semaphore parameters
# SEMMNS : # of semaphores in system
# SEMMNI : # of semaphores identifiers
# SEMMNU : # of "undo" in system
# SEMUME :
# SEMMAP :
set semsys:seminfo_semmns=7500
set semsys:seminfo_semmni=300
set semsys:seminfo_semmnu=300
set semsys:seminfo_semume=20
set semsys:seminfo_semmap=300
#
set s_xxx:max_ccbs=16
set s_xxx:x29_default=1
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C.1.3 Example AETG xmyProfile File 

This is an example of the ksh  xmyProfile files as it appears immediately following 
installation of the AETG software. 

You must make the following changes to this file to reflect your environment:

• Update the directories may need to be updated  

• Replace <hostname>  with the actual machine names 

NOTE — For the oracleservername entry, which is the 
name of your system running Oracle, this may or may not 
be the same as the system machine on which you installed 
the AETG System software.

• Replace <port>  with the actual Telexel port (ex. 22100)

After you have made the necessary changes to this file it can be sourced into the .profile 
files for all AETG users.

# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
#
# @(#)xmyProfile.eg52.3
# created on 97/10/07 at 15:37:52

#
# @(#)sample profile for madmin 96/06/11 SOL
#

# This is an example of a MYNAH System profile that
# can be sourced into MYNAH user's profiles to give
# them access to the system.
#

#
# XMYDIR is the path to a directory which is symbolically linked to
# the current release of MYNAH, e.g.,
# ln -s /opt/XXXXmyn/MYNAH/releases/MYNAH_5.0 /opt/XXXXmyn/mynah
#
XMYDIR=/opt/XXXXmyn/mynah

#
# XMYHOME is the path to a directory which is the MYNAH run environment
#
XMYHOME=/opt/XXXXmyn/mynah
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#
# create or append to LD_LIBRARY_PATH/SHLIB_PATH
#
if test -n "${LD_LIBRARY_PATH}"
then

LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${XMYDIR}/lib:/usr/openwin/lib
else

LD_LIBRARY_PATH=${XMYDIR}/lib:/usr/openwin/lib
fi

if test -n "${SHLIB_PATH}"
then

SHLIB_PATH=${SHLIB_PATH}:${XMYDIR}/lib
else

SHLIB_PATH=${XMYDIR}/lib
fi

#
# create or append to MANPATH
#
if test -n "${MANPATH}"
then

MANPATH=${MANPATH}:${XMYDIR}/man
else

MANPATH=${XMYDIR}/man
fi

PATH=${PATH}:${XMYDIR}/bin

TCL_LIBRARY=${XMYDIR}/lib/tcl
TCLX_LIBRARY=${XMYDIR}/lib/tcl

export XMYDIR XMYHOME LD_LIBRARY_PATH SHLIB_PATH PATH TCL_LIBRARY 
TCLX_LIBRARY

#
# The host name that the MYNAH license server runs on
#
LSHOST=<hostname>
export LSHOST

#
# Required Telexel variables.
#
# 1) Verify the host name for the environment variable
#    vxIpcDirectory.
# 2) Verify that vxIpcPort is a valid, unused port number.
# a) Valid numbers are in the range 1024 and 65000.
# b) If port number is already in use you will get an error
# message similiar to "address already in use".  The command
# netstat will show port numbers currently in use.  The file
# /etc/services shows well known used ports.
# 3) If /opt/XXXXtel/telexel is not where you installed Telexel, update
#    the environment variable TELDIR to the correct location.
#

vxIpcDirectory=<hostname>
C–6  



BR 007-252-007 AETG System Users Guide
Issue 1, October 1997 Example Installation Files
  Release 1.0
vxIpcPort=<port>
TELDIR=/opt/XXXXtel/telexel
PATH=${PATH}:${TELDIR}/bin

#
# append to LD_LIBRARY_PATH/SHLIB_PATH
#
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TELDIR}/lib
SHLIB_PATH=${SHLIB_PATH}:${TELDIR}/lib

#
# append to MANPATH
#
MANPATH=${MANPATH}:${TELDIR}/man

export vxIpcDirectory vxIpcPort TELDIR LD_LIBRARY_PATH SHLIB_PATH PATH 
MANPATH

#
# If Oracle is being used with MYNAH uncomment the following 3 statements,
# however, leave the last 2 statements of the following 3 statements
# commented if Oracle and MYNAH are installated on the same machine.
#
#oracleservername=<hostname>
#TWO_TASK=mynah5
#export TWO_TASK

#
# If ORACLE is being used with MYNAH uncomment the following statements.
# Verify and correct if necessary that ORACLE_HOME is being set to the
# correct path.  TNS_ADMIN must only be set if the TNS Listener files
# installed during the Oracle installation are not installed in one of
# locations that are searched automaticately by Oracle.
#

#ORACLE_HOME=/opt/XXXXora/7.3.2.3
#ORACLE_TERM=sun5
#PATH=${PATH}:${ORACLE_HOME}/bin
#export PATH ORACLE_HOME ORACLE_TERM
#export EPC_DISABLE=TRUE

#export TNS_ADMIN=${ORACLE_HOME}/network/admin
#
# If TOPCOM is being used uncomment the following and update
# /opt/XXXXtop/topcom is not where TOPCOM is installed
#
# TOPCOM=/opt/XXXXtop/topcom
# TBIN=${TOPCOM}/bin
# ETCPATH=/usr/public/isode/etc
# PATH=$PATH:${TBIN}
# export TOPCOM TBIN PATH ETCPATH

#
# If I/O Concepts is being used uncomment the following statement and
# update /opt/XXXXioc/ioconcepts if this is not where I/O Concepts is
# installed. Also set IOCLM_HOST to be the name of the host name on
# which is I/O Concepts license server runs.
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#
# LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:/usr/dt/lib
# IOCLM_HOST=<hostname>
# export LD_LIBRARY_PATH IOCLM_HOST

#
#
# optional command line editor enable
#
EDITOR=vi
set -o vi
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C.1.4 Example AETG xmyLogin File 

This is an example of the csh  xmyLogin file as it appears immediately following 
installation of the AETG software. 

You must make the following changes to this file to reflect your environment:

• Update the directories may need to be updated  

• Replace <hostname>  with the actual machine names 

• Replace <oracleservername> with the name of the mashine on which you installed t
Oracle software.

• Replace <port>  with the actual Telexel port (ex. 22100).

After you have made the necessary changes to this file it can be sourced into the .login files 
for all AETG users.

# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
#
# @(#)xmyLogin.eg52.3
# created on 97/10/07 at 15:37:23

#
# @(#)sample login for madmin 96/06/11 SOL (csh version)
#

# This is an example of a MYNAH System profile that
# can be sourced into MYNAH user's .login to give
# them access to the system.
#

#
# XMYDIR is the path to a directory which is symbolically linked to
# the current release of MYNAH, e.g.,
# ln -s /opt/XXXXmyn/MYNAH/releases/MYNAH_5.0 /opt/XXXXmyn/mynah
#
setenv XMYDIR /opt/XXXXmyn/mynah

#
# XMYHOME is the path to a directory which is the MYNAH run environment
#
setenv XMYHOME /opt/XXXXmyn/mynah

#
# create or append to LD_LIBRARY_PATH/SHLIB_PATH
#
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if ( $?LD_LIBRARY_PATH ) then
setenv LD_LIBRARY_PATH 

"${LD_LIBRARY_PATH}:${XMYDIR}/lib:/usr/openwin/lib"
else

setenv LD_LIBRARY_PATH "${XMYDIR}/lib:/usr/openwin/lib"
endif

if ( $?SHLIB_PATH ) then
setenv SHLIB_PATH "${SHLIB_PATH}:${XMYDIR}/lib:/usr/openwin/lib"

else
setenv SHLIB_PATH "${XMYDIR}/lib:/usr/openwin/lib"

endif

#
# create or append to MANPATH
#

if ( $?MANPATH ) then
setenv MANPATH "${MANPATH}:${XMYDIR}/man"

else
setenv MANPATH "${XMYDIR}/man"

endif

setenv TCL_LIBRARY "${XMYDIR}/lib/tcl"
setenv TCLX_LIBRARY "${XMYDIR}/lib/tcl"
set path = ($path $XMYDIR/bin)

#
# The host name that the MYNAH license server runs on
#
setenv LSHOST <hostname>

#
# Required Telexel variables.
#
# 1) Verify the host name for the environment variable
#    vxIpcDirectory.
# 2) Verify that vxIpcPort is a valid, unused port number.
# a) Valid numbers are in the range 1024 and 65000.
# b) If port number is already in use you will get an error
# message similiar to "address already in use".  The command
# netstat will show port numbers currently in use.  The file
# /etc/services shows well known used ports.
# 3) If /opt/XXXXtel/telexel is not where you installed Telexel, update
#    the environment variable TELDIR to the correct location.
#

setenv vxIpcDirectory <hostname>
setenv vxIpcPort <port>
setenv TELDIR /opt/XXXXtel/telexel
set path = ($path $TELDIR/bin)
setenv LD_LIBRARY_PATH "${LD_LIBRARY_PATH}:${TELDIR}/lib"
setenv SHLIB_PATH "${SHLIB_PATH}:${TELDIR}/lib"
setenv MANPATH "${MANPATH}:${TELDIR}/man"

#
# If Oracle is being used with MYNAH uncomment the following statement.
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#
setenv TWO_TASK mynah5

#
# If ORACLE is being used with MYNAH uncomment the following statements.
# Verify and correct if necessary that ORACLE_HOME is being set to the
# correct path.  TNS_ADMIN must only be set if the TNS Listener files
# installed during the Oracle installation are not installed in one of
# locations that are searched automaticately by Oracle.
#

#setenv ORACLE_HOME /opt/XXXXora/7.3.2.3
#setenv ORACLE_TERM sun5
#set path = ( $path $ORACLE_HOME/bin)
#setenv EPC_DISABLE TRUE
#
#setenv TNS_ADMIN ${ORACLE_HOME}/network/admin

#
# If TOPCOM is being used uncomment the following and update
# /opt/XXXXtop/topcom is not where TOPCOM is installed
#
# setenv TOPCOM /opt/XXXXtop/topcom
# setenv TBIN ${TOPCOM}/bin
# setenv ETCPATH /usr/public/isode/etc
# set path = ( $path $TBIN)

#
# If I/O Concepts is being used uncomment the following statement and
# update /opt/XXXXioc/ioconcepts if this is not where I/O Concepts is
# installed. Also set IOCLM_HOST to be the name of the host name on
# which is I/O Concepts license server runs.
#
# setenv LD_LIBRARY_PATH "${LD_LIBRARY_PATH}:/usr/dt/lib"
# setenv IOCLM_HOST <hostname>

#
#
# optional command line editor enable
#
setenv EDITOR vi
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C.1.5 Example Solaris AETG Start-up File (S99mynah.eg)

This is a example Solaris AETG processes start-up file. Rename this file, e.g., S99mynah, 
and place it in /etc/rc3.d with root as the owner. This is for the server only. You may ne
to update the required paths and directories.

NOTE — A logical link to this file should be set up in 
/etc/rc0.d as follows:

ln -s /etc/rc3.d/S99mynah K01mynah

#!/bin/ksh
 
# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
# 
# @(#)S99mynah.eg 50.7
# created on 96/09/18 at 15:16:02

#
# This is a sample startup file for AETG.  It should be copied
# to the /etc/rc3.d directory with root as the owner.  This is
# for the server only.  Directories by need to be updated.
#
# Also a logical link to this file should be set
# up in /etc/rc0.d as follows:
#    ln -s /etc/rc3.d/S99mynah K01mynah

vxIpcPort=<IPC Port>
vxIpcDirectory=<hostname>
TELDIR=/opt/SUNWtel/telexel
XMYDIR=/opt/SUNWmyn/mynah
XMYHOME=/opt/SUNWmyn/mynah
export vxIpcPort vxIpcDirectory TELDIR XMYDIR XMYHOME
LD_LIBRARY_PATH=${XMYDIR}/lib:${TELDIR}/lib:/usr/openwin/lib
PATH=/usr/bin:/usr/sbin:/usr/ccs/bin:/usr/openwin/bin:/usr/ucb:/etc:${XMYDIR}/bi
n:${TELDIR}/bin
export LD_LIBRARY_PATH PATH

case "$1" in
'start')

# Start up AETG and Telexel

# removing AETG pip files that might be left over
if [ -f ${XMYHOME}/run/oa/pip.oa.<hostname> ]; then
    (echo 'Deleting stale AETG pip files.') >/dev/console
    (echo 'Deleting stale AETG pip files.') >>/var/adm/messages
    ( /bin/su - madmin -c "${XMYDIR}/bin/.xmyRemovePips all"; )
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fi

if [ -f ${XMYDIR}/bin/xmyStartOA ]; then
        (echo 'starting AETG & Telexel processes.') >/dev/console
        (echo 'starting AETG & Telexel processes.') >>/var/adm/messages
        ( /bin/su - madmin -c "${XMYDIR}/bin/xmyStartOA"; )
#        (echo 'starting AETG Collector Process.') >/dev/console
#        (echo 'starting AETG Collector Process.') >>/var/adm/messages
#        ( /bin/su - madmin -c "${XMYDIR}/bin/xmyStartCL -n <collector name>"; )
fi

;;
'stop')

if [ -f ${XMYDIR}/bin/xmyStopOA ]; then
(echo 'stopping AETG processes.') >/dev/console

        (echo 'stopping AETG processes.') >>/var/adm/messages
( /bin/su - madmin -c "${XMYDIR}/bin/xmyOM shutdown <hostname>"; )

# ( /bin/su - madmin -c "${XMYDIR}/bin/xmyStopCL -n <collector name>"; )
fi

;;
*)

;;
esac
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C.2 Example Telexel  Installation Session

This is an example BAIST installation session of the Telexel System software. 

   _________________________________________________________________________
  |                                                                          |
  |              Bellcore Application Installation Setup Tool                |
  |              -        -           -            -     -                   |
  |                                 BAIST 2.1                                |
  |                                                                          |
  |           COPYRIGHT  (c) 1996 Bell Communications Research Inc.,         |
  |                         All Rights Reserved.                             |
  |                                                                          |
  |            PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.           |
  |                                                                          |
  |                                                                          |
  |                   A UNIX Packaging and Installation Tool                 |
  |                                                                          |
  |                      For further information on BAIST                    |
  |                      Contact:  Raymond C. Gray                           |
  |                                BAIST Project Manager                     |
  |                                (908)699-7960                             |
  |                                                                          |
  |                                                                          |
  |__________________________________________________________________________|
  
                               Please Wait ...
WARNING: You are using LOCAL BCRDB
********* BAIST Installation Tool Release 2.1 *********
Initializing.  Please wait.

               BAIST 2.1 FLOW CONTROL
                    PRODUCT MENU
                        Archived Products List

                         1) AETG 1.0
                         2) AETG UPDATES
                         3) TELEXEL 7.0

                         I) Installed Products
                         R) Registered Products
                         E) Exit

                Enter your Selection: 3
Load TELEXEL? [Y]: Y
Extracting Application Profile

Getting the name of PRODUCT_HOME dir

Where should the TELEXEL directory be created ?
Enter a full pathname starting with /, or q to Quit processing
: /opt/SUNWtel
Getting the name of RELEASE_HOME dir
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Making the PRODUCT_HOME dir
Making the RELEASE_HOME dir

Who should own the TELEXEL application ?
Enter a valid login name  : madmin

Running PRELOAD script

Extracting the TELEXEL application
Please wait. This may take a while ...
9096 of 9096 blocks loaded 100% COMPLETED 
Product TELEXEL TELEXEL_6.0 loaded successfully

               BAIST 2.1 FLOW CONTROL
                    PRODUCT MENU
                        Archived Products List

                         1) AETG 1.0
                         2) AETG UPDATES
                         3) TELEXEL 7.0

                         I) Installed Products
                         R) Registered Products
                         E) Exit

                 Enter your Selection: E
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C.3 Delivered Example Oracle Files

This section contains all of the example Oracle start-up and configuration files that a
delivered with the AETG System.

C.3.1 Example Solaris Oracle Start-up File (S96oracle)

This is an example Solaris Oracle start-up file. It should be moved to /etc/rc3.d with root 
as the owner. You may need to update the required directories.

#!/bin/ksh

# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
# 
# @(#)S96oracle.eg50.5
# created on 96/09/26 at 17:24:32

# This is a sample startup file for oracle.  It should
# be moved to the /etc/rc3.d directory with root as the
# owner.  Directories may need to be updated.

#
# Required update
#
# If /opt/SUNWora/oracle is not where you installed Oracle, update
# the environment variable ORACLE_HOME to the correct location.
#
ORACLE_HOME=/opt/SUNWora/oracle
export ORACLE_HOME

 case “$1” in
‘start’)

# Start up Oracle 

# Delete nasty Oracle tmp directory
if [ -d /var/tmp/o ]; then

rm -rf /var/tmp/o
fi

if [ -f ${ORACLE_HOME}/bin/dbstart ]; then
(echo ‘starting oracle7.’) >/dev/console
(echo ‘starting oracle7.’) >/var/adm/messages
( /bin/su - oracle -c “${ORACLE_HOME}/bin/dbstart”; )
(echo ‘starting oracle sqlnet server.’) >/dev/console
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(echo ‘starting oracle sqlnet server.’) >/var/adm/messages
( /bin/su - oracle -c “export PATH=${ORACLE_HOME}/bin:$PATH ; 

${ORACLE_HOME}/bin/tcpctl start”; )
# Start sqlnet V2 listner

# (echo ‘starting oracle sqlnet V2 server.’) >/dev/console
# (echo ‘starting oracle sqlnet V2 server.’) >/var/adm/messages

( /bin/su - oracle -c “ export PATH=${ORACLE_HOME}/bin:/usr/ccs/bin:$PATH 
; ${ORACLE_HOME}/bin/lsnrctl start”; )

fi

;;
‘stop’)

if [ -f ${ORACLE_HOME}/bin/tcpctl ]; then
(echo ‘stopping oracle7.’) >/dev/console
(echo ‘stopping oracle7.’) >/var/adm/messages
( /bin/su - oracle -c “${ORACLE_HOME}/bin/dbshut”; )

# ( /bin/su - oracle -c “ export PATH=${ORACLE_HOME}/bin:$PATH ; \
# ${ORACLE_HOME}/bin/lsnrctl stop”; )

( /bin/su - oracle -c “${ORACLE_HOME}/bin/tcputl Q”; )
fi

;;
*)

;;
esac
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C.3.2 Example Oracle Configuration File 

This is an example Oracle configuration file, configmynah5.ora. For this example the 
Oracle software is installed into /opt/SUNWora/7.2.3.2. If you use a different directory, the
directory statements in this example will need to be updated.

# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
# 
# @(#)configmynah5.ora 50.2
# created on 96/07/16 at 17:26:27

#
# $Header: cnfg.orc 7001200.2 93/04/26 14:58:22 eruben Osd<unix> $ Copyr (c) 1992 
Oracle
#

###################################################################
# NOTE:
# This is an example configmynah5.ora file.  Directories will need
# to be updated if different.  For this example the oracle software
# is installed into /opt/SUNWora/oracle.
###################################################################

# cnfg.ora - instance configuration parameters

control_files           = (/opt/SUNWora/oracle/dbs/ctrl1mynah5.ctl, 
                           /opt/SUNWora/oracle/mynah5/datafiles/d02/ctrl2mynah5.ctl,
                           /opt/SUNWora/oracle/mynah5/datafiles/d03/ctrl3mynah5.ctl)
# Below for possible future use...
#init_sql_files          = (?/dbs/sql.bsq,
#                           ?/rdbms/admin/catalog.sql,
#                           ?/rdbms/admin/expvew.sql)
background_dump_dest    = /opt/SUNWora/oracle/rdbms/log
core_dump_dest = /tmp
user_dump_dest = /opt/SUNWora/oracle/rdbms/log
#log_archive_dest= /opt/SUNWora/oracle/dbs/arch/arch.log
db_block_size = 2048

db_name                 = mynah5
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C.3.3 Example Oracle Initialization Script (initmynah5.ora)

This is an example Oracle initialization file, initmynah5.ora. Directories will need to be 
updated if different. For this example the oracle software is installed into 
/opt/SUNWora/7.2.3.2.

# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
# 
# @(#)initmynah5.ora 50.2
# created on 96/07/16 at 17:26:40

# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
# 
# @(#)initmynah5.ora 50.1
# created on 96/07/03 at 15:58:57

#
# $Header: initx.orc 7001300.3 93/06/16 12:28:26 mkrishna Osd<unix> $ Copyr (c) 
1992 Oracle
#

###################################################################
# NOTE:
# This is an example initmynah5.ora file.  Directories will need
# to be updated if different.  For this example the oracle software
# is installed into /opt/SUNWora/oracle.
###################################################################

# include database configuration parameters
ifile = /opt/SUNWora/oracle/dbs/configmynah5.ora

#rollback_segments              = (r01)
rollback_segments= (r01,r02,r03,r04)

##############################################################################
# Example INIT.ORA file
#
# This file is provided by Oracle Corporation to help you customize
# your RDBMS installation for your site.  Important system parameters
# are discussed, and example settings given.
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#
# Some parameter settings are generic to any size installation.
# For parameters that require different values in different size
# installations, three scenarios have been provided: SMALL, MEDIUM
# and LARGE.  Any parameter that needs to be tuned according to 
# installation size will have three settings, each one commented
# according to installation size.
#
# Use the following table to approximate the SGA size needed for the
# three scenarious provided in this file:
#
#                     -------Installation/Database Size------
#                      SMALL           MEDIUM           LARGE
#  Block         2K    4500K            6800K           17000K
#  Size          4K    5500K            8800K           21000K
#
# To set up a database that multiple instances will be using, place
# all instance-specific parameters in one file, and then have all
# of these files point to a master file using the IFILE command.
# This way, when you change a public
# parameter, it will automatically change on all instances.  This is 
# necessary, since all instances must run with the same value for many
# parameters. For example, if you choose to use private rollback segments, 
# these must be specified in different files, but since all gc_* 
# parameters must be the same on all instances, they should be in one file.
#
# INSTRUCTIONS: Edit this file and the other INIT files it calls for
# your site, either by using the values provided here or by providing
# your own.  Then place an IFILE= line into each instance-specific
# INIT file that points at this file.
###############################################################################

# tuning parameters

db_files =1020 

db_file_multiblock_read_count = 8                                     # SMALL  
# db_file_multiblock_read_count = 16                                  # MEDIUM 
# db_file_multiblock_read_count = 32                                  # LARGE  

db_block_buffers = 200                                                # SMALL  
# db_block_buffers = 550                                              # MEDIUM 
# db_block_buffers = 3200                                             # LARGE  

shared_pool_size = 3500000                                            # SMALL
# shared_pool_size = 6000000                                          # MEDIUM
# shared_pool_size = 9000000                                          # LARGE

log_checkpoint_interval = 10000

processes = 50                                                        # SMALL  
# processes = 100                                                     # MEDIUM 
# processes = 200                                                     # LARGE  

dml_locks = 100                                                       # SMALL  
# dml_locks = 200                                                     # MEDIUM 
# dml_locks = 500                                                     # LARGE
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log_buffer = 8192                                                     # SMALL
# log_buffer = 32768                                                  # MEDIUM
# log_buffer = 163840                                                 # LARGE

sequence_cache_entries = 10                                           # SMALL  
# sequence_cache_entries = 30                                         # MEDIUM 
# sequence_cache_entries = 100                                        # LARGE  

sequence_cache_hash_buckets = 10                                      # SMALL  
# sequence_cache_hash_buckets = 23                                    # MEDIUM 
# sequence_cache_hash_buckets = 89                                    # LARGE  

# audit_trail = true            # if you want auditing
# timed_statistics = true       # if you want timed statistics
max_dump_file_size = 10240      # limit trace file size to 5 Meg each
              
# log_archive_start = true      # if you want automatic archiving

mts_dispatchers="ipc,1"
mts_max_dispatchers=10
mts_servers=1
mts_max_servers=10
mts_service=mynah5
mts_listener_address="(ADDRESS=(PROTOCOL=ipc)(KEY=mynah5))"
nls_date_format = "DD-MON-YYYY"
remote_os_authent = true
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C.3.4 Example Oracle crdbmynah5.sql File 

This is an example Oracle crdbmynah5.sql file. For this example the Oracle software is 
installed into /opt/SUNWora/7.2.3.2. If you use a different directory, the directory 
statements in this example will need to be updated.

# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
# 
# @(#)crdbmynah5.sql50.2
# created on 96/07/16 at 17:26:15

REM ###################################################################
REM # NOTE:
REM # This is an example crdbmynah5.sql file.  Directories will need
REM # to be updated if different.  For this example the oracle software
REM # is installed into /opt/SUNWora/oracle.
REM ###################################################################

REM * Set terminal output and command echoing on; log output of this script.
REM *
#set termout on
#set echo on
spool /opt/SUNWora/oracle/dbs/crdbmynah5.lst

REM * Start the <sid> instance (ORACLE_SID here must be set to <sid>).
REM *

REM * Create the <dbname> database.  
REM * SYSTEM tablespace configuration guidelines:
REM *   General-Purpose ORACLE RDBMS    5Mb
REM *   Additional dictionary for applications10-50Mb 
REM * Redo Log File configuration guidelines:
REM *   Use 3+ redo log files to relieve ̀ `cannot allocate new log...'' waits.
REM *   Use ~100Kb per redo log file per connection to reduce checkpoints.
REM *
create database "mynah5"
    maxinstances 1
    maxlogfiles  16
    character set "US7ASCII"
    datafile

'/opt/SUNWora/oracle/mynah5/datafiles/d01/systmynah5.dbf'size   25M
    logfile

'/opt/SUNWora/oracle/mynah5/logfiles/log1mynah5.dbf'size 500k,
'/opt/SUNWora/oracle/mynah5/logfiles/log2mynah5.dbf'size 500k,
'/opt/SUNWora/oracle/mynah5/logfiles/log3mynah5.dbf'size 500k;

disconnect
spool off
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C.3.5 Example Oracle crdb2mynah5.sql File 

This is an example Oracle crdb2mynah5.sql file. For this example the Oracle software is
installed into /opt/SUNWora/7.2.3.2. If you use a different directory, the directory 
statements in this example will need to be updated.

This script takes care off all commands necessary to create an OFA compliant databa
after the create database command has succeeded.

# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
# 
# @(#)crdb2mynah5.sql50.2
# created on 96/07/16 at 17:26:03

# COPYRIGHT  (c) 1996 Bell Communications Research Inc.,
#   All Rights Reserved.
#
# PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
#
# This document contains proprietary information that shall
# be distributed or routed only within Bell Communications
# Research (Bellcore), and its authorized clients, except
# with written permission of Bellcore.
# 
# @(#)crdb2mynah5.sql50.1
# created on 96/07/03 at 15:58:45

REM ###################################################################
REM # NOTE:
REM # This is an example crdb2mynah5.sql file.  Directories will need
REM # to be updated if different.  For this example the oracle software
REM # is installed into /cowboy1/opt/SUNWora/oracle.
REM ###################################################################

REM * This script takes care off all commands necessary to create 
REM * an OFA compliant database after the CREATE DATABASE command has
REM * succeeded.

REM * Set terminal output and command echoing on; log output of this script.
REM *
#set termout on
#set echo on
#spool 2-rdbms.lst
spool /cowboy1/opt/SUNWora/oracle/dbs/crdb2mynah5sl.lst

connect internal
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REM # install data dictionary views:
@/cowboy1/opt/SUNWora/oracle/rdbms/admin/catalog.sql

REM * Create additional rollback segment in SYSTEM before creating tablespace.
REM *
connect internal
create rollback segment r0 tablespace system
 storage (initial 16k next 16k minextents 2 maxextents 20);

REM * Use ALTER ROLLBACK SEGMENT ONLINE to put r0 online without shutting
REM * down and restarting the database.
REM *
alter rollback segment r0 online;

REM * Create a tablespace for rollback segments.
REM * Rollback segment configuration guidelines:
REM *   1 rollback segments for every 4 concurrent xactions.
REM *   No more than 50 rollback segments.
REM *   All rollback segments the same size.
REM *   Between 2 and 4 homogeneously-sized extents per rollback segment.
REM * Attempt to keep rollback segments to 4 extents.
REM *
create tablespace rbs datafile
    ‘/cowboy1/opt/SUNWora/oracle/mynah5/datafiles/d02/rbsmynah5sl.dbf’ size 4M
default storage (

initial 128k
next 128k
pctincrease 0
minextents 2

);

REM * Create a tablespace for temporary segments.
REM * Temporary tablespace configuration guidelines:
REM *   Initial and next extent sizes = k * SORT_AREA_SIZE, k in {1,2,3,...}.
REM *
create tablespace temp datafile
    ‘/cowboy1/opt/SUNWora/oracle/mynah5/datafiles/d01/tempmynah5sl.dbf’ size 550k
default storage (

initial      256k
next         256k

        pctincrease  0
        optimal      1M
);

REM * Create a tablespace for database tools.
REM *
create tablespace tools datafile
   ‘/cowboy1/opt/SUNWora/oracle/mynah5/datafiles/d03/toolmynah5sl.dbf’ size 15M;

REM * Create a tablespace for mynah5 databases.
REM *
create tablespace my5 datafile
   ‘/cowboy1/opt/SUNWora/oracle/mynah5/datafiles/d03/my5mynah5sl.dbf’ size 15M;

REM * Create a tablespace for miscellaneous database user activity.
REM *
create tablespace users datafile
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   ‘/cowboy1/opt/SUNWora/oracle/mynah5/datafiles/d01/usrmynah5sl.dbf’  size 1M;

REM * Create rollback segments.
REM *
create rollback segment r01 tablespace rbs;
create rollback segment r02 tablespace rbs;
create rollback segment r03 tablespace rbs;
create rollback segment r04 tablespace rbs;

REM * Use ALTER ROLLBACK SEGMENT ONLINE to put rollback segments online 
REM * without shutting down and restarting the database.  Only put one
REM * of the rollback segments online at this time so that it will always
REM * be the one used.  When the user shuts down the database and starts
REM * it up with initSID.ora, all four will be brought online.
REM *
alter rollback segment r01 online;
REM * alter rollback segment r02 online;
REM * alter rollback segment r03 online;
REM * alter rollback segment r04 online;

REM * Since we’ve created and brought online 2 more rollback segments,
REM * we no longer need the second rollback segment in the SYSTEM tablespace.
alter rollback segment r0 offline;
drop rollback segment r0;

REM * Alter SYS and SYSTEM users.
REM *
alter user sys temporary tablespace temp;
#revoke resource from system;
#revoke resource on system from system;
#grant resource on tools to system;
alter user system default tablespace tools temporary tablespace temp;

REM * For each DBA user, run DBA synonyms SQL script.  Don’t forget that EACH
REM * DBA USER created in the future needs dba_syn.sql run from its account.
REM *
connect system/manager
@/cowboy1/opt/SUNWora/oracle/rdbms/admin/catdbsyn.sql

spool off
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C.3.6 Example Oracle crdb3mynah5.sql File

This is an example Oracle crdb3mynah5.sql file. For this example the Oracle software is
installed into /opt/SUNWora/7.2.3.2. If you use a different directory, the directory 
statements in this example will need to be updated.

/*
 *  COPYRIGHT  (c) 1997 Bell Communications Research Inc.,
 *  All Rights Reserved.
 *
 * PROPRIETARY - BELLCORE AND AUTHORIZED CLIENTS ONLY.
 *
 * This document contains proprietary information that shall
 * be distributed or routed only within Bell Communications
 * Research (Bellcore), and its authorized clients, except
 * with written permission of Bellcore.
 */

/*
 * @(#)crdb3mynah5.sql52.1
 * created on 97/05/27 at 09:58:52
 */

static char crdb3mynah5_sql[] = "   @(#)crdb3mynah5.sql52.1";

/* Prevent warning message from CC about sccs string defined but not used */
#ifdef __cplusplus
inline void static dummy_crdb3mynah5_sql()  { if (crdb3mynah5_sql); }
#endif

Rem
Rem cd $ORACLE_HOME/rdbms/admin
Rem
Rem $ORACLE_HOME/bin/sqlplus sys/change_on_install << ""EOF
connect sys/change_on_install
@$ORACLE_HOME/rdbms/admin/standard
@$ORACLE_HOME/rdbms/admin/catproc
@$ORACLE_HOME/rdbms/admin/catalog
@$ORACLE_HOME/rdbms/admin/dbmspipe

create user mynah identified by mynah
default tablespace my5
temporary tablespace temp;

grant execute any procedure to mynah;

grant connect to mynah;

grant resource to mynah;

commit;
Rem exit;
Rem EOF

Rem cd $ORACLE_HOME/sqlplus/admin
Rem $ORACLE_HOME/bin/sqlplus system/manager << ""EOF
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connect system/manager 
@$ORACLE_HOME/sqlplus/admin/pupbld
exit;
Rem EOF
 C–27



AETG System Users Guide BR 007-252-007
Example Installation Files Issue 1, October 1997
Release 1.0   
C.3.7 Example xmyCreateSequences Execution

Continue [y/n]: y
Database connection opened.
Sending sql: CREATE SEQUENCE xmyRunTime_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyScript_Sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyPerson_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyTestVersion_Sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyHierarchyNode_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyHierarchy_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmySutInfo_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyTest_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyUserEnumValue_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyCompareResult_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyResult_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyResultDelta_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyKeyword_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyIssue_Sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyProcedure_Sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyProcedureLibrary_Sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyRequirement_Sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyCompound_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyField_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyFieldGroup_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyFieldValue_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyRelation_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmySutFormat_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyData_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyDocument_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyResource_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyResourceUsage_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyStep_sequence MINVALUE  1  CACHE  500 
Sending sql: CREATE SEQUENCE xmyStepList_sequence MINVALUE  1  CACHE  500 
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C.3.8 Example xmyCreateTemplates Execution

Creating template objects. 
Mynah administrator successfully created
madmin successfully created
UserEnumValue template successfully created
UserEnumValue template successfully locked
defaults userEnumValues installed.
ScriptOid=1
Script template successfully created
Script template successfully locked
Hierarchy template successfully created
Hierarchy template successfully locked
HierarchyNode template successfully created
HierarchyNode template successfully locked
HierarchyNode for demo successfully created
SutInfo template successfully created
SutInfo template successfully locked
sutInfo demo successfully created
RunTime template successfully created
RunTime template successfully locked
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C.3.9 Example root.sh Run

# ./root.sh
Running ORACLE7 root.sh script...
The following environment variables are set as:

ORACLE_OWNER= oracle
ORACLE_HOME=  /opt/SUNWora/V7.2.3.2
ORACLE_SID=   mynah5

Are these settings correct (Y/N)? [Y]: Y

Enter the full pathname of the local bin directory [/opt/bin]: 
/usr/local/bin

Checking for “oracle” user id...
ORACLE_HOME does not match the home directory for oracle.
Okay to continue? [N]: Y

Creating /var/opt/oracle/oratab file...
Updating /var/opt/oracle/oratab file...

Please raise the ORACLE owner’s ulimit as per the IUG.

Leaving common section of ORACLE7 root.sh.
Setting orasrv file protections
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A after it has become an icon.
.

 
ta 

 

 

 

 

 

.

AETG — Automatic Efficient Testcase 
Generator. A Bellcore developed 
system to generate automatically and 
efficiently an optimum set of test cases 
from a set of requirements.

C

CLUI — Command Line User Interface

Compound — A database object that 
represents a complex field. It is made 
up of multiple simple Fields and 
specific values

Config file  — The AETG Configuration 
File (named xmyConfig.General) that 
resides in the directory 
$XMYHOME/config.

F

Field — A database object that is used to 
hold information about the data input 
to be applied to an application 
(sometimes also referred to as a 
SIMPLE FIELD).

Format — A database object that 
represents a collection of fields for 
input purposes; the interface into 
which data is input to an application.

G

GUI  — Graphical User Interface.

I

Icon — An X-Window that has been 
closed using a window manager 
function.

Iconified — The state of an X-Window 

L

List — An ordered collection of elements

Log File — A file containing a record of 
activity for a software product.

R

Relation — A database object that is used
to express the rules governing the da
input (formal requirements) to the 
application under test

S

Script — A file that contains one or more
instructions to be performed by a 
domain.

SUT — System Under Test.

System Under Test — A database 
object that is used to represent 
information about a System Under 
Test. The System Under Test being 
represented can be an application, a
specific release of an application, a 
platform that an application runs on, a
testing cycle for an application, a 
group of applications, or any 
combination of these things.

T

Test — A database object that is used to
track and verify compliance with 
specific system requirements

Tuple — Reference name given to the 
specific value set of a Compound. 
This symbolic value can be expanded
into the specific values of the simple 
Fields represented by the compound
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Index Index

Commands,  14-5
A

Accelerator keys
description,  3-13
list and functions,  3-13

Add Row pushbutton in Include dialog,  5-8

Administrative Privileges
Granting,  17-3
Removing,  17-4

AETG Desktop,  2-4, 3-1
Preferences view,  3-22

edited,  3-24

AETG Processes, Starting and Stopping
See Operability Management

AETG System
AETG Desktop Preference view,  3-22
Creating the Database,  13-29
Database

Creating,  13-29
Dropping,  13-30

Desktop description,  3-2
Dropping the Database,  13-30
Exiting,  2-40, 3-5, 3-34
Folder restrictions,  3-2
Icon description and use,  3-4
Installation,  13-11 to 13-13

CD-ROM,  13-11
Configuring,  14-1
File Archive,  13-12
Installing the Software,  13-11
Post-Installation Steps,  13-13
Pre-Installation Steps,  13-11

Menu description and menu options,  3-5
Networking,  13-2
Overview,  1-1
Printing,  3-30
Processes

Automatically Starting,  14-4
Responsibility List,  14-6
Starting,  14-4

Commands,  14-5
Status of, Obtaining,  14-4

Stopping,  14-4
Commands,  14-5

Starting,  1-1, 2-3
System menu description,  3-4

Attributes copied when duplicating objects,  
4-7

Authority Level,  17-3
Administrator,  17-3
Changing,  17-6
Inactive,  17-3
See Also Administrative Privileges
See Also Person Objects
User,  17-4

Autostart Processes,  14-5, 15-1, 15-3
Starting,  15-10
Stopping,  15-11

B

BAIST,  13-8
Creating Version Directories,  13-3
Pre-installation Considerations,  13-8
Setting Installation Directory,  13-8
UNIX Shell,  13-8

Blanks in values,  7-4

C

CD-ROM, Installation
AETG System,  13-11
Telexel System,  13-15

Changing a Folder’s name,  3-28

Clipboard,  4-8

Cloning
Format object,  6-16
Relation object,  9-14
Test object,  9-6

CLUI,  1-7
Adminstrative Commands,  16-1 to 16-8
Help Messages,  16-1
xmyOM,  16-2 to 16-8
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Displaying Configuration 
Processes,  16-4

OA Reading the Configuration File,  
16-5

Shutting Down an OA,  16-7
Start, Stop, Status Subcommands,  

16-7
Starting Autostart Processes,  16-2
Stopping and Restarting Autostart 

Processes,  16-6
Stopping Autostart Processes,  16-3

Comma separated values,  9-29

Command Line Interface, Modeling,  12-3

Complex Field, see Compound object

Compound object
Creating on a Format object,  8-1
Entering a description,  8-3
Fields in Compound, listing,  8-4
Fields view,  8-4
Interaction Degree,  8-4

Selecting,  8-6
Unrelated,  8-6

Interaction degree
Tuples

Cross Product,  8-6
Selecting,  8-4

List of in a Format object,  6-5
Maximum number of Tuples

Adding up to,  8-12
Setting,  8-3

Name, specifying,  8-2
Properties view,  8-2
Specifying a name,  8-2
Status, displaying,  8-3
Tuples,  8-1

Deleting,  8-14
Generate Tuples menu option,  8-9, 

8-10
Generating,  8-8

At one time,  8-9
Iteratively,  8-10

Generating before saving a 
Compound object,  8-14

List,  8-7
Names,  8-7

Changing a Tuples name,  8-12
Regenerating,  8-13

System generated,  8-12
See alsoTuples

Tuples view,  8-7
Values, clearing,  8-5
Values, selecting,  8-5
Why use,  8-1

Compound objects
Creating,  6-9
Deleting,  6-12

Compounds, Naming,  8-2

Configuration
AETG System,  14-1
Configuring AETG Database,  13-26
Configuring the Telexel System,  13-16
Database, Specifying Whether to Use,  

14-2
General Entries,  14-1
OA,  14-6
OM Port Number,  14-2
Port Numbers,  14-2
Telexel,  13-16
xmyConfig.General File

General Entries,  14-1
xmyConfigOP File

General Entries,  14-3
See Also xmyConfigOP File
Syntax,  14-3 to 14-7

Configuration Parameters
xmyConfig.General File

Database,  14-2
DefaultSD,  14-1
WelcomeNewUsers,  14-2

xmyConfigOP File
AutoStart,  14-4
Mynah,  14-4
Responsibility,  14-6
Start,  14-4
Status,  14-4
Stop,  14-4

Configurations, Modeling,  12-5

Control key,  4-10

Copying closed objects,  4-6

Copying opened objects,  4-6

Creating a folder,  2-5

Creating objects on the AETG Desktop,  4-3

Creating Test objects in a hierarchy,  9-4
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Creating the AETG System Database,  13-29

csh
Setting BAIST Installation Directory,  

13-8
Use of xmyLogin File,  13-5

Customer Support,  1-8

D

Database
AETG System

Configuring,  13-26
Running Without a Database,  14-2

Deleting hierarchies,  9-4
Deleting objects from,  3-6, 4-8
Dropping Oracle,  13-30
Duplicating objects,  4-7
Installing Oracle,  13-19 to 13-31
Maximum Size,  3-23
Searching for objects,  3-7
See Also Oracle
Specifying Whether to Use,  14-2
Storing objects in the database,  4-2
Verifying,  13-30

Database Browser
Accessing from Tools Menu,  5-2
Description,  3-7
general description,  5-1
Include dialog

Add Row pushbutton,  5-8
Delete Row pushbutton,  5-11

Object type, selecting,  5-3
Opening objects,  5-11
queries, default,  5-6
See Also Include dialog
Sorting objects,  5-3
uses,  5-1
Using the Include Dialog,  5-5
Using to associate a Format object with a 

Test object,  9-12

Decoding licensing codes,  15-7

Default settings
Database, Maximum size,  3-23
Fonts,  3-22
printer,  3-22
Saving,  3-23

Delete Row pushbutton in Include dialog,  5-11

Deleting Folders,  3-28

Deleting hierarchies,  9-4
Consequences,  9-4

Deleting objects,  3-6, 4-8
consequences,  4-8

Dialog boxes
description,  3-11
message type,  3-11
setting type,  3-11
transaction type,  3-11

Differences between copying and duplicating 
objects,  4-7

Displaying Operability configuration settings,  
15-14

Duplicating
Excluded Test Cases,  10-25
Format object,  6-15

Creating a new object,  6-16
Creating a new version,  6-16

Included Test Cases,  10-17
Relation object

Duplicated/nonduplicated attributes,  
9-16

Excludes,  10-25
Includes,  10-17

Test object,  9-6
Duplicated/nonduplicated 

Attributes,  9-7

E

Edit menu selections description,  3-6

Editing Person Object Attributes,  17-2

Environment setting for GUI,  2-3

/etc/services, Changes,  13-7

Excluded Test Cases,  10-20
Adding,  10-22
Deleting,  10-26
Duplicating,  10-25
Example contraints,  10-21
Modifying values,  10-24
Saving,  10-24
Setting values,  10-20
Specifying values,  10-20
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Exiting the AETG System,  2-40, 3-5, 3-34

F

Field object
Copying,  6-7

Copied attributes,  6-8
Creating,  6-6
Creating on a Format object,  7-1
Deleting,  6-8
Logical name,  7-2
Name, specifying,  7-2
Parameters

Entering a list of,  7-3
Specifying,  7-9

Properties view,  7-10
Rearranging in a Format object,  6-12
Sequence numbers,  7-3
Specifying a name,  7-2
Values

Blanks in values,  7-4
Changing,  7-7
Copying,  7-8
Creating,  7-5
Deleting,  7-9
Entering,  7-3
Specifying valid values,  7-3
Type

Examples,  7-4
Literal,  7-3
Non-Literal,  7-3

Values view,  7-2
Version number,  6-3
Why use,  7-1

Fields
Listing all in a compound,  8-4
Logical name,  7-2
Name,  7-2
Parameters,  7-3
Sequence numbers,  7-3
Valid values,  7-3

File Archive Installation,  13-12, 13-15

Folders
Analogy to filing cabinet,  3-1
Changing name of,  3-28
Client area description,  3-9
Creating new folders,  3-27

Deleting,  3-28
general description,  3-1
List View layout and screen objects,  3-3
moving object in and out,  3-2
naming,  3-27
Saving,  3-5, 3-28
Status area,  3-9
title bar description,  3-3

Fonts,  3-22
Selecting default,  3-25

Format object
Associating a Test object,  9-11, 9-12
Associations view,  6-14
Cloning,  6-16
Copying a Field object,  6-7

Copied attributes,  6-8
Copying Field objects,  6-7
Creating,  6-1
Creating a Field object,  6-6
Creating Compound objects,  6-9
Defining an interface,  6-1

Specifying an interface type,  6-3
Deleting a Field object,  6-8
Deleting Compound objects,  6-12
Deleting Field objects,  6-8
Duplicating,  6-15

Creating a new Format object,  6-16
Creating a new version of a Format 

object,  6-16
Entering a description,  6-3
Fields

Compound name,  6-5
Field name,  6-5
Logical name,  6-5
Sequence numbers,  6-5, 6-12

Fields view,  6-4
Interfaces, types,  6-1
Name, specifying,  6-3
Object version number,  6-3
Owner, specifying,  6-3
Properties view,  6-2
Rearranging Field objects,  6-12
Specifying a name,  6-3
Status display,  6-3
Title format,  6-4
Why use,  6-1
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G

General definition,  9-1

Granting administrative privileges,  17-6

GUI
Controls

Pushbuttons,  3-15
Radio Buttons,  3-15
Spin buttons,  3-14
Toggle Buttons,  3-14

Creating a Person Object,  17-2
Default Setting, unlock new objects,  3-23
Environment setting,  2-3
Exiting,  2-40, 3-5, 3-34
Fonts,  3-22

Selecting default,  3-25
Person Object,  17-1 to 17-8
Removing objects,  4-8
Rulers,  3-16
Starting,  2-3

GUIs, Modeling,  12-1

H

Hardware Requirements,  13-1

Help menu selection, description,  3-7

Hierarchies,  9-1
Child object definition,  9-1
Creating and naming,  9-2
Creating Test objects,  9-4
Deleting,  9-4

Consequences,  9-4
Naming,  9-4
Parent object description,  9-1
Test Hierarchy description,  9-1
Uses,  9-1

I

Icons
Minimizing and maximizing,  3-12
Tool Bar icons,  3-8
Using,  3-12

Inactive Status,  17-3

Include dialog

Adding rows,  5-8
Attribute/values conditions,  5-7
Conditions between attributes and values,  

5-7
Deleting rows,  5-11
Relations between rows,  5-7
See also Database Browser,  5-5
specifying attributes,  5-8
Using,  5-5

Included Test Cases,  10-12
Adding,  10-13
Deleting,  10-18
Duplicating,  10-17
Modifying,  10-16
Saving values,  10-15
Setting values,  10-12
Specifying values,  10-12

Installation
AETG System,  13-11 to 13-13
Assumptions and Recommendations,  13-3
BAIST considerations,  13-8
Changes to /etc/services,  13-7
Configuring the AETG System,  14-1
Environment Settings,  13-4
Installing License Keys,  13-32
Installing the AETG Software,  13-11
madmin logid,  13-7
mynah Group ID,  13-7
Obtaining License Keys,  13-6
Oracle,  13-19 to 13-31
Recommended Directory Structure,  13-3
Steps,  13-1
Telexel,  13-14 to 13-18

Interaction degree
Relations,  2-30, 10-4
Tuples,  8-4

Cross Product,  8-6
Selecting,  8-4, 8-6
Unrelated,  8-6

Invalid Test Cases,  10-28
Adding,  10-28
Deleting,  10-31
Modifying,  10-31
Saving values,  10-30
Specifying values,  10-30
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K

ksh
Setting BAIST Installation Directory,  

13-8
Use of xmyProfile File,  13-5

L

License Keys
Installing,  13-32
Obtaining,  13-6

License Server,  13-6

Licenses
Installing Keys,  13-32
License Server,  13-6
Obtaining License Keys,  13-6

Licensing,  15-5
Decoding licensing codes,  15-7
Monitoring installed licenses,  15-6
Starting the license server,  15-5
Stopping the license server,  15-5

List view, expanding object listing,  3-19

M

Menu Bar description,  3-4

Menus
Accelerator keys,  3-13

list and functions,  3-13
AETG menu,  3-5
Bar description,  3-4
Edit menu,  3-6
Help menu,  3-7
making selections,  3-12
Mnemonic keys,  3-12
Selected menu,  3-6
System,  3-4
Tools Menu,  3-7
View menu,  3-6
Window menu,  3-7

Mnemonic keys
description and use,  3-12

Modeling
Command Line Interface,  12-3

Configurations,  12-5
GUIs,  12-1

Monitoring installed licenses,  15-6

Mouse button actions,  3-11

Multiselecting Objects,  4-10

N

Naming
Folders,  2-5
Hierarchies,  9-4

O

OA,  15-1
Configuration Parameter,  14-6
Definition,  15-3
Stopping an OA,  15-12

On a specified host,  15-12
On the local host,  15-12

Stopping and restarting a host,  15-13
xmyConfigOP Entry,  14-5

Object status and default view,  4-9

Objects
changing information in your person 

object,  5-14
Clearing,  4-8
Clearing from desktop,  3-6
Copying,  3-6
Creating at first level of hierarchy,  9-4
Creating at lower levels of a hierarchy,  

9-5
Creating new,  3-6
Cutting,  3-6, 4-8
Deleting,  3-6, 4-8

consequences,  4-8
Description,  4-1
Deselecting all on desktop,  3-6
Expanding,  3-6
General description,  4-2
Individual definitions,  4-1
managing objects include dialog,  5-5
Modifying another person’s objects,  4-9
Multiselecting,  4-10
New objects, unlocking,  3-23
Opening,  3-6
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Opening in Database Browser,  5-11
Pasting,  3-6
Person object

Viewing,  5-12
Person object description,  5-12
Relationship to views,  4-2
Removing from GUI,  4-8
See Also Include Dialog
Selecting all on desktop,  3-6
Sorting in Database Browser,  5-3
Viewing
Viewing Attribute/values conditions,  5-7
Viewing, See Also Include dialog

Objects duplicating objects (clones),  4-7

Obtaining the status of processes,  15-13

OM,  15-1
Definition,  15-3
OM Port number,  15-3
Port Number, Specifying,  14-2
xmyOM Subcommands,  15-4

Operability Agent
See OA

Operability Management,  15-1 to 15-18
Autostart Processes,  14-5, 15-1, 15-3

Starting,  15-10
Stopping,  15-11

Basic Steps,  15-1
Design,  15-2
Displaying Operability configuration 

settings,  15-14
Licensing,  15-5

Decoding licensing codes,  15-7
Monitoring installed licenses,  15-6
Starting the license server,  15-5
Stopping the license server,  15-5

OA,  15-1
Obtaining the status of processes,  15-13
OM,  15-1
Overview,  15-2
See Also OA
See Also OM
Specifying if Process is a AETG Process,  

14-4
Starting processes,  15-10
Stopping processes

Stopping a specific host,  15-11
Stopping an Autostart process,  15-11

Stopping an OA,  15-12
Stopping an OA and Autostart 

Processes
On a specified host,  15-12
On the local host,  15-12

Stopping and restarting a host,  15-13
xmyOM Subcommands,  15-4

autostart,  15-10
autostop,  15-11
query,  15-14
recycle,  15-13
shutdown,  15-12
start,  15-10
status,  15-13
stop,  15-11

Operability Manager
See OM

Operating System Requirements,  13-1

Operating System, Solaris,  13-1

Options,  14-1

Oracle
Configuring AETG Database,  13-26
Database Disk Configuration,  13-21
Environment Variables,  13-20
Installation

Error Messages,  13-25
Installing the Software,  13-23
Verifying,  13-25

Pre-Installation Steps,  13-19
Required Packages,  13-20
Required Processes,  13-30
Verifying,  13-30

P

Parameters,  14-1

Person Objects,  17-1 to 17-9
Attributes,  5-13
Creating,  17-1

From the GUI,  17-2
Description,  5-12
Duplicate IDs,  17-5
Editing

Attributes,  17-2, 17-6
Authority Level,  17-6

Granting Administrative Privileges,  17-3
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Granting and removing adminstrative 
privileges,  17-6

Information View,  17-6
Information view,  5-15
Limits per UNIX ID,  17-1
Properties View,  17-3
Properties view,  5-13
Removing Administrative Privileges,  17-4
Restrictions on Users,  17-1
Saving,  17-4
Viewing,  5-12

Port Numbers,  14-2

Post-Installation Steps
AETG System,  13-13
Telexel,  13-16

Pre-Installation Steps
AETG System,  13-11
Oracle,  13-19
Telexel,  13-14

Printer, default,  3-22

Printing
General description for AETG System,  

3-30
Test Case Matrix,  9-27

Privileges, Specifying,  17-3

Processes
Automatically Starting,  14-4
Responsibility List,  14-6
Specifying if a AETG Process,  14-4
Starting,  14-4

Commands,  14-5
Status of, Obtaining,  14-4

Commands,  14-5
Stopping,  14-4

Autostart,  15-11
Commands,  14-5
On local host,  15-12
On specific host,  15-12
Specific processes,  15-11

Pushbuttons
Description and use,  3-15
Functions,  3-15

R

Radio button, description,  3-15

Rearranging Field objects,  6-12

Registering as an AETG user,  2-3

Relation object
Changing participating fields,  10-7
Changing participating values,  10-9
Cloning,  9-14
Creating,  10-1
Description, entering,  10-4
Duplicating,  9-14

Duplicated/nonduplicated attributes,  
9-16

Excluded Test Cases,  10-20
Adding,  10-22
Deleting,  10-26
Duplicating,  10-25
Example contraints,  10-21
Modifying values,  10-24
Saving,  10-24
Setting values,  10-20
Specifying values,  10-20

Excludes view,  10-19
Fields

Changing participating fields,  10-7
Rearranging,  10-10

Fields view,  10-5
Fields, listing nonparticipating,  10-6
Fields, listing participating,  10-6
Included Test Cases,  10-12

Adding,  10-13
Deleting,  10-18
Duplicating,  10-17
Modifying,  10-16
Saving values,  10-15
Setting values,  10-12
Specifying values,  10-12

Includes view,  10-11
Interaction degree,  10-4
Invalid Test Cases,  10-28

Adding,  10-28
Deleting,  10-31
Modifying,  10-31
Saving values,  10-30
Specifying values,  10-30

Invalids view,  10-27
Listing nonparticipating fields,  10-6
Listing participating fields,  10-6
Name, specifying,  10-3
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Properties view,  10-3
Rearranging Fields,  10-10
See also Test object
Specifying a name,  10-3
Test Cases

Excluding,  10-19
Including,  10-11
Invalids,  10-27

Values
Changing participating values,  10-9
Modifying Excludes,  10-24
Setting

Excluded Test Cases,  10-20
Included Test Cases,  10-12

Specifying for Excluded Test Cases,  
10-20

Specifying for Included Test Cases,  
10-12

Specifying for Invalid Test Cases,  
10-30

Why use,  10-1

Removing administrative privileges,  17-6

Removing local pip files,  15-9

Required Software Packages,  13-2

Requirements
Hardware,  13-1
Operating System,  13-1
Required Software Packages,  13-2

Ruler column headings
in displays,  3-16
using,  3-16

S

Saving Default setting on Preference view,  
3-24

Saving Folders,  3-5, 3-28

Selecting default fonts,  3-25

Set button,  10-14, 10-23

Setting Administrative Privileges
Using the GUI,  17-1 to 17-8

sh, Setting BAIST Installation Directory,  13-8

Simple Field,  6-5

Software Packages
Required,  13-2

Solaris,  1-1, 13-1
Delivered Oracle Start-up Files,  15-16
Delivered Start-up Files,  15-16
Oracle Packages,  13-20
Start-up Mechanism,  15-8

Spin button, description and use,  3-14

Starting and Stopping AETG Processes
See Operability Management

Starting processes,  15-10

Starting the AETG System,  1-1, 2-3

Starting the license server,  15-5

Stopping an OA,  15-12
On a specified host,  15-12
On the local host,  15-12

Stopping and restarting a host,  15-13

Stopping processes
Stopping a specific host,  15-11
Stopping an Autostart process,  15-11
Stopping an OA,  15-12
Stopping an OA and Autostart Processes

On a specified host,  15-12
On the local host,  15-12

Stopping and restarting a host,  15-13

Stopping the license server,  15-5

System Overview,  1-1

System Requirements,  13-1

T

Telexel
Configuring,  13-16
Installation,  13-14 to 13-18

CD-ROM,  13-15
File Archive,  13-15
Post-Installation Steps,  13-16
Pre-Installation Steps,  13-14

Verifying,  13-17

Test Case Matrix
Deleting,  9-20, 9-25
Displayed values,  9-18
File

Deleting,  9-25
Format,  9-23, 9-28

Converting,  9-29
Loading,  9-24
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Location,  9-23
Printing,  9-27
Saving,  9-23

Generating,  9-17, 9-19
Loading,  9-24
Matrix information,  9-18
Name, format,  9-18
Printing,  9-27
Saving,  9-22
Specifying maximum number,  9-25
Type,  9-18

Test object
Area test types,  9-10
Associating a Format object,  9-11, 9-12
Cloning,  9-6
Creating a new Relation object,  9-13
Creating at first level of hierarchy,  9-4
Creating at lower levels of a hierarchy,  

9-5
Creating in a hierarchy,  9-4
Description, entering,  9-10
Displaying Relation objects,  9-11
Duplicating,  9-6

Duplicated/nonduplicated 
Attributes,  9-7

Duplicating a Relation object,  9-14
Duplicated/nonduplicated attributes,  

9-16
Featuretest types,  9-10
Matrix view,  9-17
Name, specifying,  9-9
Naming,  9-4
Owner, specifying,  9-9
Parent type,  9-10
Properties view,  9-9
Relation

Deleting,  9-16
Relation object,  9-11

Creating a new Relation object,  9-13
Duplicating,  9-14

Duplicated/nonduplicated 
attributes,  9-16

Relations view,  9-11
See also Hierarchies
See also Relation object
See also Test Case Matrix
Specifying a name,  9-9
Specifying an owner,  9-9

Status, displaying,  9-10
Test Case Matrix

Deleting,  9-20, 9-25
Displayed values,  9-18
File

Deleting,  9-25
Format,  9-23, 9-28

Converting,  9-29
Loading,  9-24
Location,  9-23
Printing,  9-27
Saving,  9-23

Generating,  9-17, 9-19
Loading,  9-24
Matrix information,  9-18
Name, format,  9-18
Printing,  9-27
Saving,  9-22
Specifying maximum number,  9-25
Type,  9-18

Test Case test types,  9-10
Test test types,  9-10
Types

Displaying Parent object type,  9-10
Specifying,  9-10

Version number,  9-10
Why use,  9-1

Tests
Defining test properties,  9-9

Toggle buttons, description and use,  3-14

Tool Bar
description,  3-7
icons, description of function,  3-8

Tools Menu,  3-7
Database Browser,  3-7, 5-2

Tuples,  6-11
Adding up to Maximum number,  8-12
Count,  8-7
Creating on a Format object,  8-1
Definition,  8-1
Deleting,  8-14
Generate Tuples menu option,  8-9, 8-10
Generating,  8-8

At one time,  8-9
Iteratively,  8-10

Generating before saving a Compound 
object,  8-14
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Interaction Degree
Selecting,  8-6
Unrelated,  8-6

Interaction degree,  8-4
Tuples

Cross Product,  8-6
Selecting,  8-4

Listing,  8-7
Names,  8-7

Changing a Tuples name,  8-12
Regenerating,  8-13
System generated,  8-12

Setting Maximum number,  8-3

U

Using Include Dialog Add Row pushbutton,  
5-8

Using Include Dialog Delete Row pushbutton,  
5-11

Using the Include Dialog,  5-5

V

Values
Blanks in values,  7-4
Changing,  7-7
Clearing in a Compound,  8-5
Copying,  7-8
Creating,  7-5
Deleting,  7-9
Entering,  7-3
Selecting for a Compound,  8-5
Specifying valid values,  7-3
Type

Examples,  7-4
Literal,  7-3
Non-Literal,  7-3

Verifying
Oracle,  13-25
Telexel,  13-17

Views
AETG Desktop Preference view,  3-22
Changing,  3-6
changing,  3-26
definition,  3-18

description,  3-18
List

description,  3-19
expanding object listing,  3-19

Person object
Information,  5-15
Properties,  5-13

Preferences view
AETG Desktop,  3-22

Edited,  3-24
Refreshing

Database Browser,  3-7
desktop,  3-6
Folders and objects,  3-6

Test Properties,  9-9

W

Window menu selections, description,  3-7

Window scroll bars,  3-9

X

X-windows,  1-1

xmyConfig.General File
Configuration Parameters

General Entries
Database,  14-2
DefaultSD,  14-1
WelcomeNewUsers,  14-2

Options,  14-1
Parameters,  14-1

xmyConfigOP File
Configuration Parameters

AutoStart,  14-4
Mynah,  14-4
Responsibility,  14-6
Start,  14-4
Status,  14-4
Stop,  14-4

Example,  14-7
Syntax,  14-3

xmyConMatrix,  9-29

$XMYDIR ,  13-5, 13-12

$XMYHOME,  13-5, 13-12

xmyLogin,  13-4
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xmyMYNAHrc file,  3-5

xmyProfile,  13-4

xmyRunAetg,  1-1, 2-3

xmyShutDown,  15-12

xmyStartUp,  15-9
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